
Welcome to Isabel 6 Document
ID: 5210
Modified:
04/01/2012
Created:
03/05/2013
Version: 22

Isabel 6 will offer you a very advanced electronic banking solution. Isabel 6 is a multi-user and multi-bank
solution that meets the highest security standards. You will enjoy the freedom of the Internet to do all your
banking transactions wherever and whenever you want.
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What's possible with Isabel 6? Document
ID: 7321
Modified:
10/09/2012
Created:
08/04/2013
Version: 30

Answer:

Isabel 6 contains many features to further increase your efficiency:

Isabel 6 is a web application: the application and the data are accessible via the
internet for several Isabel users and from several locations. This allows you to share
information easily with colleagues. You will have access from several workstations,
several offices, on the road or even at home. You will also always have the most up to
date Isabel version and tables. You do not need to install anything anymore from a CD-
ROM.

High level of security: Isabel 6 is only accessible with an Isabel Secure Signing Card
and card reader. A special “Payment mode” provides extra security. With Isabel you
continue to enjoy the highest possible level of security.

Even better follow-up of your payments possible: higher speed of exchange of
information between Isabel and the banks. Ideal for your urgent payments and Intraday
information. Isabel 6 also gives you a clear overview of all your different bank accounts. 
All your transactions and their execution statuses are centralised. Excellent for your cash
management.

Ready for the Single Euro Payments Area (SEPA): Isabel 6 supports the new pan-
European formats that have been introduced as from 2008. You will enjoy the SEPA
advantages swiftly and easily.

 

Extensive support of your specific payment process:  entry of payments,
checking, signing and releasing. Isabel 6 ensures that different employees, all with their
own responsibilities and rights in the payment process, are able to do their work easily
with a clear view of the stage of the payments.

Integration in accounting and ERP solutions: with a click of a button you can send
payments directly from your accounting software. Additional signatures can be easily
made by the other users on the Isabel 6 portal site. The easy information exchange
ensures you don't need to type any data twice. You will gain time and avoid mistakes.

Zoomit is a tool for the payment of received electronic invoices: Zoomit acts as a
mailbox for electronic invoices that you can view and pay in a few clicks and also offers
you the possibility to consult electronic documents.

Preparing for connectivity integration with banks worldwide: Isabel embraces the
SWIFT connectivity standard. If you're interested, please inform Isabel if you want to be
candidate to obtain connectivity to a certain bank abroad that is not yet available on the
Isabel 6 platform.

More functionality of Isabel 6:

Consult account balance
Consult account history
Find transactions
Find account info
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Enter national, international and SEPA transactions (with or without memo date)
Enter circular cheques
Manage, create and import counterparties
Manage signing authorities 
Remote signing
Import domestic, foreign and SEPA transactions
Export account information (CODA)
Direct debits
Advanced download gives you a wide range of choices for selecting (select by type of
file, date, etc.)
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Isabel 6 is a web application Document
ID: 1107
Modified:
03/05/2013
Created:
03/05/2013
Version: 16

Isabel 6 eBanking is a web application that is accessible via secured access control on the website
http://www.isabel.be

As a result, Isabel 6 eBanking has many advantages:

You can log on to Isabel 6 anytime or anywhere you want with your Secure Signing Card
and your card reader.
You never need to install banking software.
You make use of one of the most advanced internet security systems in the world.
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Integration with Accounting and Business Management Systems Document
ID: 1135
Modified:
26/04/2013
Created:
26/04/2013
Version: 20

Isabel eBanking software has become the standard in the electronic banking world. Many accounting and
business management programs have integrated an Isabel-compatible solution into their software, which
means that you can easily import and export existing data from one program to the other. Isabel always
guarantees the secure link for all transactions.

How can I...:

Upload counterparties from my accounting software?

More info:

Overview of the accounting packages that are compatible with Isabel 6
Discover CODA
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About the Isabel 6 Welcome Page Document
ID: 1024
Modified:
26/04/2013
Created:
26/04/2013
Version: 95

Purpose:

When your configuration is technically correct, you will be able to identify yourself with your password and your
Secure Signing Card to enter the personalized and secured Welcome Page.

 Note
This page shows dynamically what is available for you.

 How to access
Simply via the Isabel 6 shortcut on the desktop.

Alternate way to access
Isabel 6 website > Company homepage > Login button in the Client Area on the right hand side.

The areas on the Isabel 6 Welcome Page:

 

1. The top right area:

Your PKI user name and number (PKI = Private Key Infrastructure) refers to your
secure signing card.

The  button that allows you to securely exit the application.

2. The top middle area:

The Bankit button gives you access to the Isabel 6 eBanking application.
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The Zoomit button gives you access to the Isabel 6 eBusiness application. Here
you find electronic documents (invoices ...) issued by companies. The
documents are available in PDF (Adobe Acrobat Reader), Finvoice (XML), signed
PDF (Adobe Acrobat Reader), CSV and text format BMF100. It is also possible to
see your Isabel 6 invoices directly into Zoomit.

3. The bottom middle area:

Ordering area:

The "Subscribe to modules" button to activate (additional) Isabel 6 modules
for your subscription. The activated modules are only applicable to you (the
active PKI user). In case you logon for the first time you have to execute the
"Subscribe to modules" step before you can use the eBanking application.

The "Card reader" button to order a new/additional card reader(s) and to check
the status of your order.

The Support button takes you to the support area of the Isabel 6 website.

The "Manage subscription" button takes you to the section of the Isabel 6
website where you can perform changes to your subscription.

The Download area button takes you to the download section of the Isabel 6
website where you can also install the following components:

Security components: compulsory part where you can find the latest version.

Isabel Offline Reporting: optional Isabel 6 module that enables you to create
quickly and easily comprehensive reports.

The "Contract profiles" button enables you to create one or more (if necessary)
profiles. Each profile can contain one or more eBanking contracts.

 Note
As common user you only need one profile with all your eBanking contracts. As
a result you do not have to choose between different profiles to start the
eBanking application.

4. The right area displays news and information related to Isabel 6.

5. The left area displays a chronological list of short messages where important
messages are displayed outlined in orange.

How can I...:

Create a new profile?
Modify or delete a profile?

More info:

Manage your contract profiles
Isabel 6 security components manual
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How to subscribe to Isabel 6 modules? Document
ID: 5482
Modified:
08/04/2013
Created:
08/04/2013
Version: 1

Prerequisite:

Once the activation of your Isabel Secure Signing Card has been completed, you need to subscribe to the
Isabel 6 modules before you can start working with Isabel 6 eBanking.

Starting from the "Welcome page"; you can always recall the subscribe to modules window to activate or
deactivate modules.

Steps:

1. Navigate to the "Welcome Page" via the Isabel 6 shortcut  on the desktop.

 Other way to access

Isabel 6 website > Company homepage > Login button in the Client Area on
the right hand side. 

 Note
When there is more than one eBanking user working on the same PC, you can
select your certificate.  

2. When the signature window appears, enter your PIN using the Isabel reader. As a result the Isabel 6
"Welcome Page" appears.

3. On the "Welcome Page", click on the "Subscribe to modules"  button to activate the modules for
the currently logged on user (not for the entire subscription).

The "Subscribe to modules" window appears (this can take a little while).

4. In the "Subscribe to modules" window you can select the required modules. The total price will appear
at the bottom of the list. For more info about the Isabel 6 charges, check our website.
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An Isabel subscription always contains at least one user with one "Standard Module". Other users of the
subscription may choose the "Standard Module" or the "Signing Module". You can extend the standard
module with optional modules according to your preference. You can retrieve more information about the
Isabel 6 modules on our website.
 

 Note

You don't have to subscribe to any specific module to use Zoomit. Zoomit is an
integral part of the application/solution Isabel.

5. After the selection of the required modules, click Save. A window containing your
order will appear:

6. When you agree with the order, enter your PIN using the Isabel reader. As a result the Isabel 6 "Welcome
Page" appears.

 Warning
When you have subscribed to the Isabel 6 modules for the first time, you should wait 30 minutes before
starting the Isabel 6 eBanking application.

More information:

Isabel 6 modules
Isabel 6 charges
Video about selection of Supplementary Modules
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Discover CODA

Isabel Go, the Isabel button in your accounting package that allows you to send payment and account
information to and from your accounting software and Isabel 6: These Isabel Software Partners are ready.
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Manage your contract profiles Document
ID: 1047
Modified:
26/04/2013
Created:
26/04/2013
Version: 43

Purpose:

The management of profiles enables you to select all the eBanking contracts that you want to visualize in one
profile. Each such profile is a group of eBanking contracts. An eBanking contract allows you to use the Isabel
eBanking application for a certain bank.

 How to access
Start > Programs > Isabel Services > Isabel 6 Login > Click on the "Contract profiles" button on the
Welcome page.

With profile management you can:

Create a new profile;
Delete a profile;
Modify the name of a profile;
Add eBanking contracts to a profile.

The Profile Management window consists of the following items:

Contract profiles list: this section shows the list of all existing profiles. 
Contracts assigned to a profile: the available eBanking contracts in the profile for the
eBanking user
Contract profile name: the existing profiles for the eBanking user
Back to portal: the button to return to the Welcome Page. Only available when all
your eBanking contracts are assigned to a contract profile.

New: the button to create a new contract profile. Only available when you have an orphan
contract. This is an eBanking contract that is not yet attached to a contract profile.

How can I...:

Create a new profile?
Modify or delete a profile?

More info:
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Working with contract profiles
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Working with contract profiles Document
ID: 2270
Modified:
26/04/2013
Created:
26/04/2013
Version: 34

Purpose:

This window allows you to:

Modify a profile; or
Delete a profile; or
Add eBanking contracts to a profile.

The profile details window consists of the following items:

Contract profiles list: this section shows the list of all existing profiles. Click on a
profile name to switch to another existing profile.

Contract profile name: this field contains the name of the profile or is empty when
creating a new profile. The field can be edited when a modification of the profile name is
desired. Do not forget to click the Save changes button to apply the modification. 

Contracts not yet assigned to a profile: this field contains all available eBanking
contracts which have not yet been attached to a profile. 

Contracts assigned to a profile: this field contains the eBanking contracts in the
profile.

Select a contract in the field Contracts not yet assigned to a profile and click on the > button to add the
contract to the profile. 
Select a contract in the field Contracts assigned to a profile and click on the < button to remove the contract
from the profile.
You can also click on the << button or the >> button to move all contracts from one list to another in one go.

 Note
You can only add eBanking contracts of the same type in one profile.

Save Changes: the button to save the changes.
Delete Profile: the button to delete the profile.
Cancel: the button to discard the changes to the profile and to return to the Profile
Details window.

How can I...:

Create a new profile?
Delete or modify a profile?
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How to create a new profile? Document
ID: 2268
Modified:
26/04/2013
Created:
26/04/2013
Version: 38

Steps:

To create a new profile:

1. Start > Programs > Isabel Services > Isabel 6 Login > Click on the "Contract
profiles" button on the Welcome page. Next the Manage Profile window appears.

2. Click the New button.

The form to define the profile appears.

3. Enter a name in the field Contract profile name.

 

4. Select a contract in the field Contracts not yet assigned to a profile and click the >
button to add the contract to the profile. The contract will appear in the field Contracts
assigned to a profile.

 
Select a contract in the field Contracts assigned to a profile and click the < button to
remove the contract from the profile. The contract will disappear from the field
Contracts assigned to a profile and it will appear in the field Contracts not yet
assigned to a profile.
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You can also click on << or >> to move all contracts from one list to another in one go.

 Note
You can only add eBanking contracts of the same type in one profile.

5. Click the Save changes button. The profile is saved and the Manage Profile window
appears.

How can I...:

Delete or modify a profile?

More information:

Profile Management
Working with contract profiles
What is a PKI contract?
What is an eBanking contract?
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How to delete or modify a profile? Document
ID: 2269
Modified:
26/04/2013
Created:
26/04/2013
Version: 35

Steps:

To delete a profile:

1. Start > Programs > Isabel Services > Isabel6 Login > Click on the "Contract
profiles" button on the Welcome page.

Next the Manage Profile window appears.

2. Click a profile name in the Contract profiles list.

The details of the profile appear.

3. Click on the Delete Profile button. The profile is removed and you return to the
Manage Profile window.

To modify a profile:

1. Start > Programs > Isabel Services > Isabel6 Login > Manage your contract
profiles.

The Manage Profile window appears.

2. Click a profile name in the Contract profiles list. The details of the profile appear.

3. You can modify the profile name in the field Contract profile name:

You can also modify the eBanking contracts attached to the profile:
 
Select a contract in the field Contracts not yet assigned to a profile and click on
the > button to add the contract to the profile.
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Select a contract in the field Contracts assigned to a profile and click on
the '<' button to remove the contract from the profile.

You can also click on the >> button to move all contracts from the list Contracts not
yet assigned to a profile to the list Contracts assigned to a profile in one go.

Or you can click on the << button to move all contracts from the list Contracts
assigned to a profile to the list Contracts not yet assigned to a profile in one go.

 Note
You can only add eBanking contracts of the same type in one profile.

4. Click on the Save changes button. The profile is modified and the Manage Profile
window appears.

How can I...:

Create a new profile?
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More information:

Profile Management
Working with contract profiles
What is a PKI contract?
What is an eBanking contract?
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Details of the user interface Document
ID: 1133
Modified:
23/04/2013
Created:
23/04/2013
Version: 76

1. The Navigation pane:

The pane contains the Reports button that gives you access to the central interface to
download (and print) reports. The button is available to both reports from the zone
Account Info as the zone Transactions.

The pane consists of several dynamic menus to make sure that you see only what you
need. These menus change according to the choices you have made in the Display
zone (2) or the Navigation tab (4) you have selected.
The different items in the Navigation pane:

New: for new operations that are not related to the items in the Display zone (2).
Example: creation of transactions, download reporting files, etc...

 Note
The dropdown button "Old Wizards" groups a number of older payment wizards
for which now exist a better alternative but yet remain available in the eBanking
application:

International payment
Domestic payment
Group of domestic payments

Actions: for operations that are related to the items in the Display zone (2).
Example: printing or searching transactions, printing or searching account info, etc...
Managing: allows you to manage your aliases for accounts, counterparties and
creditors.
Preferences: allows you to modify your personal preferences like language, local
formatting, etc...
View exchange rates: gives you a detailed overview of all foreign currencies and
their rates.
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 Tip
Click the  icon on the left side of the items in the Navigation pane to unfold the
available menu-items.
Click the   icon on the left side of the items in the Navigation pane to fold the
available menu-items.

2. The Display zone:

This zone shows the actual information according to the function that was chosen by
clicking a Navigation tab (4) and/or a menu item in the Navigation pane (1).

 Tip
The items can be sorted ascending or descending by clicking  next to the title of
each column.
This sorting functionality is disabled for the Description column (in order to
optimize the performance of the application).

Each column can be enabled (or disabled) by selecting (or deselecting) it from the
Columns menu-item.

3. The Page buttons:

When the content does not fit into the Display zone (2), it will be divided into several
pages. The buttons on the left and the right of the page indicator (Page 1 of 1 in the
example) allow you to browse through the content.

 Warning
Always use the refresh button of the eBanking application  instead of the refresh
button of your internet browser to refresh the screen.

4. The Navigation tabs:

Here you have access to Account Info, Transactions and Sent Transactions.
Each tab sheet has its own distinctive functional colour which provides you with a clear
visual feedback.

5. The Navigation path & the Filter field:

The Navigation path prevents that you get lost when working in a specific tab sheet
and/or a menu item. It will show you the path you've been following so you always know
where you are within the application.

The Filter field will be your assistant when you want to keep an overview and when you
want to sort transactions. This Filter field appears only in the Transaction
overview and the Sent Transaction overview. The Filter field contains the Filter and
Context filters. The Context filter is only available if the user has multiple banks.
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The Assign to envelope button enables you to allocate specific transactions in
envelopes.

6. The Miscellaneous pane:

Here you see your PKI user name and PKI number. Click your username to show
your profile and a list of your eBanking contracts.

Under your PKI user number, there are four icons:

When you click on the icon , a list of messages from the banks or other senders is
displayed. These feedback mails keep you up to date with the most recent news, the
status of the servers and the planned interventions.
When you click on the icon , you can find answers to your questions or immediately
access all kinds of information. You will be able to consult a detailed contextual help as
well as the table of contents of the help files. Contextual Help provides immediate
assistance to users according to the area in which they are working. It provides
information about a particular object and its context.
The icon  will transfer you back to the Welcome page.
The icon  allows you to securely exit the application.

7. The “My bank modules” button opens a pull down menu with the bank proprietary
modules installed in Isabel 6:

The pull down menu contains a separate section for each bank.
Every banksection contains 1 or more links to known sites of that bank.
If you click a link; then the corresponding site is opened in a separate screen.
Only available if you have an eBanking contract with a bank with an existing module
in the current active language.

8. Additional information:

This zone displays (among other things) the number of selected items in the Display
zone (2).

More info:

You need support for Isabel 6?
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How to enter my PIN-code with the Isabel card reader? Document
ID: 44052
Modified:
28/02/2013
Created:
09/04/2013
Version: 1

Steps:

1. If your Isabel card is not yet inserted in the Isabel card reader:

A popup window with animation is displayed to instruct you to insert your Isabel
card.

Put your Isabel card in the Isabel card reader. Next you will hear a beep sound.

2. A popup window is displayed to instruct you to enter your PIN-code (numeric
password) on the keypad of the Isabel card reader.

3. Enter your PIN code using the keypad of the card reader.

4. Confirm with the OK button of the card reader. Next you will hear a beep sound.

If the PIN-code is correct; the message "PIN OK!" appears on the display of the
Isabel card reader.

 Caution
Valid Isabel PIN codes consist of 6-8 digits. If you supply a wrong pincode 5 times
in a row then the message "WRONG PIN" appears on the display of the Isabel card
reader and your Secure Signing Card will no longer be usable. In that case you
have to order a new Secure Signing Card.

How can I...:

Change the password of my Secure Signing Card?
Continue if my Secure Signing Card is blocked or if I forgot my PIN code?

More information:
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 Security guidelines

Your Isabel card may remain in the reader while using Isabel.

Do not leave it in the card reader if you're not working with Isabel.

Keep your card in a safe place (such as your wallet).
 Possible messages

Overview of possible messages that can appear on the display of the card reader:

Insert card
Card inserted

Enter PIN:
Invalid card

Please wait ...
PIN OK!

Wrong PIN
Retry: (..2)
Retry: (..1)

PIN blocked!
New PIN:

Confirm PIN:
PIN changed!
The 2 entries

do
not match!
PIN entry
canceled
Old PIN:
Welcome

PIN too long
(max 8)

PIN too short
(min 6)
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Secure exit Document
ID: 1052
Modified:
03/05/2013
Created:
03/05/2013
Version: 15

Purpose:

The  icon to leave, provides a secure way to exit the eBanking application. 
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Auto cleanup Document
ID: 26018
Modified:
14/05/2013
Created:
14/05/2013
Version: 9

Steps:

With Isabel 6 eBanking your data is stored securely at Isabel so you can access them from anywhere at
anytime.

Timings that your data stays accessible before it is automatically cleaned (on a daily basis):

Account Info stays available for 395 days (about 13 months).

Reporting files (e.g. CODA MT940) stay available for 93 days (about 3 months).

Transactions that are not sent to the bank aren't automatically removed.

Sent Transactions stay available for 3 months.
Note

These periods of automatic removal are fixed parameters and cannot be modified.

How can I...:

Print or export transactions?
Print or export Account Info?
Manually delete sent transactions?

More information:

Backup your account information with Isabel Offline Reporting
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Account Info overview Document
ID: 760
Modified:
07/05/2013
Created:
07/05/2013
Version: 70

Purpose:

The Account Info window contains an overview of all of your accounts and their balances, sorted by bank. The
view may be different according to your contract and user role.

The overview of accounts consists of the following columns:

Account: the font type of the account number is bold when new Account Info is
processed.  Negative balances are displayed in red.  
Account holder / Alias: the name of the account holder or the alias assigned to the
account number. The alias can be configured by the user.
Date: the book date on which the financial movements have been recorded in the
financial accounting system of the bank.
Closing: closing book balance of the nominal amounts that an account holder has
deposited into or taken out of a bank account.
Closing available: this amount indicates which funds are available on the account and
as such earn interest (if available).
Forward balance: the closing value balance of future days, calculated on the value
dates of already booked transactions (if available). 
Intraday date: the day and time to which the Intraday balance relates (optional and if
available).
Intraday balance: the current balance for your account (optional and if available).

Future: when future account information is present, it is indicated by the icon (optional
and if available).

 Tips

Some banks offer the possibility to deliver intraday and/or future info.

It is possible to receive more than one end of day statement per book date. This
feature is of particular importance for end of month, quarter or year statements in
which a first statement is sent containing all transactions of the day, and a second
containing all closing charges & interests. In case multiple statements are received
for the same book date, the Account info overview will show the values from the
statement received with the highest statement number for a certain book date.
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 Tips

The account numbers are grouped per bank.
If no account numbers are visible for a bank, click the name of the bank to expand
the available accounts.
If not all account numbers are visible, use the page buttons below left to browse
through the accounts: 

If not all account numbers are visible,
a filter may be activated. In that case, you can de-activate that filter (see item
on"Filter Account Info").
it can be possible that there have been no movements yet on your account since
the activation of your Isabel 6 card.

The Filter dropdown list offers the following filters that are applicable on the "Account Info" overview area:

No Filter (inactivate the filtering)
Not yet consulted

The default filter at startup can be defined in the Preferences.
The "Select view" dropdown list offers the following filters that are applicable on the "Account Info" overview
area:

The Bank view is selected by default. If selected the classic view with bank headers is
displayed.

You can also select the Account view.

If selected the view without bank headers and with the Bank column is displayed:

The Bank column contains the bank logos of the related bank accounts.

In this view you have the ability to sort columns Ascending or Descending and to
choose the columns that are displayed. These sorting capabilities are analogous with
those used for the tables on the Transactions and “Sent Transactions” tab.
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 Notes

When you change the view from Account to Bank the default sorting is applied
again.
The configuration of the screen and the sort order isn’t saved when you leave
the eBanking application.

How can I...:

Download report files?
Consult account information?
Filter account information?
Search a transaction in the account information?

More info:

Video about Account Info

The navigation pane:

New
Download of reporting files
Actions
View Details
Filter
Search
Delete account: delete the selected account.
Print
One-off intraday future
Managing
Account properties: display the properties of the selected account.
Aliases for accounts
Recurrent intraday/future

Preferences
View exchange rates
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Consult Account Info overview Document
ID: 4077
Modified:
17/04/2013
Created:
17/04/2013
Version: 36

Purpose:

Depending on the Account preferences, which you have defined in Preferences, you can view detailed account
information for each:

statement; or
period (account info per week).

 How to access

Select Account info tab > Click an account number; or
Select Account info tab > Select an account number > Actions menu > View
details.

Tip
Any sorting applied in “Account info” details screens is also used in the generated reports.

The timeline widget allows you to select a specific statement/closing balance date in the most efficient way:

The timeline widget allows scrolling both on month & day level.

The “dot” is represented only on the closing book balance date, even if the statement
spans over multiple days.

The widget can be accessed by clicking the “Jump to specific date or statement” expandable/collapsible bar
(collapsed by default):

On the statement view, selecting a statement will show the exact statement in the table.

On the period view, selecting a statement will show the week period in which the
statement closing book balance date occurred.

The widget bar:

"Drag the timeline or jump to date”:

“Or jump to statement”: You can type or select a statement in the combo box.
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You can either enter a date in the input field according to the current regional settings or
use the calendar tool right next to the input field or drag the timeline.

If the inserted date is a date for which a statement is available, the statement is
immediately displayed in the table below & the timeline centers on the requested date.

How can I...:

Consult account information?
Filter account information?
Search for a transaction in the account information?
Print or export account information?

More info:

Links to the detailed window descriptions:

Account preferences
Account Statement Overview Displayed for each Period
Account Statement Overview Displayed for each Statement
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Account Statement overview displayed per statement Document
ID: 1591
Modified:
07/05/2013
Created:
07/05/2013
Version: 70

Purpose:

When you select an account number on the Account info tab, you see the most relevant information of the
statements.  The account information is displayed per statement.

 How to access

Select the "Account Info" tab > Click an account number; or
Select the "Account Info" tab > Select an account number > Actions menu > "View
Details"

 Tip
To see the account statement overview displayed for each statement: click on Preferences in the Navigation
pane > Select de Account Info tab in the Preferences window > Select View account info per statement.

The window consists of the following sections:

On top: general information about the account number

Bank logo and Account number : the logo of the bank, the account number and its
assigned account holder or alias.
Balance : the date and booked balance after the last booked transaction on this
account.

In the middle: Booked information

Click the  or  button to switch to previous or the first statement for this
account.

Click the  or  button to switch to the next or most recent statement for this
account.
Statement no.: the statement number, automatically assigned by the bank.
Opening balance: the balance before the transactions of the account statement
have been booked.
Date: the date on which the amount is debited or credited.
Value date: the date on which the amount is debited or credited. 
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Description: a description of the transaction.
Amount: the transferred amount of the transaction.

At the bottom: statement details

 Note
By clicking a transaction, you visualise the Statement details at the bottom of the
page.
By double-clicking a transaction, you open the details of the transaction.

Statement no.: the statement number, automatically assigned by the bank.  
Closing balance: the balance after the transactions of the account statement have
been booked.
Date: the date on which the bank has closed the statement.
View attached info: this button is only available when the bank has sent a message
related to the concerned statement. When you click on the button, the message
appears. 
Message: the details of the statement.
View details: the button that gives you detailed information about a transaction in an
account statement
Close: the button that leads you back to the accounts overview

How can I...:

Download report files?
Consult account information?
Filter account information?
Search for a transaction in the account information?
Print or export account information?

More info:

Links to the detailed window descriptions:

Account preferences
Details of a Transaction
Account Statement Overview Displayed for each Period  

The navigation pane:

Actions
View details
Print statements

Preferences
View exchange rates
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Account information overview displayed per period Document
ID: 761
Modified:
07/05/2013
Created:
07/05/2013
Version: 61

Purpose:

When you select an account number on the Account Info tab, you see the most relevant information of the
statements. The account information is displayed per period.

 How to access

Select the "Account Info" tab > Click an account number; or
Select the "Account Info" tab > Select an account number > Actions menu > View
Details

Tip
To see the account statement overview displayed for per period: click on Preferences in the "Navigation
pane"> Select the "Account Info" tab in the Preferences window > Select "View account info per period".

The window consists of the following sections:

On top: general information about the account number
 

Bank logo and Account number: the logo of the bank, the account number and its
assigned account holder or alias.
Balance: the date and amount of the last booked transaction on this account.

At the bottom: Booked information, the overview of statements of an account number
is shown in a table, containing 5 columns. If not all statements are visible, use the scroll-
bar on the right-hand side of the table.
 

Click the  or  button to switch to the previous or the first period for this
account.

Click the  or  button to switch to the next or most recent period for this
account.
Statement no.: the statement number of the transaction, automatically assigned by
the bank.
Entry date: the date on which the transaction is booked by the bank.
Value date: the date on which the value is added to the account.
Description: short description of the transaction and indication of the communication
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which is associated there.
Amount: the transferred amount of the transaction.
Close: the button to return to the Account Info window.

Tip
By clicking a transaction, you open the details of the transaction.

How can I...:

Download report files?
Consult account information?
Search a transaction in the account information?
Print or export account information?
Hide the account info details of one of my payments?

More info:

Links to the detailed window descriptions:

Account preferences
Details of a transaction 
Account Statement Overview Displayed per Statement
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Details of a Transaction in an Account Statement Document
ID: 762
Modified:
26/04/2013
Created:
26/04/2013
Version: 61

Purpose:

This window gives you detailed information about a transaction in an account statement.
 How to access

Select the "Account Info" tab > Click an account number; or
Select the "Account Info" tab > Select an account number > Actions menu > View
Details > Select a statement number > Actions menu > "View Details"

By clicking or double-clicking a statement number (depending on the account preferences), you open the
details of the transaction.

The details of the transaction consist of the following sections:

Account: the account number on which the transaction occurs out.
Account holder: the name of the account holder as it is assigned by the bank, or the
alias.
Opening balance: the opening booked balance.
Closing balance: the closing booked balance.
Bank: the name of the bank to which the account belongs.
Entry date: the date on which the transaction has been booked.
Value date: the date on which the amount is debited or credited.
Statement no.: automatically assigned by the bank.
Description: description of the transaction and an indication of the communication
which is associated to it.
Amount: the transferred amount of the transaction.
All message information that has been added to the transaction.

: button that permits you to go back to the first transaction.

: button that permits you to go back to the previous transaction.

: button that permits you to go back to the next transaction.

: button that permits you to go back to the last transaction.
Close: button that permits you to go back to the account statement overview 
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How can I...:

Consult account information?
Filter account information?
Search a transaction in the account information?
Print or export account information?

More info:

Links to the detailed windows description:

Account preferences
Account Statement Overview Displayed per Statement

Related articles:

How to hide the details of one of my payments in the account info?
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How to consult Account Info details? Document
ID: 1290
Modified:
29/04/2013
Created:
29/04/2013
Version: 48

Steps:

To consult the details of an account:

1. Select the Account Info tab.

2. Select the account you wish to consult.

3. Click View details in the Navigation pane under Actions. The window with the
different transactions of the corresponding account appears.

To consult the details of a transaction:

1. Select the transaction you wish to consult

2. Click View details in the Navigation pane under Actions. 

 Note
Depending on the display configuration you have selected in Account preferences, the Account
info is displayed per period or per statement.

Per period:

Per statement:
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To change the default view of the Account info:

1. Click Preferences at the bottom of the Navigation pane. 

2. Select the Account Info tab in the Manage user preferences screen

3. Select your desired default view of account info and click Save

How can I...:

Download report files?
Filter account information?
Search a transaction in the account information?
Print or export account information?
Request intraday or future info?

More information:

Links to the detailed windows description:

Account preferences
Consult account info
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Account Statement Overview Displayed per Period
Account Statement Overview Displayed per Statement
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How to print or export Account Info? Document
ID: 29164
Modified:
20/03/2013
Created:
20/03/2013
Version: 28

Purpose:

You can export account information to PDF documents or TXT files. You can even use this option to export into
CSV file format (can be imported into MS Excel).

 How to access
Select Account Info tab > Select the account number you wish to print > Actions menu > Print

How to create a PDF file and how to print?

1. Select the account numbers for which you wish to print Account info.

2. In the Navigation pane under Actions, click Print. As a result the Print request
window appears.

3. Choose your print options: 

Print Overview:

One table is shown with all statements if Last received is selected
One table is shown for the period From start date To end date (type or select
date via the calendar icon )

Print Statement(s):
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Choose your content:

End of day statements from Today, Yesterday, This week or This
month 
Intraday statements
Future statements 
All statements From start date To end date (type or select date via the
calendar icon )

Choose your view:

Full details:

Print statement message (selected by default)
Sort transactions per amount: Ascending or Descending
Start new page: for each bank account or for each statement
Page orientation: Portrait or Landscape

Summary: this view shows the full account statements with transactions in a
few lines

Sort transactions per amount: Ascending or Descending
Start new page: for each bank account or for each statement

Statement number and balance:

4. Click the Show PDF button. Next you can download and open the PDF document via
the Reports button in the Navigation pane.
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5. Click the Print button in the toolbar of Adobe Reader.

 Tip
It is possible to save the PDF document by clicking the Save a copy button in the
toolbar.

6. Close the window with the PDF document.

 Note
The Print option and the Print request popup screen are also available if you
select transactions in the detailed view of an account.

How to export to a text file?

1. Select the account numbers for which you want to print Account info.

2. In the navigation pane under Actions, click Print. As a result the Print Options
window appears.  

3. Choose your print options as described above.

4. Click the Export TXT button. Next you can download and open the TXT document via
the Reports button in the Navigation pane.

5. Click the Save as button. Next a windows screen appears where you can save the file.

6. From the Save in field, select the destination folder, enter the File name, select Text
file (*.txt) as type and click the Save button.

How to import into MS Excel?

After you have saved the text file, you can import it into MS Excel. This requires you to change the file extension
from TXT to CSV.

1. Right-click on the file you have saved. 

2. Click on Rename.

3. Rename the extension TXT to CSV.

4. Double-click the file to open it in MS Excel.

More info:

Reports
Problem printing to PDF
PDF Complete causes problems with printing account information
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Filter Account Info overview Document
ID: 1091
Modified:
02/05/2013
Created:
02/05/2013
Version: 49

Purpose:

You can filter account information based on account numbers, type of account info and currencies. By doing
this, you can very precisely define the account information you would like to see.

 How to access
Select Account info tab > Actions menu > Filter

The Filter account information window consists of the following sections:

Name of a filter:

Existing filter: a drop-down list to select one of the filters you previously saved.
Delete filter: button to delete your previously saved filters.
New filter: select this option in case you have no existing filters or when you would like
to create a new one.

Select Bank: if multiple banks, you can select one or more banks.

Advanced criteria: in this section, you can select the account(s) you want to add to the filter.

Account: the account number. If applicable, the account numbers are grouped by bank.
Account holder / Alias: the name of the account holder or the alias assigned to the
account number. 

 Note
Please note that both fields are case sensitive. A search gives no results if:

You are using lowercase letters when the name of the Account holder / Alias is
in capital letters or vice versa.
You are using lowercase letters for the Account. "BExx xxxx xxxx xxxx" gives
results, "bexx xxxx xxxx xxxx" doesn't.

Filter by:

Currency: you can select the currency (or currencies).
Type of account information: you can select the type of account information (Booked,
Intra Day or Future).
Name: use this field to enter the name of the new filter you want to create. 
Save filter: the button to save the filter.

List of selected account that will be used for filtering: available in the right pane.
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Apply filter: the button to apply the filter.
Cancel: the button to cancel the filter action.

How can I...:

Download report files?
Consult account information?
Filter account information?
Search for a transaction in the account information?
Print or export account information?

More info:

The navigation pane:

Actions
Clear criteria: clear all selected filter criteria in the Display Zone
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How to filter Account Info? Document
ID: 1106
Modified:
29/04/2013
Created:
29/04/2013
Version: 29

Steps:

To filter account information:

1. Select the Account info tab.

2. Click Filter in the Navigation pane under Actions. The Filter account information
window appears.

In case you use the filter for the first time or in case you want to create a new filter:

1. Select the option New filter and enter a name in the field Name (at the bottom).

2. Create a list of selected accounts by selecting one or more banks in the section
Bank and account.

3. Filter by Currency or Type of account information in the section at the
bottom of the window.

4. Save it for further use by clicking the button Save filter.

5. Click the button Apply filter to execute the filter. The Account information
window appears. Only accounts which meet the selected filter criteria are
displayed.

In case you want to use a filter you previously saved:

1. Select the option Existing filter and select one of the filters in the dropdown list.

2. Click the button Apply filter.

In case you want to modify a filter you previously saved:

1. Select the option Existing filter and select one of the filters in the dropdown list.

2. Modify the filter as required.
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3. Click the button Save filter.

4. Click the button Apply filter to execute the filter.

 Note
The filter stays active as long as you keep working in Isabel 6 eBanking. The filter can only be
inactivated by selecting No filter from the Filter dropdown list in the  Accounts overview window or by
logging off.

To delete an existing filter:

1. Select the option Existing filter and select one of the filters in the dropdown list.

2. Click the button Delete filter at the right hand side of the dropdown list.

How can I...:

Download report files?
Consult account information?
Search for a transaction in the account information?
Print or export account information?

More information:

Detailed window description of the filter criteria 

The navigation pane:

Actions
Clear criteria: clear all selected filter criteria in the Display Zone
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How to define default filters? Document
ID: 38225
Modified:
03/05/2013
Created:
03/05/2013
Version: 8

Prerequisite:

eBanking users prefer to have at start-up a view with their preferred filter.

It is possible to save a desired default filter in the application. There is a functionality that allows setting and
saving the default filter that is used in the Account Info area (and in the Transactions area).

Steps:

You can define the list of filters of the Account Info area via the Filter functionality:

Shows the filter(s) defined by you with the Filter action.

 Notes
An exception is the system defined filter “Not yet consulted”.

This filter is listed at the bottom of the dropdown list, clearly separated from user
created filter(s). 
This filter cannot be modified in the Filter screen.
This filter shows all accounts which have not yet been consulted, i.e. which are in
bold. This applies to all types of received account info: booked, intraday & future.

Applying the Account Info filter from the Preferences: 

1. After selecting the "Default filter", click on the Save button.

2. Restart the application to apply the changes.

3. After this change and until a next change, each time you start the application, the filter
chosen in the Preferences is applied. 
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If you delete the filter that is defined by default, the system returns a pop up with a warning message and the
system displays the “No filter” filter.
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Search Account Info overview Document
ID: 1078
Modified:
08/05/2013
Created:
08/05/2013
Version: 49

Purpose:

You can search for booked transactions in accounts based on specific criteria, such as an entry date, an
amount or the name of the other party. By doing this, you can search very precisely for the account information
you would like to see.

 How to access
Select Account Info tab > Actions menu > Search

The Search Account Information window consists of the following sections:

Bank and account: in this section you can select one or more account numbers from one or more banks (if
available). If not all accounts are visible, use the scroll bar on the right-hand side of this section to scroll up or
down.

Account: the account number. If applicable, the account numbers are grouped by bank.
Account holder / Alias: the name of the account holder.

Search by:

Type of account information: in this sub tab, you can select the type of account
information (Booked, Intra day or Future).

Date: in this sub tab, you can define the search criteria by date.

Type of Date: 2 date types can be selected (you have to select one of the two
types).

Value date: date on which a transaction starts to bear interest.
Balance date: date on which the transaction was booked (day balance).

From and To: start and end date of the period in which you wish to look for
transactions. Either enter the date manually, or select the date via the  icon.

Amount: in this sub tab, you can define the search criteria by amount.

Tips
When searching for debited (or negative) amounts, use the minus (-) sign.
If you search on the amount with numbers after the comma make sure you use a
comma "," as separator and not a point ".". Example: 15,99 will be found, 15.99
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will not be found.

Equals: option button to search for a transaction with an exact amount.
From and To: option button to search for a transaction with an amount with lower
and upper limit.

Transaction: in this sub tab, you can define the search criteria by transaction details.

Statement number: the statement number of the transaction, automatically assigned
by the bank.
Message: the communication of the transaction. 
Currency: select the currency used in the transaction in the dropdown list.

Counterparty: in this sub tab, you can define the search criteria by counterparty.

 Note 
In exceptional cases, the account information sent by your bank does not contain
the name or the account number of the counterparty (this info is however often
included in the transaction message or appendix). So, if you are looking for a
counterparty name or account , such account information will not appear in your
results. Search by "transaction message" is currently not supported.

Counterparty name: the name of the counterparty in the transaction.
Counterparty account: the account number of the counterparty in the transaction.

Search: click this button to apply the search criteria and view the search result.
Cancel: the button to cancel the search action.

 Note
In the menu Actions > Clear criteria you can delete the search criteria you have entered.

How can I...:

Download report files?
Consult account information?
Consult Account Info details?
Filter account information?
Search for a transaction in the account information?

More info:

Links to the detailed window description:

The search result
Details of a transaction
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Search result Document
ID: 1103
Modified:
29/04/2013
Created:
29/04/2013
Version: 29

Purpose:

This window displays the results of a search operation in the transactions, based on the
search criteria you have defined.

 How to access
Select Account Info tab > Actions menu > Search > Select the search criteria and click on the button
Search

The window with the results of the search action consists of a table with the following items:

Bank and account

Bank: the bank servicing the account.
Account: the account number on which the transaction is booked.
Date: the date on which the transaction is booked.
Statement number: the statement number of the transaction, automatically assigned by
the bank.
Amount: the amount of the transaction.
Currency: the currency used in the transaction.
Counterparty: the name of the account holder of the counterparty.
Back: the button to return to the Search criteria window.
Close: the button to finish the search action.

 Note
If a filter is applied to the account information, the search action is only performed for the filtered account
information. By clicking or double-clicking a transaction, you open the details of the transaction.

How can I...:

Search a transaction?

More info:

The navigation pane:

Actions
View details
New search: the action to start a new search
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How to search for a transaction in the Account Info? Document
ID: 1076
Modified:
30/04/2013
Created:
30/04/2013
Version: /

Steps:

To search for a transaction in the account information:

Select the Account Info tab.

Click Search in the Navigation pane under Actions. The Search account
information window appears.

 
Select the search criteria you wish to use.

Tip 
When you look up an Amount that contains a comma for the decimal places; you
can use an amount with a comma in the lookup fields "Equals" or "From" and "To". 

Click the Search button. The Search results window appears. An overview of all
transactions that meet the selected search criteria is shown.

Tip
Click a transaction in the results table to open the details of a found transaction.

Click the Close button to finish the search action.

Tip
To return to the search criteria window:

Click the Back button; or
Click New search in Navigation pane under Actions.

If a filter is applied to the Account info, the search action is performed only on the filtered Account info.

How can I...:

Download report files?
Consult account information?
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Filter account information?

More information:

Links to detailed window descriptions:

Search result
Search account info
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Exchange Rates overview Document
ID: 1090
Modified:
17/04/2013
Created:
17/04/2013
Version: 27

Purpose:

The Exchange rates window gives you a detailed overview of all foreign currencies and
their rates.

 How to access
Select Account Info tab >  View exchange rates

The Exchange rates window consists of the following items:

Exchange rate: the value of the target currency for 1 Euro 
Code: the code of the destination currency
Target currency: the currency of the destination
Last update: the date of the last update of the exchange rate

 Note
The exchange rate is not defined in real-time.

Close: the button to exit the Exchange rates window

More info:

The navigation pane:

Actions
Print list

Preferences
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How to print or export Exchange Rates? Document
ID: 34663
Modified:
30/04/2013
Created:
30/04/2013
Version: 4

Prerequisite:

Isabel 6 eBanking allows you to print or export overviews of the available Exchange Rates.

When selecting the print functionality, you can choose between printing to a PDF document or exporting to a
text file. The PDF document can be printed or saved. The text file is often used to export the data to another
program.

Steps:

1. Select the Account info tab.

2. Select View exchange rates in the Navigation Pane.

3. Click Print list under Actions in the Navigation Pane.

As a result the Print Options popup window appears.

Available Print options:
 

Daily updated exchange rates 
All exchange rates

4. Print or export Exchange Rates:

Show (and print) PDF document:

 Note
A PDF writer is not required to create the PDF file, this function is included in
Isabel 6 eBanking. However you need Adobe Reader to view the PDF file.
 

1. Click the Show PDF button. Next you can download and open the PDF
document via Reports in the Navigation pane.

2. Click the Print button in the toolbar of Adobe Reader. The overview, the
details or the summary will be printed.

Tip
It is possible to save the PDF document to your hard disk by clicking the
Save a Copy button in the toolbar.

3. Close the window with the PDF document.

Export to a text file:
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 Tip
The default text separator is ';'.
To modify the text separator:

Select the Transactions tab > Managing menu > Preferences menu-
item.
Select General from the Manage user preferences overview and enter
the text separator in the field When exporting as txt-file, separate with.

Tip
To simplify the import of your exported txt-file in Microsoft Excel, you can
rename the extension of the file to "csv" (e.g. report.csv).

1. Click the Export TXT button. Next you can download and open the TXT
document via Reports in the Navigation pane.

2. Click the Save As button. A Windows popup window appears to save the text
file to a destination folder.

3. From the Save in field, select the destination folder.

4. Enter the file name.

5. From the Save as type field, select Text File (*.txt).

6. Click the Save button and close the window.

More information:

Reports
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Download Report Files Overview Document
ID: 957
Modified:
07/05/2013
Created:
07/05/2013
Version: 1

Purpose:

You can enter account information in accounting and ERP packages manually, or you can import account
information. If you want to import account information, you simply need to sign up to the module Download
bank files and ask your bank to send the account information as report files (CODA).The bank then sends you
the report files, together with the original account information.

 How to access
Select Account Info tab > New menu > Download of reporting files

On the Download report files page, an overview of available reporting files is displayed.

You can filter the Not yet downloaded reporting files by selecting this filter on top of
the overview.
You can filter the available report files by selecting a filter from the Format dropdown list
on top of the overview.

 Tip
If not all reporting files are visible, use the browse buttons to browse through the files:

 

Saved: indicates whether the file is already downloaded ( ) or not.
File name / Account number: the file name / account number, as sent by the bank. In
case the reporting file contains one single account number, the account number will be
displayed instead of the filename. 
Bank: name of the bank that has sent the report file
Format: the format of the report file (CODA, MT940, ...)
Statement date: the period to which the report file refers
Advanced download: use a filter for file type or period to download a limited file
range
Download: the button to start downloading the selected report files
Cancel: the button to return to Account Info

How can I...:

Sign up to the Isabel 6 modules?
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More info:

Links to related window descriptions:

Download Report Files Overview
Download Report Files
Advanced download of Report Files

Summary of a Report File
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Download Report Files Document
ID: 1267
Modified:
30/04/2013
Created:
30/04/2013
Version: 28

Purpose:

In the Download report files window you can navigate to the destination folder where you wish to save the
report file.

 How to access

Select Account Info tab > New menu > Download of reporting files > Select
the report files > Download button; or 
Select Account Info tab > New menu > Download of reporting files > Open the
summary of a report file > Download button

The Download report files window contains the following items:

The tree view to navigate to the local folder where you wish to save the report files
Start download: the button to start the download of the selected report file(s)
Cancel: the button to cancel the download

How can I...:

Sign up to the Isabel 6 modules?
Consult or view the summary of the content of a report file?
Download reporting files? 
Print or export a report file?

More info:

Links to detailed window descriptions:

Download Report Files Overview
Download Report Files
Advanced download of Report Files

Summary of a Report File
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Advanced download of Report Files Document
ID: 21716
Modified:
30/04/2013
Created:
30/04/2013
Version: 31

Purpose:

This option offers you advanced possibilities to execute report downloads based on file
type and/or date.

 How to access
Select Account Info tab > New menu > Download of reporting files > Advanced download or the button
Advanced download in the below right corner of the screen.

As a result the popup window Advanced download appears.

This window contains the following items:

Type of download file:

All (default value)
CODA
MT940
...

Date: this option allows selecting a period.

Period:

Today (default value)
Yesterday
Last 3 days  
This week
Last week
This month
Last month

All files received From date To (with calendar). You don't have to type the /. The
maximum period allowed is one month and the inserted dates have to be valid. 

Include already downloaded files: If you select this checkbox, all already downloaded
files available in the selected period and with the selected format will also be
downloaded.

Download: the button to start the download of the selected report file(s)

Cancel: the button to cancel the download
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How can I...:

Sign up to the Isabel 6 modules?
View the content of a report file?
Download reporting files? 
Print or export report files?

More info:

Links to related window descriptions:

Download Report Files Overview
Download Report Files

Summary of a Report File
Related articles:

Isabel Go, the Isabel Go button in your accounting package that allows you to send payment and
account information to and from your accounting software and Isabel 6: These Isabel Software Partners are
ready.

If your accounting package supports Isabel Go, you need to activate the "Isabel Go" module and the
"Download bank files" module.
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Summary of a Report File Document
ID: 976
Modified:
30/04/2013
Created:
30/04/2013
Version: 36

Purpose:

The file summary of a report file contains the details that are not visible in the overview of
the available report files.

 How to access

Select Account Info tab > New menu > Download of reporting files > Select a
report file > Actions menu > View file; or
Select Account Info tab > New menu > Download of reporting files > Double click
a report file

The Report file summary window contains the following sections:

1. File properties:

This section gives you general information about the report file. 
 

Name: the file name, sent by the bank.
Type: the format of the report file (CODA, MT940,...).
Bank: name of the bank who has sent the report file
Size: the size of the file.
Reception date: the date on which the bank has sent the report file.

2. Content:

This section gives you detailed information about the content of the report file. 

3. History of downloads:
 

Downloaded By: name of the user and the date when the report file was
downloaded.
Multiple users may have downloaded the report file.
Date: date when the reporting file is downloaded.

Download: the button to start downloading the opened report file.
Cancel: the button to close the Report file summary window.
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How can I...:

View the file summary of an account statement?
Print or export account information?
Sign up to the Isabel 6 modules?
Consult or view the summary of the content of a report file?
Download reporting files? 
Print or export a report file?

More info:

Links to related window descriptions:

Download Report Files Overview
Download Report Files
Advanced download of Report Files.
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How to download Report Files? Document
ID: 942
Modified:
30/04/2013
Created:
30/04/2013
Version: 43

Prerequisite:

To be able to download report files you need the module Download bank files.

Steps:

To download reporting files (CODA, MT94X, ...):

1. Select the Account Info tab.

2. Click Download of reporting files in the Navigation pane under New. An overview
of available report files appears.

 

3. Select the report files you wish to download.

4. Click the Download button.

The Download report window appears. 

5. Select the destination folder in the tree view.

 Tip
You can download the account statements directly to a server on the network in
case a logical driver has been assigned for this server on the local computer.

6. Click the Start download button.
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A popup window appears with the Destination Directory and the selected account
statements. When the statements are downloaded, the title bar of the popup window
indicates Download finished successfully.

7. Click the Close button to end the download. Next you return to the list of available
account statements where the status pictogram  indicates whether the file is
already downloaded or not.

8. Click the Cancel button. Next you return to the account overview.

How can I...:

View the content of a Report file?
Consult Account Info details?
Sign up to the Isabel 6 modules?

More information:

Download Report Files Overview
Download Report Files
Advanced download of Report Files

Summary of a Report File
Discover CODA

 Isabel Go, the Isabel Go button in your accounting package that allows you to send payment and
account information to and from your accounting software and Isabel 6: These Isabel Software Partners are
ready.

If your accounting package supports Isabel Go, you need to activate the "Isabel Go" module and the
"Download bank files" module.
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How to view the content of a Report file? Document
ID: 975
Modified:
08/05/2013
Created:
08/05/2013
Version: 23

Steps:

To view the content of a reporting file:

1.  Select the Account Info tab.

2. Click Download of reporting files in the Navigation pane under New.

 
An overview of all available report files appears.

3. Select the report file that you wish to consult.

4. Click View file in the Navigation pane under Actions.

Next the summary of the report appears.

 Tip
If you wish to view the content of multiple files at once, select the reporting files and then click Print (in the
Navigation pane under Actions). Next click Show PDF in the popup window.

How can I...:

Download report files?
Print or export a report file?

More information:

Links to detailed window descriptions:

Overview download report files
Report download
The file summary of a report file

The navigation pane
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How to request one-off Intraday or Future info (optional)? Document
ID: 8252
Modified:
07/05/2013
Created:
07/05/2013
Version: 34

Steps:

You have the possibility to obtain Intraday or future info with a one-off (non recurrent) demand at your bank(s).

 Notes

Your account information is updated within 25 minutes after a request.

Intraday and/or Future info on demand is only available for certain banks.
 

To create a one-off Intraday/Future info request:

1. Select the “Account info” tab.

2. Select “One-off intraday/future request” info in the "Navigation pane" under
Actions.

 
As a result the “One-off intraday/future” popup appears.

 
 Note

You can click the “More Info” button to expand a dropdown list containing the
banks for which Intraday and/or Future information is requested.
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3. Click the OK button to send the on demand request.

 

As a result a “One-off intraday/future” toast message appears to indicate that “Your
request has been sent”.

 Note
Only one request is possible every 60 minutes. If you click the OK button in the
“One-off intraday/future" popup within an hour after the previous click, a “One-off
intraday/future” toast message appears to indicate that “The minimal time
between requests (60 minutes) hasn’t passed yet”.
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The result of the request is displayed in the account info area.

How can I...:

Request recurrent Intraday or Future info (optional)?
View Intraday or Future info (optional)?

More information:

What to do if I didn't receive Intraday- or Future info yet?
What banks send Intraday- and Future information?
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How to request recurrent Intraday or Future info (optional)? Document
ID: 8242
Modified:
07/05/2013
Created:
07/05/2013
Version: 44

Purpose:

You have the possibility to obtain Intraday or future info with a recurrent demand at your bank(s).

 Note
Intraday and/or Future info is only available for certain banks.

 

To create a recurrent Intraday/Future info request:

1. Select the "Account info" tab.

2. Select the "Recurrent intraday/future" info in het "Navigation pane" under
Managing.

As a result the “Recurrent intraday/future” menu appears in the account area.

You select one of the following options:

1. Never: you cancel all existing requests.

2. "At logon": a request is launched as soon as you logon to the eBanking
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2. "At logon": a request is launched as soon as you logon to the eBanking
application (Bankit) on the "Welcome page" .

3. "During working days at selected hours": one or more hours between 8:00
and 18:00 on a working day..

 Notes

You are also informed that for the planning of recurrent requests the CET
(Central European Time) time zone is used. The time zone can be adapted
in the Preferences screen.

In total you can never request more than 6 updates per day:

The total “Number of remaining selections” is displayed in the account
area, the remaining combinations (as described) are not displayed.

Maximum 4 "During working days at selected hours";

Maximum 6 " One-off intraday/future";

Maximum 6 "At logon";

Or any combination of these.

In case you have already requested 6 updates on a day, and you try to
launch a 7th, a toast message is shown indicating “Intraday/future: only 6
messages allowed per day”.

Scheduled and “On every logon”  requests have higher priority than on
demand requests.

3. Click the Save button. After processing the request, the result is displayed in the
account info area at the scheduled time.

How can I...:

Request one-off Intraday or Future info?
View Intraday or Future info (optional)?

More info:

I didn't receive Intraday- or Future account information
What banks send Intraday- and Future information?
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How to view Intraday or Future info (optional)? Document
ID: 8244
Modified:
07/05/2013
Created:
07/05/2013
Version: 35

Purpose:

To view Intraday/Future info information.

1. Select the Account info tab.

2. Click for a specific account on Intraday date or Intraday balance which indicates
that information is available for that account.

In the case of Future info the availability of information is indicated by a clickable
checkmark.

Notes
Additional intraday information is available on the Account statement overview:

In the intraday information section you can see the time the bank has sent the
account information (Intraday: transactions of hh:mm).

The Reception date/time displayed is not the time the eBanking application has
received the file but it is the time that is mentioned in the reporting message MT942.
In case the bank hasn’t provided the date or time in the file, no reference is displayed.
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How can I...:

Request one-off Intraday or Future info?
Request recurrent Intraday or Future info (optional)?

More info:

I didn't receive yet Intraday- or Future account information
What banks send Intraday- and Future information?
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How can I print or export Report Files? Document
ID: 34660
Modified:
30/04/2013
Created:
30/04/2013
Version: 9

Prerequisite:

Isabel 6 eBanking allows you to print or export overviews or details of the available report files.

When selecting the print functionality, you can choose between printing to a PDF document or exporting to a
text file. The PDF document can be printed or saved. The text file is often used to export the data to another
program.

Steps:

1. Select the Account Info tab.

2. Click Download of reporting files in the Navigation pane under New.

3. Select one or more report files you want to show (and print).

4. Click Print under Actions in the Navigation Pane.

As a result the Print Options popup window appears.

Available Print options:
 

Overview of (selected) files
Details of each of the selected files:
 

File properties 
File contents 
History of downloads 

5. Print or export report files: 
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Show (and print) PDF document:

 Note
A PDF writer is not required to create the PDF file, this function is included in
Isabel 6 eBanking. However you need Adobe Reader to view the PDF file.
 

1. Click the Show PDF button. Next you can download and open the PDF
document via Reports in the Navigation pane.

2. Click the Print button in the toolbar of Adobe Reader. The overview, the
details or the summary will be printed.

Tip
It is possible to save the PDF document to your hard disk by clicking the
Save a Copy button in the toolbar.

3. Close the window with the PDF document.

Export to a text file:

Tip
The default text separator is ';'.
To modify the text separator:

Select the Transactions tab > Managing menu > Preferences menu-
item.
Select General from the Manage user preferences overview and enter
the text separator in the field When exporting as txt-file, separate with.

Tip
To simplify the import of your exported txt-file in Microsoft Excel, you can
rename the extension of the file to "csv" (e.g. report.csv).

1. Click the Export TXT button. Next you can download and open the TXT
document via Reports in the Navigation pane.

2. Click the Save As button. As a result a Windows popup window appears to
save the text file to a destination folder.

3. From the Save in field, select the destination folder.

4. Enter the file name.

5. From the Save as type field, select Text File (*.txt).

6. Click the Save button and close the window. 

More information:

Reports
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Aliases for Accounts Document
ID: 1088
Modified:
30/04/2013
Created:
30/04/2013
Version: 31

Purpose:

In the overview of the available accounts or in the list of your ordering accounts, the Account holder name is
defined by the bank. If the name is unclear or confusing, you can assign an easy-to-remember alias for each
account number.

 How to access

For reporting accounts: Select Account Info tab > Managing menu > Aliases For
accounts
For ordering accounts: Select Transactions tab > Managing menu > Aliases For
accounts

 Note
An alias created for an ordering account will not be available for the corresponding reporting account and
vice versa. When both accounts must have an alias you have to specify it for both accounts.

The Aliases for Accounts window contains a table with the following columns:

Account: this column contains the available account numbers, together with their
currencies
Account holder: this column shows the name of the account holder as it is assigned by
the bank. This name will be used when selecting this account number in transactions.
Alias: the field to add an easy to remember alias to the account number
Bank: the name of the bank of the account
OK: the button to apply the changes
Cancel: the button to discard the changes

 Notes

The Aliases for Accounts on the Account Info tab are not copied to the Aliases for
accounts and to the Aliases for counterparties on the Transactions tab and vice
versa.
The Aliases for Accounts list can not be sorted from the Alias column.

More info:

The navigation pane:

Actions
Delete all selected aliases: clear the alias fields of all the selected accounts
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Transactions overview Document
ID: 697
Modified:
17/04/2013
Created:
17/04/2013
Version: 72

Purpose:

The Transactions window displays the list of the created transactions. In this list, you can
easily follow the status of each transaction.

The overview of the transactions is shown in a table containing 9 columns:

 : check boxes to select one, more or all transactions. In the Navigation pane under
Actions, you can see the authorised actions and the selected transaction(s) that are
applicable for you.
 : indicates which transaction was inserted with the urgency code or payment method

Urgent.
Action: contains icons which indicate the status and what action needs to be taken.

Icons Status

The transaction needs To be completed, user interaction is required.

The transaction is Refused by another user or by Isabel due to an error.

 The transaction needs To be signed.

The transaction is Sufficiently signed, is ready to send.
The transaction is Insufficiently signed. One or more signatures are missing
to be able to send the transaction.

An action is pending. If you click the icon, you will see the message A refresh is needed to
receive an update of the file status. Click OK to continue.

Description: the name of the transaction.
Nbr.: the number of transactions in a group transaction.
Total: the total amount of the transaction.
Bank: the bank to whom the transaction will be sent.
Memo date: the date on which the transaction should be carried out or on which the
amount should be transferred to the beneficiary account.
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 Note
The meaning of the memo date can vary depending on the principal account's bank.
Contact the principal account's bank to get information on how this bank handles
transactions with a memo date.

Creation time: the creation date and time of the transaction.

  Tips

In the Filter dropdown list (in the Filter-field on top of the Display-zone) you
can choose which transactions you want to see.

In the Context dropdown list (in the Filter-field on top of the Display-zone) you
can choose which bank you want to see. The Context filter is only available if you
have multiple banks. The content of the filter choices is composed in the following
way and order:

Identification label
Bank name 
Contract ID

If not all transactions are visible, use the Browse buttons to browse through the
transactions.

 Note
When you select transactions in de Display-zone you can consult the following additional information in the
zone below the Browse buttons:

The number of Selected transactions is the number of selected rows (which may
contain one or more transactions). 
The Nbr of transactions that are selected by you. The Nbr of transactions is only
displayed if the total number of selected (group)-transactions is known (See Nbr.
column), in other words it will not be displayed if a DIV file is selected.
 The Total amount of all selected items. The Total amount is only displayed if
the selected items have the same currency.
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How can I...:

Create a domestic payment?
Create an international payment?
Create a SEPA payment?
Create a group of payments?
Create a direct debit?
Upload files?
Sign a transaction?
Send a transaction?
Group a transaction?
Ungroup a transaction? 
Print or export transactions?

More info:

Which wizard for which payment?
Video about working with transactions

Using Isabel 6 - v6.26 - 697 - Transactions overview 15/05/2013

81 / 283

https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=897
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=880
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=20877
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=1886
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=5435
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=1197
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=917
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=1228
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=1201
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=1210
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=34643
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=29532
https://www.isabel.eu/en/forbusiness/solutions/isabel6/demo/demoPlayer25fps.html?type=standard&file=/content/dam/isabel6/media/mp4/en/ISABEL6-EN-11.mp4&stretching=uniform


Transaction Details Document
ID: 4196
Modified:
13/05/2013
Created:
13/05/2013
Version: 31

Purpose:

In the overview of transactions, not all information of a transaction is displayed. You can
view all information by opening the details of a transaction.

 How to access

Select Transactions tab > Click the name of the transaction; or
Select Transactions tab > Select a transaction > Actions menu > View details

The transaction details contains the following items:

In the upper section of the Transaction details you find signature information and possible feedback on the
transaction.

 Note
Depending on the fields that were filled in, some of them will or will not be visible.

Payments group:

 
Payment group: the name of the group of transactions
Transaction type: the type of transaction (ordinary transfer, salary payment, ...)
Global/single debit:

Global debit: Global debit is activated, the total amount is shown on your account
statements
Single debit: Global debit is deactivated, every order is entered as a
separate transaction on your account statements  

Urgency code: the urgency code of the transaction 

Urgent: urgent transaction
Not urgent: normal transaction, no urgency

File reference: a reference which may be useful for your internal accountancy
Transaction reference: the reference of the transaction, assigned by Isabel  
Creation date/time: Date and time on which the file is uploaded

Using Isabel 6 - v6.26 - 4196 - Transaction Details 15/05/2013

82 / 283



eBanking contract: the Banking contract, used for the transaction
Contract bank: the bank of the ordering account
Contents:

Ordering party account: principal account, used in the transaction
Beneficiary account: the account number of the beneficiary
Beneficiary name: the name of the beneficiary as it will appear on your account
statement.
Memo date: the date on which the transaction should be carried out or on which
the amount should be transferred to the beneficiary account

 Note
The meaning of the memo date can vary depending on the principal account's
bank. Contact the principal account's bank to get information on how the bank
handles transactions with a memo date.

Amount: the amount to be transferred
Message to beneficiary: a message for the beneficiary 

Number of transactions: the number of transactions included in the group
Total: the total amount of all transactions. This amount is entered on your account
statements if Global debit is activated.

Single payment:

 
Ordering party account: principal account, used in the transaction
Beneficiary name: the name of the beneficiary as it will appear on your account
statement.
Beneficiary address: the address of the beneficiary
Beneficiary account: the account number of the beneficiary
Amount: the amount to be transferred
Indicative exchange rate: the exchange rate when it concerns a non Euro payment
Memo date: the date on which the transaction should be carried out or on which the
amount should be transferred to the beneficiary account 
Message to beneficiary: a message for the beneficiary 
User reference: an internal reference that can be useful for you (for instance your
accounting program)
Payment type: ordinary transaction or cheque
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Foreign payment method code: the code to indicate how the payment must be
handled by the bank, only available for international transactions
Transaction charges: the code to indicate who carries the payment costs
(principal, beneficiary or shared), only available for international transactions
Beneficiary bank BIC: the Bank Identification Code of the beneficiary's bank, only
available for international transactions
Transaction reference: the reference of the transaction, assigned by Isabel  
Creation date/time: Date and time on which the file is created
eBanking contract: the Banking contract, used for the transaction
Contract bank: the bank of the ordering account

Audit trail history: the button to view the history of the transaction.
Sign: the button to sign the transaction
Send: the button to send the transaction to your bank

Close: the button to close the details of the transaction

More info:

How to hide the account info details of one of my payments?
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Signing transactions overview Document
ID: 733
Modified:
17/04/2013
Created:
17/04/2013
Version: 32

Purpose:

Each transaction that you send to your bank or to other correspondents, must be
accompanied by a digital signature. When a transaction is signed the bank can verify the
authenticity of the transaction.
Before you can send a transaction to your bank or to other correspondents, you and/or other signatories must
secure the transaction with a digital signature. A signature is compulsory for each transaction.

By signing a transaction with a digital signature:

You agree with the information that was filled out and you indicate that the order is ready;
You are sure that the recipient knows that you sent the transaction;
You are sure that the recipient knows that the transaction was not changed during
sending.

To be able to sign a transaction, the transaction must first be prepared on the Transactions tab. There are 3
different ways to sign a transaction:

1. One cardholder creates and signs the transaction; or 

2. One cardholder creates and signs the transaction but additional signatures of other
cardholders are required to obtain a valid signed transaction. Therefore he/she needs
to invite other cardholders during the creation of the transaction; or

3. One cardholder creates the transactions but he/she has no authority to sign the
transaction. Therefore he/she needs to invite other cardholders during the creation of
the transaction.

The other cardholders are invited by:

An Isabel 6 mail invitation (in the Miscellaneous pane); or

 
A regular e-mail invitation. This is only the case if other invited cardholders have
configured their e-mail address in the Preferences of the Isabel 6 eBanking application.

When a cardholder receives an invite, he/she can add his/her digital signature to the transaction in the
eBanking application.
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The digital signature for a transaction will always be created with the Isabel OfficeSign component. The Isabel
OfficeSign popup window will automatically appear when the signature needs to be created.

For security reasons, each character of your password is displayed as an asterisk in the window.

Once the transaction is sufficiently signed you can send it manually to the bank or it will be automatically sent if
this option is chosen in the transaction processing options.

 Note
If you want to use the option Send when sufficiently signed, you will need to activate the module MultiSign.

Sign & Send information overview:

The Sign & Send information for transactions in or outside an envelope is displayed in a popup window. The
system detects the signable transactions and displays the unsignable transactions.

If the selection of banking files in or outside an envelope contains (at least) one banking
file with a state different from “to be signed”, “insufficiently signed” or “sufficiently
signed” or for which the logged-on user is not an eligible signer then the system displays
a report containing these transactions.

This report is displayed when at least one selected transaction cannot be signed.
The table shows the name of the selected transactions that cannot be signed.
If you click on the Continue button, the signature flow continues.

If transaction(s)  in or outside an envelope are not ready to be send due to their status or
authorization, the system displays a report containing these transactions.

This report is displayed when at least one selected transaction cannot be signed.
The table shows the name of the selected transactions that cannot be signed.
If you click on the Continue button, the signature flow continues.

How can I...:

Sign a transaction?
Make one or more other users sign a transaction?
Sign a large number of transactions?

More info:

The page keeps loading when you have signed a transaction.
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How to sign transactions? Document
ID: 917
Modified:
09/04/2013
Created:
09/04/2013
Version: 52

Steps:

To sign transactions in eBanking:

1. Select the Transactions tab.

2. Select the transaction(s) you wish to sign.

3. In the Navigation pane under Actions, click Sign.

 Warning
When you don't have the appropriate or sufficient power to sign authorizations for a
specific transaction, the Sign link is greyed out when this specific transaction is
selected.

A popup window appears with the details of the selected transaction.

 Note
If multiple transactions are selected, you can browse through the selected
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transactions by clicking the  or  buttons.

4. Enter your PIN-code with the Isabel card reader and confirm. The selected
transactions are signed and you return to the transactions overview.

 Note
When you return to the transactions overview, the To be signed  icon is not
changed immediately. After a few minutes and after refreshing the page, this icon
will be changed into the Sufficiently Signed  icon or into the Insufficiently
Signed  icon (if the transaction is still to be signed by other users).

How can I...:

Enter my PIN-code with the Isabel card reader? 
How can a transaction be signed by multiple users?

More information:

I want to sign a direct debit order or a transaction but the sign link is greyed out. What now?
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How to invite or change signers? Document
ID: 1208
Modified:
30/04/2013
Created:
30/04/2013
Version: 18

Steps:

To modify the signers for a created transaction:

1. Select the Transactions tab. 

2. Open the details of the transaction where the signer(s) must be modified. 

3. Click Modify processing options in the Navigation pane under Actions.

4. Change the Signer(s) to invite with the < > buttons and click the Submit button.

How can I...:

Modify the processing options of a transaction?
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How to make one or more other users sign a transaction? Document
ID: 3078
Modified:
30/04/2013
Created:
30/04/2013
Version: 51

Steps:

There are two ways to sign a transaction by more than one user.

Actions that each user/signer is required to carry out from his/her own computer:

1. Open the invitation you received by e-mail. The description of the transaction is
mentioned in the subject of the e-mail and the person who has invited you is
mentioned in the body of the e-mail.

 Notes
1. This invitation can only be received if a valid e-mail adress is configured in the

Preferences of the Isabel 6 application. 

2. To use the Invite signer option, the initiator needs the module MultiSign.

2. Start the Isabel 6 application.

3. Select the Transactions tab.

4. Select Transactions to be signed from the Filter dropdown list.

5. Search the transaction that is mentioned in the subject of the e-mail.

6. Sign the transaction.

 Note
The other signers are invited by:

1. An Isabel 6 mail invitation (in the Miscellaneous pane); or

2. A regular e-mail invitation. This is only the case if other invited signers have
configured their e-mail address in the Preferences of the Isabel 6 eBanking
application.

Actions that you or every other user/signer have to perform on the same computer:

1. The initiator should first select the transaction(s) that needs to be signed.

 Tip
If the concerned transaction(s) is/are not visible, select Transactions to be signed
from the Filter dropdown list.
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2. Click Switch Signer in the Navigation pane under Actions.

 Note
To use the Switch signer option, the initiator needs the module MultiSign.

3. Select the other signer from the dropdown list.

4. Let the other signer insert his/her Secure Signing Card in the card reader and click the
Next button.

5. The other user selects his/her certificate and clicks the OK button.

6. The other signer inserts his/her pincode. Next appears an overview of the transactions
to be signed.

7. Click the Next button to proceed. Next, a popup window appears with the details of the
selected transactions.

 Tip
 With multiple transactions it is possible to browse through the transactions by
clicking the  and  buttons.

8. The other signer signs the transactions.

9. The other user selects his/her certificate and clicks the OK button.

 Notes

When you return to the transactions overview, the To do icon does not change
immediately. After a few minutes and after refreshing the page, this icon will change
into the Sufficiently signed icon .
The transaction(s) can also be signed by several users without the use of the module
MultiSign. To do so, follow the steps hereunder.

a. Each user/signer has to log into the Isabel 6 application separately
b. Select Transactions to be signed from the Filter dropdown list.
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c. Sign the transaction(s) that needs to be signed.

How can I...:

Enter my PIN-code with the Isabel card reader?
Sign a transaction?
Subscribe to modules?
Switch a signer?
Invite a signer?

More information:

Video about signing with several users
Details of General preferences
Troubleshooting issues related to the "Switch Signer" function
You are unable to see the transactions that need your signature
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How to sign a large number of transactions? Document
ID: 38197
Modified:
08/04/2013
Created:
08/04/2013
Version: 7

Prerequisite:

It is possible to increase the number of displayed transactions in steps of 20 up to a maximum of 100 for one
page. As a result it is also possible to sign to up to 100 transactions in one time.

 Note
The system will propose to enter a signature every 20 transactions.

Select the Transactions tab.

Steps:

1. Select the number of transactions to be displayed.

2. Select the transactions to be signed.

3. Click on Actions > Sign.

As a result the system detects the signable transactions and a Warning popup
window appears containing the unsignable transactions.

4. Click the Continue button.

1. Next the popup window appears to sign the transactions.
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2. Also a toaster notification window appears in the right down corner of the screen
that notifies:

1. the number of transactions that are ready to be signed.

2. that the system will propose to enter a signature every 20 transactions

3. the number of transactions still to be signed with a progress bar

Note
An envelope may contain an unlimited number of transactions. Nevertheless we advise you to limit the
number of transactions in an envelope to 100.

How can I...:

Add transactions to an envelope?
Remove transactions from an envelope?
Change the number of transactions displayed?
Use envelopes with Payment?
Use envelopes with Upload of files?
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Clone or duplicate transactions Document
ID: 8635
Modified:
26/03/2013
Created:
26/03/2013
Version: 18

Instead of creating a new transaction, you have the possibility to clone a transaction. This means that you can
create an exact copy of a previously created transaction and modify it according to your needs.

 Note
A cloned transaction maintains every detail of the original transaction, except for the signature(s) and the
audit trail.

The feature is available for the following transaction wizards:

Payment
Group of payments
SEPA direct debits

 How to access
Select (Sent) Transactions tab > Select a transaction > Actions menu > View details > Actions menu >
Clone transaction:

If all transactions are ok then a popup window appears with the message "The
execution date of the cloned transaction(s) has been updated. The customer
reference of the cloned transaction(s) has been updated":

The correct transaction wizard is displayed with the cloned transaction(s).

If not all transactions are ok then a popup window appears that invites you to delete
or correct the invalid transaction(s):

The correct transaction wizard is displayed with the cloned transaction(s).
Erroneous transactions are put together in a group.

 Note for the cloning of a "Group of domestic payments (Old wizards)"
The following fields cannot be changed afterwards:

Memo date: if required, you will have to create a new "Group of domestic
payments" instead of a duplicate.
Urgency code
Transaction type
Type of debit (global debit or single debit by transaction)

How can I...:

Create a group of domestic payments?
Create a beneficiary group (workaround)?

More info:

You cannot change some fields when trying to modify one or more payments in a Group of payments.
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Creating Payment overview Document
ID: 20867
Modified:
30/04/2013
Created:
30/04/2013
Version: 1

Purpose:

With Isabel eBanking, you can create a payment (either SEPA or non SEPA) in the Euro zone on the
Transactions tab > New > Payment

The payment consists of a single screen in which you can enter all information required for the payment.

A SEPA payment consists of a transaction in Euros carried out between bank accounts established in one of
the 27 member states of the European Union, in Iceland, Norway or Liechtenstein. Both parties will have to
respect the IBAN and BIC account number formats.

The Payment window contains the following items:

1. Payment data: contains all the core payment data elements.

Originator alias: the alias assigned to the principal account
Originator name: the name of the principal account. After the principal account is
selected, the name, the account number, the account currency, country code and
bank are automatically filled in.
More...: if this link is clicked, the Address bar of the originator becomes visible
Originator Address: becomes only visible while clicking on the More link and
shows the address of the originator
Originator Account Number: the ordering account from which the amount will be
debited. The available ordering accounts are listed in a drop-down list. A name is
assigned to each ordering account.
Originator Account Currency: prepositioned to EUR. All SEPA transactions are
done in Euro.
Originator Country Account: country to which the account number belongs
BIC: the Bank Identification Code of the originator account.

To:

Beneficiary: the option to select an existing beneficiary or create a new one.
You can select a beneficiary by alias, account number or by name and address.
To use a new beneficiary, you can simply start typing his/her data in the fields.
Own account: the option to select a personal account. The personal account
numbers are listed in a drop-down list.
Alias: alias of the beneficiary account. The Clear all button allows you to delete
all entered data.
Beneficiary Account Country: country of the beneficiary account.
Account number (IBAN): account number of the beneficiary. The button allows
you to Edit account format.
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BIC: Bank Identification Code, composed of 8 to 11 characters. The Search
button allows you to look up the BIC code of the beneficiary account, related to
country, bank and location of the bank. The Search button searches a BIC
code.  
Name and address: the personal data of the beneficiary
The name and address are automatically filled in when an existing beneficiary is
selected. When you enter a new beneficiary you need to fill in the information
manually.
Update this beneficiary: the check box appears when you change any details
of an existing beneficiary and is checked by default. You can also choose to
save the amount and the message.
Save this new beneficiary: the check box appears when you enter a new
beneficiary and is checked by default. You can also choose to save the amount
and the message.

Payment data:

Amount: the amount to be transferred, use "." or "," to add decimals.

 Note
The maximum amount is:

999.999.999,99 € for SEPA payments. To insert this maximum amount
you have to split the payment or you can use the "Domestic payment
(Old wizards)"  if still available.
99.999.999.999,99 € for non-SEPA payments.

Transaction Currency: the default is set to Euro.

Execution date (dd/MM/yy): the date on which the transaction should be
executed or on which the amount should be transferred to the beneficiary
account. You can type the date manually or with the icon  . The “Execution
date” is automatically pre-filled with the current date. When the current date is a
weekend day, the next Monday is used as the default “Execution date”.

 Note
The interpretation of the execution date can vary depending on the principal
account's bank. Contact the principal account's bank to know how the bank
handles transactions with a memo date.

Message to beneficiary: message to the beneficiary.
More...: extension of the Message to beneficiary zone.
End to end identifier (Customer reference): the internal reference that can be
useful for your own accountancy (34 positions).

 Note

The transaction is indicated as a SEPA or non SEPA payment with the following
icons in the right-top corner:

  or 

The transaction is considered as a SEPA payment in case the following conditions
are true:

Account Number format is IBAN
BIC code is defined
Account Currency is Euro
Account Country is a SEPA country
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End to end identifier (Customer reference)

 Tip
You don't have direct access to the Account Info of the selected Originator
Account number. However you can easily switch from the Transactions tab  to
the Account Info tab (to retrieve the appropiate Account Info) and back without
losing already entered Payment data.

 Tip
Besides the functionality in the dedicated manage counterparties (beneficiary or
debtor) window in Isabel 6; you have also the possibility to create, modify and save
beneficiary data directly from the Payment wizard.

1. The created beneficiary data appears in bold and can be saved. The option
Save this new beneficiary is selected by default.

2. The modified beneficiary data appears in italics and can be saved. The option
Update this beneficiary is selected by default.

3. You have the possibility to add an additional account number to an existing
beneficiary.

 How to access
Select existing beneficiary > Delete Account number > Insert new Account
number > Select the "Update this beneficiary" option > The "Save this
account as a new account " option appears and is selected by default.

2. Define additional payment data: contains all additional payment data.

SEPA payment: with Reason of payment overview and High priority treatment by
your bank option
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non SEPA payment:

Reason of payment: the contents of the list varies according to the type of
payment (SEPA or non SEPA).
Cost attribution (non SEPA): option to select cost attribution (Shared charges,
All charges to principal or All charges to beneficiary). the default is Shared
charges.
Cost account (non SEPA): option to select cost account. A default cost account
can be defined in the Transaction preferences.
Currency (non SEPA): option to select currency.
Payment modality (non SEPA) 
Exchange method (non SEPA): type or select "exchange rate as per contract
number", only available if other currency.
Message to ordering party bank (non SEPA)
Intermediary Bank BIC Code (non SEPA): can be found with Search button
Message to beneficiary bank (non SEPA): type message or select from list
(Hold amount for beneficiary, Phone beneficiary or Contact beneficiary)
High priority: option to select to demand a priority treatment of your bank.

 Note
Contact the bank of the principal account to know if the bank demands
supplementary charges for a priority treatment.

3. Set advanced processing options: shows the advanced processing options
available for this payment.

Name: this field contains an automatically generated name for the transaction,
which can be changed.

Processing options:

Send when sufficiently signed.
Shared: the option to share the payment with other users.
Test processing.

 Note
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If you want to use the option Send when sufficiently signed, you will need to
activate the module MultiSign.

Potential signers: the list of all possible signers.

Select a user in the field Potential signers and click the right arrow button to
invite the user to sign the transaction.
Select a user in the field Signer(s) to invite and click the left arrow button to
remove the signer.

Invited signers: this field is of no use at the moment

The buttons at the bottom of the screen:

Next transaction: for encoding another SEPA transaction
Sign: to sign the transaction(s)
Send: to send the transactions to the bank
Finish: to finish creating the transaction and saves it. If data is missing, an error
message will invite you to fill in all required fields before closing this window.
Cancel: to cancel the transaction

How can I...:

Create a SEPA payment?

More info:

What do the abbreviations IBAN and BIC mean?
Which IBAN countries are supported in Isabel 6?
Which wizard for which payment?
Video about SEPA & non-SEPA payments
Transaction preferences
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How to create a SEPA payment? Document
ID: 20877
Modified:
22/04/2013
Created:
22/04/2013
Version: 45

Prerequisite:

SEPA stands for Single Euro Payments Area. SEPA creates an environment where people can use the
same payment tools (cards, transfers, ...) all over Europe.
 
Isabel 6 supports SEPA transactions. It is preferably that you create SEPA transactions with the IBAN account
numbers of your counterparties, but you can also use national BBAN accounts (12 digits).

Steps:

To create a SEPA payment:

1. Select the Transactions tab.

2. In the Navigation pane, under New, click Payment. The Payment window will be
displayed.

 Note
The transaction is indicated as a SEPA or non SEPA payment with the following
icons in the right-top corner:

   or 

The transaction is considered as a SEPA payment in case the following conditions
are true:

Account Number format is IBAN
BIC code is defined
Account Currency is Euro
Account Country is a SEPA country
End to end identifier (Customer reference)

3. Fill in the necessary fields in the various sections:
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Payment data

 Notes
If  your total number of counterparties exceeds the number defined by the
system configuration then:

•    The counterparties are not displayed.
•    A balloon message “Too many results. Type more characters ...” appears.

•    You have to type the first corresponding characters in the “Alias”, “Account
Number (IBAN)” or "Name and address" combo box. The purpose is to limit the
counterparties to be displayed in the dropdown list in order to optimize screen
performance.

Tip
The intelligent quick input mode enables you to use the tab key to navigate
optimally through the most relevant fields. 

Tip
You don't have direct access to the Account Info of the selected Originator
Account number. However you can easily switch from the Transactions tab  to
the Account Info tab (to retrieve the appropiate Account Info) and back without
losing already entered Payment data.

 Tip
Besides the functionality in the dedicated manage counterparties (beneficiary or
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debtor) window; you have also the possibility to create, modify and save
beneficiary data directly from the Payment wizard.

Define additional payment data
Set advanced processing options

4. Click on the Next transaction button to enter a new transaction or click on the Finish
button to end the creation of transactions.

More information:

Creating payment
What do the abbreviations IBAN and BIC mean?
Video about SEPA & non-SEPA payments
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How to print or export transactions? Document
ID: 34643
Modified:
21/03/2013
Created:
21/03/2013
Version: 7

Prerequisite:

Isabel 6 eBanking allows you to print or export overviews, details or summaries of the available transaction
data.

When selecting the print functionality, you can choose between printing to a PDF document or exporting to a
text file. The PDF document can be printed or saved. The text file is often used to export the data to another
program.

Steps:

1. Select the Transactions tab.

2. Select one or more transactions you want to show (and print).

3. Click Print under Actions in the Navigation Pane. As a result the Print
options popup window appears.

Available Print options:

Overview of (selected) files:
 

Add totals per bank
Add totals per bank account
Add totals per transactions currency
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Details of (selected) files:
 

Add processing data
Start new page per file (not applicable for “Print transaction details”)
Transactions are printed:

As in file
Sorted per amount: Ascending or Descending

Summary of (selected) files

4. Or click on a transaction in the Transactions area to open “View transaction
details” window > Select “Actions > Print transaction details” to open the “Print
options” popup window.

5. Print or export transactions: 

Show (and print) PDF document:

 Note
A PDF writer is not required to create the PDF file, this function is included in
Isabel 6 eBanking. However you need Adobe Reader to view the PDF file.

1. Click the Show PDF button. Next you can download and open the PDF
document via the Reports button in the Navigation pane.

2. Click the Print button in the toolbar of Adobe Reader. The overview, the
details or the summary will be printed.

Tip
It is possible to save the PDF document to your hard disk by clicking the
Save a Copy button in the toolbar.

 Example of a "Overview of (selected) files" PDF report

 Example of a "Details of (selected) files" PDF report
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 Example of a "Summary of (selected) files" PDF report

Export to a text file:

1. Click the Export TXT button. Next you can download and open the TXT
document via the Reports button in the Navigation pane.

2. Save the file as a *.txt file.

Notes
The default text separator is ';'
To modify the text separator:

Select the Transactions tab > Managing menu > Preferences
menu-item.
Select General from the Manage user preferences overview and
enter the text separator in the field When exporting as txt-file,
separate with.

To simplify the import of your exported txt-file in Microsoft Excel, you
can rename the extension of the file to "csv" (e.g. report.csv).

More information:

Reports
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Creating Group of payments overview Document
ID: 8620
Modified:
08/05/2013
Created:
08/05/2013
Version: 21

Purpose:

The wizard to create a "Group of payments" responds to the following needs:

Group SEPA Credit Transfers or XML Credit Transfers (grouping SEPA/Non SEPA)
and thus also international payments.

Enable a quick and automated input of multiple transactions in one group.

Group International payments.

Group transactions to reduce the quantity of banking files in the "Transactions area" and
reduce the number of signatures (this is similar to the principle of envelopes in IBS5).

Make modifications afterwards within a bulk of transactions.

The wizard to create a "Group of payments" is similar to the existing Payment wizard.

An accordion menu is used to display the group overviews:

Enables you to browse transactions which are being created.

Enables you to adjust group-wide parameters.

The automatic grouping of transactions is based on the following predefined criteria:

Originator account
Originator account currency
Transaction execution date
Priority
Qualified Transaction Type
Charges type
Costs account
Costs account currency
Payment method

How can I...:

Create a Group of payments?
Manage a Group of payments?
View the details of a group of payments?
Print or export a Group of payments?
Print or export the details of Group of payments?

More info:

Which wizard for which payment?
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How to create a Group of payments Document
ID: 1
Modified:
30/04/2013
Created:
30/04/2013
Version: 1

Steps:

1.    Select the Transactions tab.

2.    Select “New > Group of payments” or “New > Payment > Group of payments”.

As a result the “Group of payments” window appears with the “Payment Data” accordion menu open.

3.    Insert the payment data.

 Note
If  your total number of counterparties exceeds the number defined by the system configuration then:

•    The counterparties are not displayed.
•    A balloon message “Too many results. Type more characters ...” appears.
•    You have to type the first corresponding characters in the “Alias”, “Account Number (IBAN)” or
"Name and address" combo box. The purpose is to limit the counterparties to be displayed in the
dropdown list in order to optimize screen performance.

Tip
You have the possibility to select the "Keep the message for next transaction" option in the
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"Message to beneficiary" section of the "Payment data" accordion menu. If you select this option
and click the "Next transaction" button then the message is saved and still available in the
"Message to beneficiary" section.

4.    Click the “Next transaction” button. As a result the first group with the first transaction is created which
is displayed in the menu title by “(1)” of the “Created Groups” accordion menu.

In the “Payment Data” accordion menu the originator of the previous payment remains selected.

  

5.    Insert the payment data and click the “Next transaction” button until all transactions are inserted.

Tip
The intelligent quick input mode enables you to use the tab key to navigate optimally through the
most relevant fields. 

Tip
Besides the functionality in the dedicated manage counterparties (beneficiary or debtor) window; you
have also the possibility to create, modify and save beneficiary data directly from the Group of
payments wizard.

6.    Click on the “Created groups” accordion menu title to manage the groups. As a result the “Created
groups” accordion menu opens.

Tip
Every time you click on the title of an accordion menu:

•         The menu opens if it was closed.

•         The menu closes if it was opened.

The accordion menu can also be closed with the  button at the bottom of the menu.

When a new group is created, the system gives it automatically a name. 

You can click on the  button of a group to show the To section with the separate lines for each
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payment.

These lines contain the beneficiary Alias, the beneficiary account number and the Amount.

Tip
You can click on the  button to hide the To section with the separate lines for each payment.

Tip
You can assign one or more groups of payments to an envelope. When you select an envelope, all
selected groups will be assigned to the same envelope.

You can manage a group with the following tools (available for each group):

•         “Global debit” checkbox:

o    If checked: request a batch entry for the sum of the amounts of all transactions in a
payment. The mandates (power to sign) are applicable on the total amount.

o    If unchecked: request a single entry per individual transaction. The mandates are
applicable to the separate transactions.

•       or “Modify group transactions”button:

if you click the  button, the "Edit transactions" popup window is displayed and you can modify
the "Amount" and/or the "Message to beneficiary" of one or more transactions.

•          or “Modify the group attributes” button:

If you click the  button, the “Modify the group attributes” window opens in the “Created
Groups” accordion menu and you can adapt the following attributes (and you click afterwards
Save to confirm):

o    Originator data like “Originator Alias”, Name ...

o    Execution Date

o    Reason of payment

o    High priority

o    Message to beneficiary
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 Note
When you click the Save button the system:

o    Updates and validates all transactions belonging to the group with the new attributes.

o    Re-evaluates all transactions to know to which resulting group they belong:

-  In most cases this is the (one-and-only) original group.

-  It can also result in additional new groups.

-  If the criteria of a new group meet the criteria of an already existing group, these
groups are merged.

•       or “Set advanced processing options” button: 

If you click the  button than the “Set advanced processing options” window opens in the
“Created Groups” accordion menu and you can adapt the following options (and you click
afterwards Save to confirm):

o    The previously automatically created Group Name. If manually changed, there is no check
on the uniqueness.

o    Signer(s) to invite

o    Processing options:

-  Shared

-  Send automatically when sufficiently signed

  -  Hide details: specific option to hide sensitive information to other users of the
subscription (e.g. salary payments). This is in addition to the configured admin rights.

This option is available if needed for your job within your organization and if you have
a mandate of your organization (through admin rights).

If selected, then you as the initiator of the group of payments (unlike the other users
of the subscription) have the exclusive ability...

-     To view the full detail of the group of payments.

-     To generate the fully detailed report of the group of payments.

-     To modify the group of payments and the “Hide details” option.

-     To create a new group of payments based on the saved template of the group
of payments.
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You can manage a transaction in a group with the following tools (available for each transaction):

•           or “Modify the transaction” button: 

If you click the  button of a transaction (or the line of a transaction) than the “Payment Data”
accordion menu opens with the selected transaction:

o    You adapt the transaction data.

o    You save the adapted data:

-  By clicking another transaction in the “Created groups” accordion menu.

-  By clicking the “Next transaction”, “Sign All”,  “Send All” or “Finish” button at the
bottom.

Note
When you save the adapted data of a transaction the system:

o    Updates and validates the transaction.

o    Re-evaluates all transactions to know to which resulting group they belong:

-  In most cases this is the (one-and-only) original group.

-  It can also result in an additional new group.

-  if the criteria of the new group meet the criteria of an already existing group,
these groups are merged.

•          or “Delete the transaction” button:   

If you click the  button of a transaction a confirmation dialog appears with the text “Are you
sure you want to delete this payment transaction?”. You click the Yes button to confirm the
deletion.

7.    To continue, you click:

•         The “Sign all” button (analogue with signing a group of domestic payments, all related groups will
be signed); or

•         The “Send all” button; or

•         The Finish button

Note
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After a lost session you have to login again. A lost session is a session that is interrupted because of
technical problems or a session timeout. 

You are able to retrieve and complete his/her groups after a lost session:

If you go back to the Transactions area, a conformation popup window appears which offers you the
possibility to complete unfinished groups.

If you confirm with the Yes button, you are redirected to the “Created groups” accordion menu in the “Group
of payments” Window.

How can I...:

Creating Group of payments
Manage a Group of payments?
View the details of a group of payments?
Create and use a template of a Group of payments?

Using Isabel 6 - v6.26 - 1 - How to create a Group of payments 15/05/2013

113 / 283

https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=8620
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=3
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=5
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=43597


How to manage a Group of payments? Document
ID: 3
Modified:
30/04/2013
Created:
30/04/2013
Version: 1

Steps:

1. Select the “Transactions” tab.

2. Select the "View details' action in the navigation pane or doubleclick an existing group
of payments.

3. Select the “Modify transaction(s)” action in the navigation pane.

4. Add, modify or delete transactions.

5. Click the “Finish” button. As a result the modified group of payments appears in  the
Transactions area.

How can I...:

Create a Group of payments?
View the details of a group of payments?

More information:

Creating Group of payments
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How to view the details of a group of payments? Document
ID: 5
Modified:
30/04/2013
Created:
30/04/2013
Version: 1

Steps:

  How to access

Transactions tab > select the payment group > “View details” action; or
Transactions tab > doubleclick on the payment group; or

"Sent Transactions" tab > select the payment group > “View details” action; or
"Sent Transactions" tab > doubleclick on the payment group.

 Notes
o    If the currency of the transactions of a group differs from the contract currency, the
amount shall also be expressed in the contract currency. It is displayed next to the
Total between parentheses.

      Example
    450 EUR (300 GBP). There is only one Total shown.

o    If the transactions of a group are in different currencies, then the Total is only
expressed in the contract currency.

How can I...:
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Create a Group of payments?
Manage a Group of payments?

More information:

Creating Group of payments
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How to create and use a template of a Group of payments? Document
ID: 43597
Modified:
04/01/2013
Created:
03/05/2013
Version: 1

Steps:

1. Select the Transactions tab.

2. Select “New > Group of payments” in the “Navigation pane” to create a “Group of
payments”.

3. Inserts several transactions and click “Next transaction” to continue in the “Payment
Data” accordion menu. As a result the transactions are automatically grouped in the
“Created Groups (X)” accordion menu (with X = the number of groups).

4. Click on the “Created groups” bar to open the “Created Groups” accordion menu.

5. Select/check the “Save as template” option (on top of the “Created Groups” bar on
the left hand side of the “Assign to envelope” button).

6. Click the “Sign all”, “Send all”, or “Finish” button. As a result the “Confirmation”
popup window appears with the following text: “A new template ‘Template payment
group #XXX’ has been created. This template can be retrieved in the
Transactions area by setting the filter to ‘My templates’”.

7. Click the “OK” button to confirm.

8. Select the “My templates” filter.
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As a result the list of already created templates appears in the Transactions area.

9. Select one template.

10. Select “Actions > Create from template”.

 Note
You have the possibility to edit the name of a template by clicking on the name in
the Description column.

As a result the “Group of payments” wizard opens with groups that are created from
the template.
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11. Complete the “Groups of payments” wizard.

  Note
You can also save the latter “Group of payments” as a template by executing the
described steps (5) and (6).
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Creating International payment Document
ID: 682
Modified:
30/04/2013
Created:
30/04/2013
Version: 44

Purpose:

With the International payment you can easily create transactions (domestic and international) by means of a
step-by step wizard.

 Tip
If you want to make a payment to a beneficiary within the SEPA zone, it is better to make use of the SEPA
payment because your payment will be free of charges.

 How to access
Select Transactions tab > New menu > Old wizards > International payment

The wizard consists of the following steps:

Step 1: Transaction Data

In this window you can choose the payment type (normal or cheque), fill in the amount, the memo date, the
transaction currency, the beneficiary's data and choose the principal account.

Depending on the Country of the beneficiary account, the wizard will automatically switch to either a
Domestic transaction or an International transaction.

 Domestic transaction  International transaction

Step 2: Transaction Handling

In the Transaction Handling window of the
domestic payment you can choose the type of the
transaction, add an internal reference, add a
message to the beneficiary.

Step 2: Transaction Handling (1/2)

In this window you can add an internal reference, a
message to the beneficiary, a bic code, choose the
payment method and decide upon the settling of the
costs.

Step 2: Transaction Handling (2/2)

In the final step of the transaction handling, you
can specify whether the amount that you have
entered previously, is an amount in the currency of the
principal or of the beneficiary.

You can also add a message to the principal and the
intermediate bank. 

Step 3: Processing Options

In the last step you can:

decide if you want to send or sign the transaction immediately or not;
invite signers.

How can I...:

Create a domestic transaction?
Create an international transaction?

More info:

Links to detailed window descriptions:

Transaction data
Domestic Transaction handling
International Transaction handling (1/2)
International Transaction handling (2/2)
Processing options
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Transaction Data Document
ID: 688
Modified:
04/01/2012
Created:
03/05/2013
Version: 56

Purpose:

To create a transaction with the International payment, the first step is to fill in the transaction's main
information.

The window to fill in the transaction data is similar to the paper form. 

The following fields are displayed in the window Transaction Data:

Payment type: the option to indicate if the payment is a normal payment (default) or a
cheque
Memo date (dd/MM/yy): optional data. The date on which the transaction should be
executed or on which the amount should be transferred to the beneficiary account.
Either enter the date manually in the mentioned format, either select the date
via the calendar icon .

 Note
The interpretation of the memo date can vary depending on the principal account's
bank. Contact the principal account's bank to know how the bank handles
transactions with a memo date. 

Amount: the amount to be transferred, use "." or "," to add decimals. 
Transaction currency: the currency of the amount.

Principal: 

Alias: the alias assigned to the principal account
Account number: the ordering account from which the amount will be debited. The
available ordering accounts are listed in a dropdown list. A name and address are
assigned to each ordering account.
Account currency: the currency of the account. By default, the currency of the principal
account is selected. If necessary you can select another currency in the dropdown list. It
is possible that only a limited number of currencies is shown, depending on the
authorization for the selected principal account.
Name and address:  the name and address of the principal account. After the principal
account is selected, the name and the address are automatically filled in.

To:

Beneficiary: the option button to only select existing beneficiaries. You can select
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Beneficiary: the option button to only select existing beneficiaries. You can select
a beneficiary by account number, alias or beneficiary name and address.
New beneficiary: the option button to indicate that the beneficiary is not yet inserted.
You will need to fill in the account number, the beneficiary name and address and
optionally an alias. You will also have the opportunity to save this new beneficiary under
an alias name of your choice by checking the Save beneficiary option.
Own account: the option button to only select personal accounts. The personal account
numbers are listed in a dropdown list.
Country account: the country to which the account number belongs (only available if
the option New beneficiary or Own account is selected). 
Alias: short name or code for internal use in your company (only visible if the option
Beneficiary or Own account is selected). 
Account number: the number of the beneficiary account. You can select an account in
the dropdown list or enter a new account number. The system will automatically detect
whether you are entering a formatted account number. Possible hyphens are
automatically added in the account number.
Other format: the button to use another account number format, if supported by the
account country (only available if the option New beneficiary is selected).
Name and address: the personal data of the beneficiary. The name and address are
automatically filled in when the beneficiary is selected. When you enter a new
beneficiary you will need to fill in the information manually.
Save beneficiary: the check box to save the beneficiary or not (only available if the
option New beneficiary is selected). 
Cancel: the button to cancel the transaction
Next: the button to proceed with the Payment wizard

More info:

Links to detailed window descriptions:

Domestic Transaction handling
International Transaction handling (1/2)
International Transaction handling (2/2)
Processing options
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International Transaction Handling (1/2) Document
ID: 685
Modified:
30/04/2013
Created:
30/04/2013
Version: 47

Purpose:

When you create a transaction to an account of another country, some extra information is needed in order to
handle the transaction correctly. Within the wizard, you need to add this extra information in
the Transaction Handling (1/2) window and Transaction Handling (2/2) window.

The Transaction Handling (1/2) window consists of the following items:

User reference: a reference which may be useful for your internal accountancy
Message to beneficiary: the communication to the beneficiary, as it will appear in your
account statements
Payment method: the type of transaction, listed in a dropdown list. If Z-Bilateral
agreement with your bank is selected, you have to fill in the field next to Payment
method with the 2 alphabetical characters, as agreed with your bank. 
BIC: the Bank Identifier Code. If the code is not filled in or not correct, click the Search
button to look it up.
Bank name: the full name of the bank, automatically filled in when a BIC is selected.
Location: free text field to indicate the location of the bank if no BIC is used, or
automatically filled in when a BIC is selected.
Costs

Shared charges: the option button to indicate that the charges are shared between
the principal and the beneficiary. If you have selected the option button, you can
select the Cost account and the Currency in the drop-down lists.
All charges to principal: the option button to indicate that the charges are for the
principal. If you have selected the option button, you can select the Cost account
and the Currency in the drop-down lists.
All charges to beneficiary: the option button to indicate that the charges are for the
beneficiary.

 Note

In the context of the Payment Service Directive (PSD) issued by the European
Commission, there are additional automatic controls added to the application for
the costs of an international transaction.
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The following 3 conditions are checked:

Is the payment executed in 1 of the following currencies: EUR, BGN, CZK,
DKK, EEK, HUF, LVL, PLN, RON, SEK, GBP, NOK, ISK, CHF or LTL?
Are the ordering party and beneficiary countries part of the European
Economic Area (EEA)?
Is the currency of the ordering party the same as the currency of the
transaction/beneficiary?

The possible results are: 

The 3 conditions are met: the only option available is Shared charges.
Only condition 1 and 2 are met: only the options Shared charges (default)
and All charges to principal are available.
All other cases: all options are available with Shared charges as default.

Cost account: the account to be debited with the charges, listed in a dropdown list.
Currency: the currency in which of the charges will be debited, listed in a dropdown list.
Back: the button to return to Transaction Data.
Next: the button to proceed to International Transaction Handling (2/2).
Cancel: the button to discard the transaction.

More info:

Links to detailed window descriptions:

Transaction data
International Transaction handling (1/2)
International Transaction handling (2/2)
Processing options

Countries of the European Economic Area (EEA)
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Transaction Handling (2/2) Document
ID: 691
Modified:
30/04/2013
Created:
30/04/2013
Version: 47

Purpose:

In this window you can add an extra message to the bank and to an intermediate bank.

The Transaction Handling (2/2) window contains the following items:

In the first section, the transaction data is displayed and there is an indication whether
extra costs or not are incurred with the transaction.

Extra costs  Extra costs will be incurred with this payment

No extra costs  Low cost payment

Message to ordering party bank: the message you want to send to the principal bank.
Intermediary bank BIC code: the BIC of the intermediary bank. If the code is not filled
in or not correct, click the Search button to look it up .
Intermediary bank: the name of the intermediary bank, automatically selected when the
BIC of the intermediary bank is selected
Intermediary bank location: the location of the intermediary bank

Message to beneficiary bank: the message you want to send to the beneficiary's
bank

Free message: selection to use a free communication to the beneficiary bank.
SWIFT code: selection to use a SWIFT code for the beneficiary bank.

Back: return to the Transaction Handling (1/2) window
Next: proceed to the Processing Options
Cancel: discard the transaction

How can I...:

 

More info:
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Links to detailed description:

Transaction data
International Transaction handling (1/2)
International Transaction handling (2/2)
Processing options

The navigation pane:

Managing
Counterparties

Preferences
View exchange rates
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Processing Options Document
ID: 683
Modified:
30/04/2013
Created:
30/04/2013
Version: 54

Purpose:

Before finishing a transaction you can:

Alter the name of your transaction;
Indicate if you want to send or sign the transaction immediately;
Indicate if the transaction is a test processing 
Define the signers of the transaction.

The Processing Options window consists of the following sections:

Name: this field contains an automatically generated name for the transaction which can
be changed.

Processing Options:

Sign immediately: the option to sign the transaction immediately after clicking
the OK button.
Send when sufficiently signed: the option to send the transaction automatically
when the transaction is sufficiently signed 
Shared: the option to share the payment with other users.
Test processing: option only available for certain banks.

 Note
If you want to use the option Send when sufficiently signed, you will need to
activate the module MultiSign.

Invite signers:

Potential signers: the list of all possible signers.
Selected signers: the list of the signers who have to sign.

Select a user in the field Potential signers and click the > button to invite the user
to sign the transaction.
Select a user in the field Signer(s) to invite and click the < button to remove the
user.
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 Note
If you want to use the option Invite signers, you will need to activate the
module MultiSign.

Next Transaction: insert a new transaction.
Finish: finish the transaction. The users in the list of Selected signers will receive an e-
mail with an invitation or a notification to sign the current transaction.
Cancel: finish the transaction without transaction option.

More info:

The navigation pane:

Managing
Counterparties
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How to create an international transaction? Document
ID: 880
Modified:
07/01/2013
Created:
03/05/2013
Version: 35

Steps:

To create an international transaction:

1. Select the Transaction tab.

2. In the Navigation pane, under New, click Old wizards > International payment.
The Transaction Data window appears.

3. Fill in the Transaction data.

 

4. Click the Next button.

5. Add extra data, such as an internal reference and bank information, to the transaction
for further Transaction handling.

 

6. Click the Next button.

7. Complete the data for the Transaction handling.
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8. Click the Next button.

9. Define the Processing options.

 

10. Click the Next transaction button to create another transaction or click the Finish
button to finish the international transaction.

More information:

Links to detailed window descriptions:

Transaction data
Transaction handling (1/2)
Transaction handling (2/2)
Processing options

The navigation pane:

Managing
Counterparties
Preferences
View exchange rates
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Transaction Data Document
ID: 688
Modified:
04/01/2012
Created:
03/05/2013
Version: 56

Purpose:

To create a transaction with the International payment, the first step is to fill in the transaction's main
information.

The window to fill in the transaction data is similar to the paper form. 

The following fields are displayed in the window Transaction Data:

Payment type: the option to indicate if the payment is a normal payment (default) or a
cheque
Memo date (dd/MM/yy): optional data. The date on which the transaction should be
executed or on which the amount should be transferred to the beneficiary account.
Either enter the date manually in the mentioned format, either select the date
via the calendar icon .

 Note
The interpretation of the memo date can vary depending on the principal account's
bank. Contact the principal account's bank to know how the bank handles
transactions with a memo date. 

Amount: the amount to be transferred, use "." or "," to add decimals. 
Transaction currency: the currency of the amount.

Principal: 

Alias: the alias assigned to the principal account
Account number: the ordering account from which the amount will be debited. The
available ordering accounts are listed in a dropdown list. A name and address are
assigned to each ordering account.
Account currency: the currency of the account. By default, the currency of the principal
account is selected. If necessary you can select another currency in the dropdown list. It
is possible that only a limited number of currencies is shown, depending on the
authorization for the selected principal account.
Name and address:  the name and address of the principal account. After the principal
account is selected, the name and the address are automatically filled in.

To:

Beneficiary: the option button to only select existing beneficiaries. You can select
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Beneficiary: the option button to only select existing beneficiaries. You can select
a beneficiary by account number, alias or beneficiary name and address.
New beneficiary: the option button to indicate that the beneficiary is not yet inserted.
You will need to fill in the account number, the beneficiary name and address and
optionally an alias. You will also have the opportunity to save this new beneficiary under
an alias name of your choice by checking the Save beneficiary option.
Own account: the option button to only select personal accounts. The personal account
numbers are listed in a dropdown list.
Country account: the country to which the account number belongs (only available if
the option New beneficiary or Own account is selected). 
Alias: short name or code for internal use in your company (only visible if the option
Beneficiary or Own account is selected). 
Account number: the number of the beneficiary account. You can select an account in
the dropdown list or enter a new account number. The system will automatically detect
whether you are entering a formatted account number. Possible hyphens are
automatically added in the account number.
Other format: the button to use another account number format, if supported by the
account country (only available if the option New beneficiary is selected).
Name and address: the personal data of the beneficiary. The name and address are
automatically filled in when the beneficiary is selected. When you enter a new
beneficiary you will need to fill in the information manually.
Save beneficiary: the check box to save the beneficiary or not (only available if the
option New beneficiary is selected). 
Cancel: the button to cancel the transaction
Next: the button to proceed with the Payment wizard

More info:

Links to detailed window descriptions:

Domestic Transaction handling
International Transaction handling (1/2)
International Transaction handling (2/2)
Processing options
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Domestic Transaction Handling Document
ID: 686
Modified:
30/04/2013
Created:
30/04/2013
Version: 41

Purpose:

When creating a transaction between a Belgian ordering party account and a Belgian beneficiary with
the International payment, you are creating a domestic transaction.

The Transaction Handling window consists of the following items:

Message to beneficiary:

Free message: selection to use an unstructured communication to the beneficiary?
Structured message: selection to use a structured message?

User reference: internal reference that can be useful for your accountancy.
Transaction type: reason for payment listed in a drop-down list. .
Urgent: select this option for an urgent payment.

 Tip 
Contact your bank to know whether they support this option or if they charge extra
costs for an urgent payment.

Back: return to the Transaction Data
Next: proceed to the Processing Options
Cancel: discard the transaction.

More info:

Links to detailed window descriptions:

Transaction data
Domestic Transaction Handling
Processing options

The navigation pane :

Managing
Counterparties
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Processing Options Document
ID: 683
Modified:
30/04/2013
Created:
30/04/2013
Version: 54

Purpose:

Before finishing a transaction you can:

Alter the name of your transaction;
Indicate if you want to send or sign the transaction immediately;
Indicate if the transaction is a test processing 
Define the signers of the transaction.

The Processing Options window consists of the following sections:

Name: this field contains an automatically generated name for the transaction which can
be changed.

Processing Options:

Sign immediately: the option to sign the transaction immediately after clicking
the OK button.
Send when sufficiently signed: the option to send the transaction automatically
when the transaction is sufficiently signed 
Shared: the option to share the payment with other users.
Test processing: option only available for certain banks.

 Note
If you want to use the option Send when sufficiently signed, you will need to
activate the module MultiSign.

Invite signers:

Potential signers: the list of all possible signers.
Selected signers: the list of the signers who have to sign.

Select a user in the field Potential signers and click the > button to invite the user
to sign the transaction.
Select a user in the field Signer(s) to invite and click the < button to remove the
user.
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 Note
If you want to use the option Invite signers, you will need to activate the
module MultiSign.

Next Transaction: insert a new transaction.
Finish: finish the transaction. The users in the list of Selected signers will receive an e-
mail with an invitation or a notification to sign the current transaction.
Cancel: finish the transaction without transaction option.

More info:

The navigation pane:

Managing
Counterparties
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Creating Domestic payment overview Document
ID: 699
Modified:
30/04/2013
Created:
30/04/2013
Version: 63

Purpose:

The method to create a domestic payment resembles filling in a paper transaction form.

 Note  
When you want to be guided through the transaction process step by step, use the International payment.
You cannot create an International payment with the Domestic payment. You need to use the
International payment.

 How to access
Transaction tab > New menu > Old wizards > Domestic payment

The Enter transaction window consists of the following items:

Payment type: the option to indicate if the payment is a normal payment (default) or a
cheque
Memo Date: the date on which the transaction should be executed or on which the
amount should be transferred to the beneficiary account . Either enter the date manually,
either select the date via the calendar  icon.

 Note
The interpretation of the memo date can vary depending on the principal account's
bank. Contact the principal account's bank to know how the bank handles
transactions with a memo date.

Amount: the amount to be transferred, use "." or "," to add decimals 
Euro is the only currency available here.

Principal:
 

Alias: alias assigned to the principal account
Account number: ordering account from which the amount will be debited. The
available ordering accounts are listed in a dropdown list. A name and address are
assigned to each ordering account.
Name and address:  name and address of the principal account. After the principal
account is selected, the name and the address are automatically filled in.
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To: 
 

Beneficiary: option to select an existing beneficiary. You can select a beneficiary by
account number, alias or beneficiary name.
New beneficiary: option button to create a payment to a new beneficiary. You will
need to fill in the account number, the beneficiary name, address and optionally
an alias. 
Own account: option to select a personal account. The personal account numbers
are listed in a dropdown list.
Alias: short name or code for internal use in your company
Account number: number of the beneficiary account. You can select an account in
the drop-down list or enter a new account number. The system will automatically
detect whether you are entering a formatted account number. Possible dashes are
automatically added in the account number.
Circular cheque: selection to make a circular cheque of the payment. This button is
only active if the Payment type is set to Cheque.
Name and address: personal data of the beneficiary
The name and address are automatically filled in when an existing beneficiary is
selected. When you enter a new beneficiary you need to fill in the information
manually.
Save beneficiary: selection to save the beneficiary or not (only available if the option
New beneficiary is selected).

Message to beneficiary:
 

Free message: selection to use an unstructured communication to the beneficiary.
Structured message: selection to use a structured message.

User reference: internal reference that can be useful for your accountancy. This field is
limited to 8 characters.
Transaction type: type of the payment listed in a dropdown list.  
Urgent: selection to make the payment urgent.

 Tip
Contact your bank to know whether they support this option or if they charge extra
costs for an urgent payment.

Set advanced processing options: selection to indicate that you want to complete the
set of advanced processing options. If you select this option and you click the Finish
button, the window Processing options appears.
Next Transaction: allows you to create another transaction with the same principal
account.

 Note
When Set advanced processing options is selected, the button Next
Transaction will only be available in the Processing options window.

Finish: complete the transaction(s).
Cancel: discard the transaction.

How can I...:

Create a Domestic payment?
Create a Group of Domestic payments?

More info:

Which wizard for which payment?
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Links to detailed window descriptions:

Processing options
Circular cheque
Payment wizard
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How to create a domestic payment? Document
ID: 897
Modified:
27/02/2013
Created:
03/05/2013
Version: 46

Prerequisite:

A domestic payment is only possible in Euro and between 2 Belgian account numbers
in structured format (XXX-XXXXXXX-XX).

Steps:

To create a domestic payment:

1. Select the Transactions tab.

2. In the Navigation pane, under New, click Old wizards > Domestic payment. The
Enter transaction window appears.

 

3. Fill in the transaction data for the domestic transaction.

4. Click the Next Transaction button to enter a new domestic payment, or
Click the Finish button to end the transaction and to return to the main transactions
window.

 Note
If you have selected the check box Set advanced processing options in the
transaction data, the window to define the processing options will appear after you
continue.

 Note
If you know only the Belgian IBAN of the counterparty, use the option Payment.

More information:

Creating domestic payment
Creating International payment 
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How to create a group of domestic payments? Document
ID: 1886
Modified:
30/04/2013
Created:
30/04/2013
Version: 29

Steps:

The creation of a group transaction is similar to the creation of a Domestic payment.

To create a group transaction:

1. Select the Transactions tab. The list of inserted transactions appears.

2. In the Navigation pane under New, click Old wizards > Group of domestic
payments. The New group window appears.

3. Encoding group parameters, such as group name, transaction type, memo date, ...

 Note
Some group parameters cannot be changed once the group of domestic payments
is saved  in case you intend to clone a Group of domestic transactions.

 

4. Click the Next button. The window to fill in the first transaction appears.

5. Fill in: Encoding one or more payments.
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6. Click the Next Transaction button to add another transaction to the group; or click the
Finish group button to proceed with the Processing Options.

7. Define the Processing options.

 

8. Click the OK button to finish the Group transaction.

 Note
This funtionality will be available in the the Domestic Payment wizard in a future release.

How can I...:

Group encoded transactions?
Clone or duplicate transactions?

More information:

Links to detailed window descriptions:

Encoding group parameters
Transaction Data
Processing Options
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Creating Direct Debit overview Document
ID: 32619
Modified:
17/04/2013
Created:
17/04/2013
Version: 5

Purpose:

Direct debit is an optional module in Isabel 6 eBanking. If you settle your invoices using direct debits, then you
can create direct debit orders for your debtors using the Direct Debit module and send them to the bank for
execution. The procedure is virtually identical to the procedure for transfers.

You have the option of creating an order for each debtor separately or for a group of debtors. You can also
import direct debit order files, which you have created in txt format in an external application.

To manually create a direct debit order, there are 3 steps:

General criteria of the direct debit order such as creditor number and account, group
name, etc...
The data of the direct debit order
Processing options (optional)

More info:

Which wizard for which payment?
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Direct Debit parameters Document
ID: 5434
Modified:
30/04/2013
Created:
30/04/2013
Version: 25

Purpose:

 

 How to access
Select Transactions tab > New menu > Direct Debit

The window with the criteria of the direct debit order consists of the following items:

Group name: the name for a group of direct debit orders
Pivot date (dd/MM/yy): the date on which the creditor's account must be credited with
the amount of the direct debit
Template for automatic debtor encoding: enables you to use a template that
contains one or more debtors with predefined values.

 How to create “Debtor group templates”
Select Transactions tab > Managing menu > Counterparties > Managing menu >
Debtor group templates > New menu > Template > Type Name and click Add >
Click template > Add direct debits with predefined values (Amount, Refund,
Message to debtor, Structured reference)

Creditor number: the credit number, allocated by the bank, which identifies you as a
beneficiary of the direct debit order agreement that the debtor has entered into with the
bank. One or more accounts may be related to this credit number.
Account: the account number, related to the creditor number
Name and address: the name and address of the creditor
File reference: a reference which may be useful for your internal accountancy
Next: continue the creation of the direct debit order.
Cancel: cancel the creation of the direct debit order.

How can I...:

Create a direct debit order?
Create a creditor?
Upload a bank file?
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More info:

The navigation window

Managing
Counterparties
Creditors
Preferences
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Direct Debit data Document
ID: 5436
Modified:
30/04/2013
Created:
30/04/2013
Version: 21

The window to fill in the data of the direct debit order contains the following items:

The criteria which you have entered in the first step remain visible.
Amount: the amount, which the debtor is indebted to you 
Refund: check box to indicate if it is a refund (selected) or not (cleared)
Debtor: the option to select an existing debtor 
New debtor: the selection to fill in a new debtor in the direct debit order 
Alias: the dropdown list to select an existing debtor by means of an alias 
Direct debit number: the dropdown list to select the direct debit number 
Debtor name and address: the name and address of the debtor
 
Message to debtor: the communication to the beneficiary, as it will appear in your
account statements
Structured reference: a structured message to the beneficiary 
File reference: a reference which may be useful for your internal accountancy
Other transaction: to create a new direct debit order 
Finish: to finish the orders and to proceed with the processing options 
Cancel: to cancel the direct debit orders, all previous orders of this session are
cancelled too

How can I...:

Create a direct debit order?
Create a creditor?

More info:

The navigation pane

Managing
Counterparties
Creditors
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Preferences
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How to create a Direct Debit? Document
ID: 5435
Modified:
30/04/2013
Created:
30/04/2013
Version: 17

Prerequisite:

In order to create a Direct Debit, you need to subscribe to the module Direct Debit.

Steps:

To create a direct debit order:

1. Select the Transactions tab.

2. In the Navigation pane, under New, click Direct Debit. The window to enter the
criteria of the direct debit order appears. 

3. Fill in the data: Encoding group direct debit parameters.

  

4. Click the Next button and the window to fill in the data of the direct debit order appears.

5. Fill in the data: Encoding one or more direct debits.

 

6. Click the Other transaction button to create a new direct debit order; or click the
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Finish group button to proceed with the processing options. 

7. Define the Processing options.

 

8. Click the OK button to finish the direct debit order.

More information:

Links to detailed window descriptions:

Direct Debit criteria
Data of the Direct Debit Order
Processing options

The navigation pane

Managing
Counterparties
Creditors
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Creating SEPA Direct Debits and mandates overview Document
ID: 43590
Modified:
30/04/2013
Created:
30/04/2013
Version: 1

Purpose:

Within the context of the SEPA (Single Euro Payment Area) the existing national debit systems in the SEPA
countries will be replaced by a single European system.

This European system is known as Sepa Direct Debit (abbreviated SDD). In Belgium, this is referred to as the
"European direct debit" or "Sepa direct debit" (in Dutch "domiciliëring", in French "domiciliation").

From 1 February 2014, only the European system will be accepted.

More information on the European direct debit is available on http://www.sepabelgium.be/ or from your bank.

The purpose of the SDD module in the eBanking application is to offer you the ability to manage your SDD
transactions easily. The eBanking application features both an input wizard and mandate management, both
only accessible to users that are subscribed to the so called “direct debit” module.

Definitions:

DOM80: The system specific to Belgium that was designed by the Belgian banks in
1980 for settling direct debit transactions. DOM80 still supports the BBAN (Belgian
Bank Account Number) representation. As from 1 February 2014, DOM80 will no
longer be supported.

SEPA Direct Debit (SDD): the European direct debit system, which replaces DOM80
(and for instance DOM2000). With European direct debit, you have a unique, secure
and rapid system for paying your bills in euros in any SEPA country.

Creditor: A person to whom money is owed by a debtor; someone to whom an
obligation exists - in the context of the eBanking application, this means you.

Debtor: A person who owes a creditor; someone who has the obligation to pay a
debt.

DMF: Debtor-driven Mandate Flow in which the debtor bank is responsible for
mandates.

CMF: Creditor-driven Mandate Flow in which the creditor bank is responsible for
mandates.

CI: Creditor Identifier.

MRI: 'Mandate-Related Info' or information that is related to the mandate.

Descriptions:

Features in SDD:

Unlike DOM80; SDD features one-off direct debits, with a mandate that can only
be used for one single collection.
With SDD, the creditor is responsible for the management of the mandates.

SDD features two schemes (the difference is related to legal protection and
contractual obligations):

The Core (= B2C = Business to Customer) scheme; and
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B2B (Business to Business) scheme.

SDD features a shift from a DMF to a CMF.
Core vs. B2B Direct Debit scheme:

Core DD scheme  B2B DD scheme

Creditor is responsible for mandate acquisition = Creditor is responsible for mandate
acquisition

No validation of mandate by Banks
≠

Debtor Bank validates the mandate

Creditor sends Direct Debit request to his/her
bank with mandate reference

= Creditor sends Direct Debit request to his/her
bank with mandate reference

Debtor Bank executes Direct Debit
≠

Debtor Bank verifies the mandate & executes
Direct Debit

Debtor has 8 weeks to request refund (more
possible)

≠ Debtor has no possibility of requesting refund

Collection date = D+5 (first, one-off) or D+2
(next, final)

≠ Collection date = D+1

 

Mandate flow:

The creditor sends the European mandate form to your debtor. The debtor sends the
signed form back directly.

The creditor archives the received (paper) mandates and enters the mandate
information into the eBanking application. Thereafter, the creditor can proceed to set
up a collection in the eBanking application.

SDD flow:
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In the event of a collection, the transaction information available is sent to the bank.

The MRI must also be sent to the bank:

A mandate reference that must be unique to the creditor identifier concerned
A notion of "sequence of the collection". When making the first collection on a
new mandate (and in the case of some subsequent amendments) it must be
submitted as sequence value "First". After a successful collection, the sequence
value in the mandate management must be changed to "Next".
The date of signature of the mandate
The scheme: "Core" or "B2B"

Mandate type:

Recurring: collections may occur repeatedly.
One-time: only one collection may be made. This is a new type that does not
exist in the DOM80 system.

The role of the banks:

Implementing role:

The creditor's bank ensures that the collections are sent to the debtor's bank.
The debtor's bank debits the debtor's account and remits the amount to the
creditor's bank.
The creditor's bank credits the creditor's account.

Registering role:

Registration of the scheme, sequence and type of collection.
Storage of the history of the collections by the debtor's bank (e.g. for the right
to refund)..
Storing the DOM80 information for migrated mandates
The confirmation of the B2B mandates.

Controls:

Is there sufficient provision on the debtor's account?
Is the sequence of collections respected?
Has the debtor blocked collections for this creditor?
Control of B2B mandates (no right to refund to the debtor).
If the claim cannot be debited from the debtor's account, the bank will report
this as "REJECT" to the creditor's bank.

Using Isabel 6 - v6.26 - 43590 - Creating SEPA Direct Debits and mandates overview 15/05/2013

152 / 283



How can I...:

Create mandates?
Assign mandates to groups? (optional)
Create a file (a collection)?
View the details of a collection in the (Sent) Transaction area?
Modify mandates (amendments)?

More info:

Isabel 6 SEPA Direct Debits in detail (pdf - 22 pages)
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How to create mandates? Document
ID: 43591
Modified:
02/05/2013
Created:
02/05/2013
Version: 1

Prerequisite:

You have the possibility to create mandates for new or migrated direct debit users in the Mandate area.

New mandate:

You can insert the new mandates for SDD. The relevant information is on the mandate
forms that you have sent to new debtors. These debtors have sent these forms back
signed, with their IBAN and BIC filled in.

New migrated mandate:

Your existing direct debit numbers in the current DOM80 Belgian system are issued by
your debtor's bank. This bank is required to save the original mandates on paper. This
means you do not have to get a new European mandate signed for the existing direct
debit numbers.

This module is designed to convert the DOM80 mandates into European mandates. The
original direct debit numbers and creditor number(s) linked to the migrated European
mandate. The reference to the managing bank of the original DOM80 mandate is thus
ensured. If necessary, you can always contact the bank in question to confirm the validity
of a migrated mandate.

Afterwards you can use these mandates in the SDD wizard.

Steps:

1. Select the Transactions tab.

2. Select “Managing > Mandates” in the “Navigation pane”.

As a result the “Manage Mandates” area is displayed.
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3. Insert a new mandate or a migrated mandate:

Select “New > Mandate” in the “Navigation pane”: as a result the “New
Mandate” area is displayed.

1. Insert the mandate information. The new mandate contains the following fields
to enter:

Mandate reference: mandatory field, an easy to retrieve reference
created by you;
Payment scheme:

Core; or
B2B;

Type of payment:

 Notes
In the Core scheme, you must send your collections at least 5 days
(in case of First, One-off) or 2 days (for Next or Final) before your
requested collection date.
For the B2B scheme, you must send your collections at least 1 day
before the requested collection date.

Recurrent: use multiple times, contains the Sequence value First,
Next or Final, impacts submission time to the bank, value has to be
entered correctly, else the file will be rejected by the bank.

 Notes
You must insert the correct values, otherwise the file will be
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rejected by the bank. Careful management is essential.
When making a first collection with a migrated mandate, you must
send the sequence value "First" to the bank (standard value).
The sequence value must be changed after the first successful
collection to ”Following”:

You can change the sequence value separately for each
mandate. For information on this, see "How to modify
mandates (amendments)?"; or
You can change the sequence value for a group of mandates.
For information on this, see "How to assign mandates to
groups?" under the description of how to filter mandates with
the sequence value "First".

One-off: use only one time;

Signature date: mandatory field;
Signature place;
Contract Identifier;
Contract description: free text allowing to put the description of the
signed contract;

Debtor: click the “Display reference party” link to display “all” the debtor
fields (or click “Hide reference party” to hide optional debtor fields).

Debtor identification code;
Debtor reference party name;
Debtor reference party identification code;
Account number (IBAN): mandatory field;
BIC: mandatory field;
Name and address:

Name: mandatory;
Street & number;
Zip code, city;
Country;

Creditor: click the “Display reference party” link to display “all” the

Using Isabel 6 - v6.26 - 43591 - How to create mandates? 15/05/2013

156 / 283

https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=43603
https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=43593#change_sequence


creditor fields (or click “Hide reference party” to hide optional creditor
fields).

Creditor Identifier: mandatory field, can be inserted manually or can
be selected from the list with previously entered CIs;

 Example
BE97ZZZ123456789

 Notes (for BE)

In the SEPA environment, the Creditor Bank issues the CI.
Structure (controlled by the eBanking application):

Country code; and
Control number; and
Company number; and
National identification (not controlled by the eBanking
application)

Creditor reference party name;
Creditor reference party identification code;
Name and address: name is mandatory;

Default amount: amount in euro;
Default message to debtor: default 2 lines, can be collapsed/expanded
with more/less;

 Example of a Belgian structured message
123456789002; or
+++123/4567/89002+++

Note: free text field to add remarks for e.g. the location of the mandate in
paper format;

2. Follow the steps starting with step 6 "Select ..." in the description "How to
modify mandates (amendments)?"

3. Click one of the following buttons to continue:
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Next;
Save;
Cancel;

Or select “New > Migrated mandate” in the “Navigation pane”: as a result the
“New Migrated Mandate” area is displayed.

1. Insert manually the information that can be retrieved from the paper mandate
(information related to the former DOM80 mandate). The new migrated
mandate contains the following fields to enter:

Mandate reference: mandatory field, a reference created by you;
Payment scheme:
Core: default value;
B2B: disabled;
Note: free text field to add remarks for e.g. the location of the mandate in
paper format;
Type of payment:

Recurrent: use multiple times, default value, contains the default
Sequence value First;
One-off: disabled;

Signature date: mandatory field;
Signature place;
Contract Identifier;
Contract description: free text allowing you to enter the description of the
signed contract;

Debtor: click the “Display reference party” link to display “all” the debtor
fields (or click “Hide reference party” to hide optional debtor fields).

Former direct debit number: mandatory field, can be inserted
manually or can be selected from the list with previously entered
debtors (via Transactions > Managing > Counterparties), ceases to
exist in the SDD context but is used here as a reference to the former
DD;
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Debtor identification code;
Debtor reference party name;
Debtor reference party identification code;
Name and address:

Name: mandatory;
Street & number;
Zip code, city;
Country;

Account number (IBAN): mandatory field;
BIC: mandatory field;

Creditor: click the “Display reference party” link to display “all” the
creditor fields (or click “Hide reference party” to hide optional creditor
fields).

Former creditor number: mandatory field, can be inserted manually
or can be selected from the list with previously entered values (via
Transactions > Managing > Creditors);

 Example
04-568-108-10

Creditor Identifier: mandatory field, can be inserted manually or can
be selected from the list with previously entered Cs (Creditor
Identifiers);
Creditor reference party name;
Creditor reference party identification code;
Name and address: name is mandatory;

Default amount: amount in euro;
Default message to debtor: default 2 lines, can be collapsed/expanded
with more/less;

2. Follow the steps starting with step 6 "Select ..." in the description "How to
modify mandates (amendments)?"

3. Click one of the following buttons:
Next;
Save;
Cancel;

Note
The upload of a mandate migration file from your bank(s) is not yet available.

How can I...:

Assign mandates to groups? (optional)
Create a file (a collection)?
View the details of a collection in the (Sent) Transaction area?
Modify mandates (amendments)?

More information:

Creating SEPA Direct Debits and mandates
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Isabel 6 SEPA Direct Debits in detail (pdf - 22 pages)
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How to assign mandates to groups? (optional) Document
ID: 43593
Modified:
02/05/2013
Created:
02/05/2013
Version: 1

Prerequisite:

By assigning mandates to groups, you have a handy means of preparing and simplifying your collections.

Steps:

1. Select the Transactions tab.

2. Select “Managing > Mandates” in the “Navigation pane”. As a result the “Manage
Mandates” area is displayed.

3. Select one or more already created mandates on the Mandates tab.

4. Click on the “Group of mandates” button. As a result the “Group of mandates” pop-
up window appears beneath the button.

5. Assign the selected mandates:

To a new group:

Type the name of the new group in the entry field of the “Create a new group”
section & click the “Create group” button.
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As a result then new group appears selected in the “Assign selected” section.

To a new group or to an existing group:

1. Click the “Assign to selected group(s)” button to assign the selected
mandates to the selected mandate groups.

As a result the pop-up disappears and an icon appears next to grouped
mandates in the Group column of the “Manage Mandates” area which is
also a short-cut to display that specific mandate group. The icon in the final
version in production will differ from the icon in the screenshot below.

 Notes

You can assign a mandate to more than one group.
You can use the Search field & button to find mandates. This will search
on Mandate reference, Debtor Name and Debtor Account number.
You can use the “Group filter” combo box to select the mandate group
that has to be used as a filter for the displayed mandates.
You can click the   of the Scheme column to select the Core or B2B
filter.
You can click the  of the Sequence column to select the sequence
value First, Next, Final or One-off filter.
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The possibility of filtering mandates with the sequence value "First" and
then making your selection allows you (after a first collection) to change
the sequence easily to "Next" (via Actions > Change sequence to
Next).

2. Click the Groups tab page in of the “Manage Mandates” area to display the
mandate groups and mandates.

 Note
You have the ability to select and “Remove mandate(s) from the group”
with a dedicated button.

Example
A school uses SDD for the collections of school accounts and other costs:

At the school secretariat, the mandates are assigned to a fixed mandate group per
class. Once every quarter, the secretariat collects the school accounts for each class
(=for each fixed mandate group).
In the course of the school year, however, there are activities for which the students
can register individually and for which the payments are not collected via the
quarterly school account. For this purpose, the secretariat will assign the mandate for
each participating student to an additional "temporary" mandate group. The
secretariat can then very simply collect the entire temporary mandate group in a
single transaction.

How can I...:

Create mandates?
Create a file (a collection)?
View the details of a collection in the (Sent) Transaction area?
Modify mandates (amendments)?

More information:

Creating SEPA Direct Debits and mandates
Isabel 6 SEPA Direct Debits in detail (pdf - 22 pages)
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How to create a file (a collection)? Document
ID: 43595
Modified:
02/05/2013
Created:
02/05/2013
Version: 1

Prerequisite:

You can collect both by group of mandates and mandate by mandate.

If you have created at least one group of mandates, the wizard automatically activates the "Group of
mandates" option.

Steps:

1. Select the Transactions tab.

2. Select “New > SEPA direct debits” in the “Navigation pane”. As a result the “SEPA
direct debits” area is displayed with the "Direct Debit Data” accordion menu
opened.

3. Select the “Originator Alias”.

 Important note
Accounts of banks that are not supporting the pain.008.001.02 file format are not
available in this combo box.

4. Select:

The “Group of mandates” option:
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 Notes
You don’t need to know about grouping rules; collections are automatically
assigned to groups according to the rules.
The "Group of mandates" option is only available if you have created
mandates and group(s) of mandates previously.

1. Select a group of mandates that is defined in the Mandate area. 

 Note
You have the ability to:

“Modify attributes” with a dedicated button. If you click this button,the “Edit
group attributes” pop-up window is displayed.

(Un)select mandates. Mandates are already selected by default, with the
exception of the mandates with the sequence value "First', for which you
have already made a collection in the past.(you had to change the
sequence value for this to "Next"). You can still select these mandates
manually.
Modify the Amount and “Message to debtor” of each mandate. This will
always save the original amounts in the mandate!

2. Choose the type of Amount to apply:

Group: insert the percentage that is applied to the amount each individual
mandate in the group; or
Fixed: insert the same amount that is applied to every collection of the
selected mandates, individual amounts of mandates are overruled.
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3. Insert a mandatory “Requested collection date” (by using the calendar tool).
The date depends on the payment type (sequence) and the payment scheme
which is defined in the mandate (for more information see "How to create
mandates?").

 Notes
In the Core scheme, you must send your collections at least 5 days (in case
of First, One-off) or 2 days (for Next or Final) before your requested
collection date.
For the B2B scheme, you must send your collections at least 1 day before
the requested collection date.

4. Select:

For "Message to debtor” the "Group" option: the “Message to debtor” that
is defined in every mandate (where applicable) is used instead of a global
message; or
For “Message to debtor” the "Fixed" option: the “Message to debtor” that
is defined in each mandate is replaced by a global "Fixed" “Message to
debtor” that you have to insert here.

5. Insert a “Customer reference (End to End identifier)” or use the generated
reference.

The “Single mandate” option:

1. Type/select a single mandate reference that is defined in the Mandate area with
the “Mandate reference” combo box.

2. Insert the Amount that is applied to the collection using the single mandate; the
amount of the mandate is overruled in such a case.

 Note
In the case of a "Single mandate" the original values of the "replaced" values
are always saved in the mandate.

3. Insert a mandatory “Requested collection date” (by using the calendar tool).
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The date depends on the payment type (sequence) and the payment
scheme which is defined in the mandate (for more information see "How to create
mandates?").

 Notes
In the Core scheme, you must send your collections at least 5 days (in case
of First, One-off) or 2 days (for Next or Final) before your requested
collection date.
For the B2B scheme, you must send your collections at least 1 day before
the requested collection date.

4. Insert a “Message to debtor” for the collection that is using the mandate. As a
result the “Message to debtor” defined in the mandate is overruled by this
message.

5. Insert a “Customer reference (End to End identifier)” or use the generated
reference.

6. Click one of the following buttons to continue:

Next transaction: you can insert the next transaction and/or open the
“Created Groups” accordion menu to:

View the groups;

Modify group attributes of a group with the  button of a group;

Set advanced processing options of a group with the  button of a group;
View transactions in a group by clicking the  button to open a group;

Adapt a transaction in a group with the  button of a group;

Remove a transaction from a group with the  button of a group;
Add transaction to a group with the “Add transaction” button (opens the
“Direct Debit Data” accordion menu);
Enable/disable the “Global debit” option of a group;

Sign all;
Send all;
Finish;
Cancel;

How can I...:
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Create mandates?
Assign mandates to groups? (optional)
View the details of a collection in the (Sent) Transaction area?
Modify mandates (amendments)?

More information:

Creating SEPA Direct Debits and mandates
Isabel 6 SEPA Direct Debits in detail (pdf - 22 pages)
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How to view the details of a collection in the (Sent) Transaction
area?

Document
ID: 43599
Modified:
02/05/2013
Created:
02/05/2013
Version: 1

Steps:

1. Select the "(Sent) Transactions" tab.

2. Select a “Collection group” in the "(Sent) Transactions" area.

3. Select “Actions > View details” in the “Navigation pane”. As a result the “View
transaction details” area is displayed.

4. Click:

The Sign button (displayed if applicable); or
The Send button (displayed if applicable); or
The Close button;

How can I...:

Create mandates?
Assign mandates to groups? (optional)
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Create a file (a collection)?
Modify mandates (amendments)?

More information:

Creating SEPA Direct Debits and mandates
Isabel 6 SEPA Direct Debits in detail (pdf - 22 pages)
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How to modify mandates (amendments)? Document
ID: 43603
Modified:
02/05/2013
Created:
02/05/2013
Version: 1

Prerequisite:

You can modify mandates manually in case of a rejection or amendment of a mandate. Some properties of a
mandate can be modified without an amendment; e.g. debtor name. Mandate amendments are not applicable
in case of one-off mandates or migrated mandates with sequence value "First".

Amendments to mandates are made at the initiative of the creditor (e.g. an amended mandate reference) or at
the initiative of the debtor (e.g. a changed IBAN).

 Example
The account number of a debtor is changed. This amendment has an impact on the mandate properties.

Steps:

1. Select the Transactions tab.

2. Select “Managing > Mandates” in the “Navigation pane”. As a result the “Manage
Mandates” area opens.

3. Select a mandate in the “Manage Mandates” area.

4. Select “Actions > Show mandate details” in the “Navigation pane”. As a result the
“Edit mandate” screen is displayed.

5. Modify the existing mandate data.

6. Click on the Save (or Cancel) button:

Where the mandate amendment can be processed automatically (this applies in
most cases):

a "Warning" pop-up appears automatically if you have made changes to items
in the "Process mandates screen, which can also be modified manually in the
"Mandate amendment" pop-up window.
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1. Click on the OK (or Cancel) button. A second "Warning" pop-up will now
appear, which allows you to change the amendment to the mandate.

2. Click on the Yes (or No) button. The "Mandate amendment" pop-up window
is now displayed.

Under the "Set amendment" option you can select the following items

manually and then update them with the  button:

Mandate reference
Creditor Identifier
Creditor name
Debtor account number: if selected then “Debtor BIC” is disabled.
Used for changing the account number at the same bank.
Debtor BIC: if selected then “Debtor account number” is disabled.
The value is always “Same Mandate New Debtor Agent”. Used for
changing the account number to one at another bank.

Or you may remove the mandate amendment via the "Remove
amendment" option (this option is active/applicable where the amendment
was already added earlier).

3. Click on the Apply (or Cancel) button. The following collection with this
mandate now contains the data from the amendment.

Where the mandate amendment cannot be processed automatically, you will have
to modify the items manually in the "Mandate amendment" pop-up window (this is
in rare cases, e.g.where a bank rejects a collection as a result of an error relating to
the amendment):

1. Click the “Add Amendment” button or the “Edit Amendment” button (the
latter button is available if the amendment was already added earlier). As a
result the “Mandate amendment” pop-up window is displayed.

  Note

Using Isabel 6 - v6.26 - 43603 - How to modify mandates (amendments)? 15/05/2013

172 / 283



The “Add/Edit Amendment” button is only available for a migrated
mandate if the mandate has a “Next” or “Final” Sequence.

2. Select the option:

"Set amendment":

Just as with the automatic mandate amendments, you can select items

manually and then modify them using the  button.

Or "Remove amendment" (active/applicable where it was already been
added earlier).

3. Click on the Apply (or Cancel) button. The following collection with this
mandate now contains the data from the amendment.

 Notes

The mandate amendment includes the original (previous) data of the mandate
(whereas the common sense meaning of the term amendment is the change made to
an item).

The new values are not applied to the amendment but are stored in the mandate
itself.

Tip
You can also enter the names of the changed items and their original values in the Comment” field on the
"Process mandate" screens (34 spaces are available for this purpose) or you can print a screenshot of the
Mandate amendment" pop-up. 

This manual backup is recommended unless in some cases an amendment has been deleted automatically
and the amendments therefore must be re-entered manually (and you must not change the sequence value
of "First"). This is the case for:

the creation of the first collection of a mandate with an amendment.
The rejection of a collection (REJECT). A REJECT is a rejection that occurs before
the debtor has been debited.

How can I...:

Create mandates?
Assign mandates to groups? (optional)
Create a file (a collection)?
View the details of a collection in the (Sent) Transaction area?

More information:

Creating SEPA Direct Debits and mandates
Isabel 6 SEPA Direct Debits in detail (pdf - 22 pages)
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Creating Group of domestic transactions overview Document
ID: 32622
Modified:
17/04/2013
Created:
17/04/2013
Version: 8

Purpose:

The window New group allows you to create a series of domestic transactions that can be
saved in one group. The transactions in a group all have the same transaction type
and ordering party account and the memo date.

 How to access
Transactions tab > New menu > Old wizards > Group of domestic payments

How can I...:

Create a group of domestic payments?
Create a beneficiary group (workaround)?

More info:

Which wizard for which payment?

Links to detailed window descriptions:

New group - Encoding group parameters of a Group of domestic payments.
Transaction Data
Processing Options
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Group parameters Document
ID: 702
Modified:
15/03/2012
Created:
16/02/2013
Version: 52

The Encoding group parameters step consists of the following items: 

Note that the group parameters marked in red, cannot be changed once the group of domestic payments is
saved (more info)

Group name: the name of the group you want to create
Memo date (dd/MM/yy): the date on which the transaction should be executed or on
which the amount should be transferred to the beneficiary account. 
Either enter the date manually, or select the date via the calendar  icon. 

 Note
The interpretation of the memo date can vary depending on the principal accounts
bank. Contact the principal accounts bank to know how the bank handles
transactions with a memo date. The date will appear on every form of each individual
transaction, but it can be modified afterwards.

Alias: the dropdown list to select an existing debtor by means of an alias. 
Ordering account: the principal accounts are listed in a dropdown list.
Name and address:  the name and address of the principal account. After the principal
account is selected, the name and the address are automatically filled in.
Transaction type: the type of transaction that will be used for every transaction in the
group. The transaction types are listed in a dropdown list. 

 Note
This ordering account will be used for every transaction in the created group.

Global Debit: the selection to indicate that the transaction orders are entered as one
total amount on your account statements, provided that the principal account and the
memo dates are identical. If you clear this selection, every order is shown as a separate
transaction on your account statements.  
File reference:  Enter a reference here for internal company use. 
Urgent: the selection to indicate that the transactions are urgent
Next: to start creating the first transaction of the new group
Cancel: to abort the creation of the group

How can I...:
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create a group of domestic payments?

More info:

Links to detailed window descriptions:

New group
Transaction Data
Processing Options

Known issues:

You cannot change some fields when trying to modify one or more payments in a Group
of payments.
You have created a group of domestic payments but you cannot consult the details in
the account information. Why?
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Group of Domestic Transactions - Transaction data Document
ID: 703
Modified:
02/05/2013
Created:
03/05/2013
Version: 41

Purpose:

You can create a group of transactions via Group of domestic payments. Once you have
filled in the group parameters, you can create a series of transactions that are all added to
the group.
The Encoding one or more payments step consists of the following items:

Payment type: the option to indicate if the payment is a normal payment (default) or a
cheque.
Memo date (dd/MM/yy): this field is greyed out because you have already filled this in
when you create a new group.

 Note
The interpretation of the memo date can vary depending on the principal account's
bank. Contact the principal account's bank to know how the bank handles
transactions with a memo date. 

Amount: the amount to be transferred, use "." or "," to add decimals.
Principal: 
 

Alias: the alias assigned to the principal account.
Account: the principal account from which the amount will be debited. The available
principal accounts are listed in a drop-down list. A name and address are assigned to
each principal account. 
Name and address: the name and address of the principal account. After the
principal account is selected, the name and the address are automatically filled in.

To: 

Beneficiary: to select existing beneficiaries. You can select a beneficiary by account
number, alias or beneficiary name and address.
New beneficiary: the selection to indicate that the beneficiary is not yet inserted.
You will need to fill in the account number, the beneficiary name and address and
optionally an alias.
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Own account: to select personal accounts. The personal account numbers are
listed in a dropdown list.
Alias: short name or code for internal use in your company.  
Account number: the number of the beneficiary account. You can select an account
in the dropdown list or enter a new account number. In case of a new account
number, you will only be able to enter the format that is allowed (i.e. IBAN or BBAN
format).
Circular Cheque: the selection to create a circular cheque. This button is only active
if the payment type is a Cheque.
Name and address: the personal data of the beneficiary. The name and address
are automatically filled in when you select the beneficiary. When you enter a new
beneficiary you will need to fill in the information manually.
Save beneficiary: the selection to save the beneficiary or not (only available if the
option New beneficiary is selected)

 
Message to beneficiary: 

Free message: selection to use an unstructured communication to the beneficiary.
Structured message: selection to use a structured message.

User reference: a reference which may be useful for your internal accountancy. This
field is limited to 8 characters. 
Transaction type: the type of transaction that will be used for the transaction. The
transaction type is defined in the group criteria and can not be modified in this window. 
Urgency mode: the mode by which the transaction should be handled by the bank. The
urgency mode is defined in the group criteria and can not be modified in this window.
Next Transaction: the button to add an additional transaction to your group.
Finish group: the button to end the creation of the series of transactions. The
Processing options window appears after clicking the Finish group button.
Cancel: the button to abort the current transaction. All previous transactions in the group
are saved.

More info:

Links to detailed window descriptions:

New group
Transaction Data
Processing options
Circular cheque
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How to group Domestic Transactions? Document
ID: 1201
Modified:
02/05/2013
Created:
02/05/2013
Version: 28

Prerequisite:

You can group only domestic transactions.

The following transactions cannot be part of a group:

Uploaded files;
Foreign transactions;
Grouped transactions;
SEPA payments (this functionality is forseen in the Payment wizard)

Steps:

To group existing transactions:

1. Select the Transactions tab.

2. Select the transactions you wish to group.

3. Click Group domestic payments in the Navigation pane under Actions.

Next a window appears with a list of the selected transactions.

4. Optionally, select the check box Global debit, if you want the payment orders to
appear as one transaction on your account statements.

5. In the field Group name, enter a name for the new group.

6. Click the Ok button.
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The group is added to the list of transactions. The selected transactions no longer
appear in the list but are a part of the created group.

How can I...:

Create a Group transaction?
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Creating Envelopes overview Document
ID: 38114
Modified:
17/04/2013
Created:
17/04/2013
Version: 12

Purpose:

The creation of transaction envelopes is a feature also available in the previous version of the eBanking
application (Isabel Business Suite 5). However the functionality differs from the IBS5 group functionality and is
not based on it, e.g. it is not possible to enable global debit in an envelope.

The feature improves the visibility and facilitates the transaction flow in the Transactions area.

With this feature you can create transactions and allocate these transactions in envelopes (the allocation can
also be undone). Besides this, you can also handle files for multiple banks together.

The feature enables the initiators of transactions to create envelopes, to assign transactions and to send a
message to the signers. The signers can easily consult their envelopes and sign it. The senders can send
envelopes.

Functionality:

You are able to create an envelope with different types of payment, to give it a name and
to rename it.

You have the possibility to assign a transaction to an envelope in:

the Transactions area
the Payment (SEPA & Non-SEPA) wizard
the "Upload of files" wizard

A default name is used for a new envelope when the name is not specified during
creation.

It is possible to sign more than 20 transactions at the same time.
Envelopes in the Transactions area:

When the signer and/or sender consult the Transactions area, all available transactions
are displayed on one page.

When the initiator creates a payment, he/she can use envelopes or can keep it into the
Transactions area.

Named envelopes are used to (re)allocate the selected transaction(s) in one specific
envelope. The envelope disappears in the Transactions area, when all transactions
with the same name are sent, removed or deleted.

An envelope can’t be assigned to another envelope; the transactions of the first
envelope are added to the other envelope when doing this.

You have the possibility to only display the transactions in the Transactions area that
are not already assigned to an envelope. Therefore the extra filter “Not assigned to an
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envelope” is available.

Filters can also be applied to envelopes.

Different colours represent the current status of the transactions of the envelope:

Green envelope: all banking files are sufficiently signed
Orange envelope: all banking files are insufficiently signed
Blue envelope: all banking files are ready to be signed
Yellow envelope: all banking files are in the TO BE COMPLETED status
Red envelope: all banking files are in the ERROR status
Crosshatched envelope: all banking files have a different status

How can I...:

Add transactions to an envelope?
Remove transactions from an envelope?
Change the number of transactions displayed?
Use envelopes with Payment?
Use envelopes with Upload of files?
Sign a large number of transactions?
Define default filters?
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How to use envelopes with Payment? Document
ID: 38166
Modified:
02/05/2013
Created:
02/05/2013
Version: 7

Prerequisite:

During the creation of a transaction with the Payment wizard it is possible to add this transaction to:

An existing envelope
A newly created envelope

Steps:

1. Click on New > Payment in the Transactions area.

2. Insert the Payment Data.

3. Click on the “Assign to envelope” button . Next the envelope popup
window appears.

4. Actions you can perform:

1. Click on an existing envelope to assign the selected transactions to an existing
envelope; or

2. Type a new envelope name and click on the "Create envelope" button; or

3. Click on the "do not assign" option to avoid that the current transaction is added
to any envelope; this is by default the case if an envelope was selected for the
previous transaction; the buttonlabel "Assign to envelope" is then replaced with
the name of the previous envelope.

 Note
An envelope may contain an unlimited number of transactions. Nevertheless we advise you to limit the
number of transactions in an envelope to 100.

How can I...:
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Add transactions to an envelope?
Remove transactions from an envelope?
Change the number of transactions displayed?
Use envelopes with Upload of files?
Sign a large number of transactions?
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How to use envelopes with Upload of files? Document
ID: 38167
Modified:
02/05/2013
Created:
02/05/2013
Version: 5

Prerequisite:

During the upload of transactions files it is possible to add these transactions to:

An existing envelope
A newly created envelope

Steps:

1. Click on New > Upload of files in the Transactions area.

2. Select the file(s) you want to upload.

3. You want to add:

1. All contained transactions to an envelope: click on the “Assign to envelope”
button in “Step 1: Select files”.

2. Only transactions that are contained in seperatly selected files to an envelope:
 

a. Click on the “Define attributes” button in Step 1. Next the “Step 2: Define
attributes (optional)” window is displayed.

b. Click on the “Assign to envelope” button next to the desired files.
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How can I...:

Add transactions to an envelope?
Remove transactions from an envelope?
Change the number of transactions displayed?
Use envelopes with Payment?
Sign a large number of transactions?
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How to add transactions to an envelope? Document
ID: 38163
Modified:
02/05/2013
Created:
02/05/2013
Version: 8

Prerequisite:

Select the Transactions tab.

Steps:

1. Select one or more transactions.

2. Click on the “Assign to envelope” button . Next the envelope popup
window appears.

3. Options:

1. Click on an existing envelope to assign the selected transactions to an existing
envelope; or

2. Type a new envelope name and click on the "Create envelope" button

 Note
An envelope may contain an unlimited number of transactions. Nevertheless we advise you to limit the
number of transactions in an envelope to 100.

How can I...:

Remove transactions from an envelope?
Change the number of transactions displayed?
Use envelopes with Payment?
Use envelopes with Upload of files?
Sign a large number of transactions?
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How to remove transactions from an envelope? Document
ID: 38164
Modified:
02/05/2013
Created:
02/05/2013
Version: 4

Prerequisite:

Select the Transactions tab.

Steps:

Click on the unfold envelope button. Next the envelope is unfolded and the contained
transactions appear on separate lines. Also the "Remove from envelope" button
appears.

Select one, more or all transactions.

Click on the "Remove from envelope" button.

How can I...:

Add transactions to an envelope?
Change the number of transactions displayed?
Use envelopes with Payment?
Use envelopes with Upload of files?
Sign a large number of transactions?
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Upload transaction files overview Document
ID: 704
Modified:
02/05/2013
Created:
02/05/2013
Version: 43

Purpose:

To quickly create a large number of transactions, you can upload a bank file that is created by an external
program.

Isabel 6 eBanking provides a wizard that guides you through the upload procedure.

 How to access
Select Transaction tab > New menu > Upload of files

The wizard to upload one or more transactions consists of 4 steps:

Select files: the step in which you must select the files you wish to import 
Define attributes (optional): the step in which you can define attributes of the
uploaded transactions such as an internal reference and the file format
Upload files: the step in which you follow the progress of the upload
Define processing options: the step to define processing options such as the
selection of the signer(s).

 Note
The file that you upload needs to have a specific structure depending on the type of transaction (domestic or
international transaction, direct debit, cheques, ...). 
More information on the upload file structure can be found on the website of the Belgian Bankers' and
Stockbroking Firms Associaton, http://www.febelfin.be/, in the section Mijn geld en ik / Mon argent et moi.

How can I...:

Upload a bank file?
Hide the details of an uploaded (imported) file?
Configure Isabel 6 for renaming or deleting files automatically after the upload? 

More info:

Links to detailed window descriptions:

Step 1: Select files for upload.
Step 2: Define attributes (optional) of the uploaded bank files.
Step 3: Upload files.
Step 4: Define processing options for the uploaded bank files.
Configure the treatment of uploaded files after a successful upload.

Related articles:

Where to find more information about ABB/BVB standards (import and export files) for
electronic banking via Isabel 6?
Supported bank file upload and download formats.
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Upload transaction files - Select Files (1/4) Document
ID: 705
Modified:
02/05/2013
Created:
02/05/2013
Version: 40

Purpose:

In step 1 of the upload wizard, you select the files you wish to upload.

The Select files window in the upload wizard contains the following items:

Directories: a tree view where you can browse to the folder where the bank files are
located
When you have selected the correct folder, the files are displayed  in the field Files.

 Note
If you have saved your files on your desktop; you can retrieve these files by
navigating in the Directories structure to the following folder:

In Windows XP: C:\Documents and Settings\{your username}\Desktop; or
In Windows Vista or 7: C:\Users\{your username}\Desktop

Files: an overview of all the bank files in the selected folder
Selected files: an overview of the files that will be uploaded

Select a file in the field Files and click the  button to add the file to the Selected
files field.
Select a file in the field Selected files and click  the  button to remove the file from
the selected file.
You can also click on  or  to move all files from one list to another in one go.

 Tip
If you wish to select multiple files, hold the CTRL-key while selecting the files.

Upload: start upload of the bank files.
Define attributes: define the attributes of the bank files.
Cancel: discard the upload wizard.

How can I...:

Upload a bank file?
Hide the details of an uploaded (imported) file?
Configure Isabel 6 for renaming or deleting files automatically after the upload?
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More info:

Links to detailed window descriptions

Step 1: Select files.
Step 2: Define attributes (optional) of the uploaded bank files.
Step 3: Upload files.
Step 4: Define processing options for the uploaded bank files.
Configure the treatment of uploaded files after a successful upload. 

Related articles:

Where to find more information about ABB/BVB standards (import and export files) for
electronic banking via Isabel 6?
Isabel 6 supported bank file upload and download formats.
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Upload transaction files - Define Attributes (optional) (2/4) Document
ID: 706
Modified:
02/05/2013
Created:
02/05/2013
Version: /

Purpose:

Step 2 of the upload wizard is optional. In this step you can define several attributes for the bank files, to keep a
clear overview on them.

The Define attributes (optional) window of the upload wizard contains the following columns:

File: column that displays the complete path and the file name of the bank file 
Name: column in which you can type an internal reference, which can be useful for your
own accountancy
File format: column in which you can define the transaction type in the bank file (default
is Autodetect). .

 Tip
It is recommended to define the File format instead of using the default option
Autodetect. The advantage of defining the format is that an error in a file will be
detected during the upload.

 Note
When using the Autodetect setting for the file format ... : 

And the format of the upload file can not be detected, the file may still be sent to
the bank as a so called DIV file and the transaction(s) in the upload file might not
be carried out (depending on the bank).
And the format of the upload file can be detected, but the file contains another
error, the file will not be sent to the bank.

Shared: column where you can select to share/not to share (default) the file with other
users.
 Hide details: column in which you can enable or disable (default) Hide details. 

 Note
Some customers who are using the upload functionality want to make a distinction in
the viewing rights of users independently of the determined admin rights. Certain
users who import/upload information can have a mandate from their
organization to hide details of files for other users because there is
specific sensitive information in it (e.g. salary payments).

 Warning
No user of the subscription can reset the value of the hide details option. Once
decided to hide the details, there are no means to overrule this information.
 
Next: to proceed with the wizard
Cancel: to abort the upload
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How can I...:

Upload a bank file?
Hide the details of an uploaded (imported) file?
Configure Isabel 6 for renaming or deleting files automatically after the upload? 

More info:

Links to detailed window descriptions:

Step 1: Select files for upload.
Step 2: Define attributes (optional) of the uploaded bank files.
Step 3: Upload files.
Step 4: Define processing options for the uploaded bank files.
Configure the treatment of uploaded files after a successful upload.

Related articles:

Where to find more information about ABB/BVB standards (import and export files) for
electronic banking via Isabel 6?
Isabel 6 supported bank file upload and download formats.
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Upload transaction files - Upload Files (3/4) Document
ID: 707
Modified:
02/05/2013
Created:
02/05/2013
Version: 56

The Upload files window of the upload wizard looks as follows:

The Upload files window of the upload wizard consists of the following items:

Progress: column that displays a progress bar of the upload process for each bank file

: icon indicating that Isabel Banking is currently uploading the bank file

: icon indicating that the upload of the file is successfully completed

: icon indicating that the upload was not successful, the file has an incorrect
structure

: 
if format is DIV, than you have to assign bank/DIV-type
if upload gives warnings, than you have to accept or refuse the upload

File: column that displays the name of the bank file
Feedback: column that displays feedback about the upload. If not all data is correct,
click the  button to see the details or the alert. 
Action: column that indicates what action needs to be taken (Accept or Refuse), in
case some data are missing or erroneous.  
Bank: column that shows the destination bank

 Notes
The column Action is empty if the file is correctly uploaded.
The column Bank contains the logo of the bank to which the file will be sent.

Next: define the Processing Options of the uploaded bank files
Close: finish the upload wizard without defining processing options

 Notes

In the case that a special format needs to be uploaded (DIV files), the wizard will
request to specify the format and the destination bank via an additional combo box. A
subscription to the module Upload cheques and various files is required for this
and it must be supported by your bank.

You can also import direct debit files, created with an independent software program,
into Isabel 6. Technically, files are imported from your ERP or accountancy software
to a DOM'80 file or to the latest XML SDD format. If you would like to use the XML
SDD format your ERP or accountancy software must be ready to support SEPA direct
debits. For more information about SEPA direct debits please contact your software
provider and your bank.

When uploading one or more large files, you do not have to leave the Upload
files window open until the operation is complete, this is also indicated by the remark
on the screen (with the bulb icon). You can continue working, for example check your
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account information or enter new transactions. After 2 minutes a message
will indicate that the upload process continues in the background. You can always
check whether the upload is still in progress via the Uploaded file(s) currently
being processed filter on the Transaction tab.

How can I...:

Upload a bank file?
Hide the details of an uploaded (imported) file?
Configure Isabel 6 for renaming or deleting files automatically after the upload? 

More info:

Links to detailed window descriptions:

Step 1: Select files for upload.
Step 2: Define attributes (optional) of the uploaded bank files.
Step 3: Upload files.
Step 4: Define processing options for the uploaded bank files.
Configure the treatment of uploaded files after a successful upload.

Related articles:

Where to find more information about ABB/BVB standards (import and export files) for
electronic banking via Isabel 6?
Isabel 6 supported bank file upload and download formats.
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Upload transaction files - Define processing options (4/4) Document
ID: 708
Modified:
03/05/2013
Created:
03/05/2013
Version: 42

Purpose:

In step 4 of the upload wizard, you can define processing options for all the transactions in
a bank file.
The Define processing options window in the upload wizard consists of the following items:

File: the name of the bank file that is uploaded
Sign immediately: selection to indicate that you wish to sign the transaction
immediately after finishing the upload
Send when sufficiently signed: selection to indicate that you wish to send the
transaction immediately after sufficient signatures
Signers : click on the hyperlink Invite signers to select the users who need to sign the
transaction.
Finish button to complete the upload wizard

 Notes

If you want to use the option Send when sufficiently signed, you will need to
activate the module MultiSign.
The so called hash code can be generated by your accounting software and is used
to prove that a file has not been altered between the moment it is created in your
accounting package and the moment it is signed and send to the bank.

How can I...:

Upload a bank file?
Hide the details of an uploaded (imported) file?
Configure Isabel 6 for renaming or deleting files automatically after the upload?

More info:

Links to detailed window descriptions:

Step 1: Select files for upload.
Step 2: Define attributes (optional) of the uploaded bank files.
Step 3: Upload files.
Step 4: Define processing options for the uploaded bank files.
Configure the treatment of uploaded files after a successful upload.

Related articles:

Where to find more information about ABB/BVB standards (import and export files) for
electronic banking via Isabel 6?
Isabel 6 supported bank file upload and download formats.
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Treatment of uploaded file Document
ID: 29097
Modified:
03/05/2013
Created:
03/05/2013
Version: 18

Purpose:

You can upload banking files from your accounting software or ERP system into Isabel 6 via the manual upload
functionality.

Isabel 6 eBanking offers the customer a way to show whether or not a file has been uploaded already. This will
help you to avoid that you download the same banking file multiple times.

Every customer has a specific method to manage the files coming from his/her accounting software or ERP
system.

You have the possibility to choose between 3 distinctive options that can be selected via the Transaction
Preferences.

1. No treatment: this is the default option for the 'Treatment of uploaded files after
successful upload (even if the file is not correct)'.

2. Delete the file: with this option the original file will be deleted after it is successfully
uploaded.

3. Rename the file: with this option the original file will be renamed according to the
following principles: 
 

The file extension will be changed to SAV.
The date and the time will be added in front of the original file name (e.g.
yyyymmdd_hhmm_original filename.SAV).

Uploads via Isabel Go (of all ERP systems and other applications using automatic upload) are not subject to
these preferences. The third party application handles this by itself.

 Note
If a file is not correctly uploaded to the Isabel system, an error message will be shown.

How can I...:

Upload a bank file?
Hide the details of an uploaded (imported) file?
Configure Isabel 6 for renaming or deleting files automatically after the upload? 
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More info:

Links to detailed window descriptions:

Step 1: Select files for upload.
Step 2: Define attributes (optional) of the uploaded bank files.
Step 3: Upload files.
Step 4: Define processing options for the uploaded bank files.
Configure the treatment of uploaded files after a successful upload.

Related articles:

Where to find more information about ABB/BVB standards (import and export files) for
electronic banking via Isabel 6?
Isabel 6 supported bank file upload and download formats.
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How to upload files? Document
ID: 1197
Modified:
03/05/2013
Created:
03/05/2013
Version: 47

Steps:

To upload files:

1. Select the Transactions tab.

2. Click Upload of files in the Navigation pane under New. The Upload of files wizard
starts.

3. In the Directories section, select the folder where the files to be uploaded are stored.

4. In the Files section, select the files to be uploaded.

5. Click the  button to move the selected files to the Selected files field. The files
listed in the Selected files field will be uploaded.

 Tip
Click the  icon to move all files from the Files field to the Selected files field.

6. Click the Upload button (and go to step 9) or proceed to the next step to Define
attributes (optional).

7. Add and select possible attributes to the files to be uploaded with Define attributes
(optional).

 Tip
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It is recommended to define the File format instead of using the default option
Auto Detect. The advantage of defining the format is that an error in a file will be
detected during the upload.

 Notes
When using the Auto Detect setting for the file format ... : 

And the format of the upload file can not be detected, the file may still be sent to
the bank as a so called DIV file and the transaction(s) in the upload file might not
be carried out (depending on the bank).
And the format of the upload file can be detected, but the file contains another
error, the file will not be sent to the bank.

8. Click the Next button. The selected files are being uploaded. Wait until feedback is given for all files.

9. Click the Next button, next the Define processing options window appears; or click the Close button to
end the upload process.

10. Define the processing options.

 

11. Click the Finish button to finish the upload of the files.

How can I...:

Hide the details of an uploaded (imported) file?

More information:

Links to detailed window descriptions:

Step 1: Select files for upload
Step 2: Define attributes (optional) of the uploaded bank files
Step 3: Upload files
Step 4: Define processing options for the uploaded bank files

Related articles:

Where to find more information about ABB/BVB standards (import and export files) for
electronic banking via Isabel 6?
Isabel 6 supported bank file upload and download formats
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How to modify a transaction? Document
ID: 1225
Modified:
03/05/2013
Created:
03/05/2013
Version: 25

Steps:

To modify a transaction:

 Notes

If you modify a transaction that was previously sufficiently signed then all possible
signers have to sign the modified transaction again.
It is not possible to modify an uploaded transaction. To modify an uploaded
transaction, you have to recreate the transaction file and upload this new file.

1. Select the Transactions tab.

2. Click the name of the transaction you wish to modify. The details of the transaction
appear.

3. In the Navigation pane under Actions, click Modify transaction(s).

The transactions module, in which you have created the transaction, appears.

4. Modify the transaction. You have to run the complete transaction module to save
the modifications. Next you return to the transaction details.

5. Click the Finish button.

How can I...:

Create a domestic transaction?
Create a international transaction?
Create a group transaction?
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How to send a transaction? Document
ID: 1228
Modified:
03/05/2013
Created:
03/05/2013
Version: 32

Prerequisite:

Before you can send a transaction, the transaction must have the Sufficiently signed 
 icon.

Steps:

To send a transaction:

1. Select the Transactions tab.

2. Select the transaction(s) you wish to send.

3. In the Navigation pane under Actions, click Send.

The transaction disappears from the overview of transactions and will appear after a
few minutes in the Sent Transactions tab.

 Note
If a transaction is insufficiently signed, you are invited to add a signature.

How can I...:

Sign a transaction?

More information:

Sent Transactions overview
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How to delete a transaction? Document
ID: 1229
Modified:
04/01/2013
Created:
03/05/2013
Version: 25

Steps:

To delete one or more transactions:

1. Select the Transactions tab. The list of transactions appears.

2. Select the transaction(s) you wish to delete.

 Tip 
The check box on top of the table can be used to select all visible transactions on the current page.
Transactions on other pages are not selected.

 

3. Click Delete in the Navigation pane under Actions.

A Confirmation popup window appears. 

4. Click the Yes button.

The updated list of transactions appears.
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How to modify the processing options of a transaction? Document
ID: 1233
Modified:
07/01/2013
Created:
03/05/2013
Version: 19

Steps:

To modify the processing options of a transaction:

1. Select the Transactions tab. 

2. Click the name of a transaction. The details of the transaction appear. 

3. Click Modify processing options in the Navigation pane under Actions.  

4. Modify the processing options for the transaction.

5. Click the Submit button. The details of the transaction appear. 

6. Click the Close button.

More information:

Modify processing options window
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How to change the number of transactions displayed? Document
ID: 38165
Modified:
03/05/2013
Created:
03/05/2013
Version: 7

Prerequisite:

Select the Transactions tab.

Steps:

 Note
To assign transactions to an envelope you can only select transactions on the active page. Thus, if you want
to assign transactions from several pages, you have to do this page by page.

Use following way(s) to change the number of transactions displayed:

Increase the number of displayed transactions:

Click on the number of transactions displayed dropdown list.

Select the number of transactions displayed.  

The default value is 20 transactions. You can increase the number of displayed
transactions in steps of 20 up to a maximum of 100 for one page.

Collapse existing envelopes. As a result more transactions are displayed on the current
page.

How can I...:

Sign a large number of transactions?

Using Isabel 6 - v6.26 - 38165 - How to change the number of transactions displayed? 15/05/2013

205 / 283

https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=38197


Using Isabel 6 - v6.26 - 38165 - How to change the number of transactions displayed? 15/05/2013

206 / 283



How to define default filters? Document
ID: 38236
Modified:
03/05/2013
Created:
03/05/2013
Version: 4

Prerequisite:

eBanking users prefer to have at start-up a view with their preferred filter.

It is possible to save a desired default filter in the application. There is a functionality that allows setting and
saving the default filter that is used in the Transactions area (and in the Account Info area).

Go to the Preferences > Transactions screen.

Steps:

The available "Default filters" are fixed and thus there are no filters defined by you.

The available "Default filters" are the same than the items of the Filter list in the Transactions area:

My Transactions
All Transactions
Transactions assigned to an envelope
Transactions not assigned to an envelope
Transactions to be signed
Transactions ready to send
Files requiring special user interactions
Uploaded file(s) currently being processed

Applying your "Default filter":

1. Select your "Default filter".

2. Click on the Save button.

3. Restart the application to apply the changes.

4. After this change (and until next change), each time you start the application, the
chosen "Default filter" is applied in the Transactions area.
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More information:

Envelopes
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Managing Counterparties (beneficiaries and debtors) overview Document
ID: 990
Modified:
03/05/2013
Created:
03/05/2013
Version: 62

Purpose:

A counterparty is considered to be the other party in a financial transaction. A counterparty can be a beneficiary
or a debtor or both.

You can fill in the counterparty's data in every transaction you create. But to save time, you can build a list of
counterparties from which you can select one when creating a transaction.

You can:

Manually create a counterparty and add it to the list; or
Add a counterparty while creating a transaction; or 
Upload counterparties from Isabel Business Suite 5.0 or a file, to reuse existing lists
(e.g. all suppliers).

 How to access
Select Transactions tab > Managing menu > Counterparties

The Manage counterparties window contains the following sections:

Search: button to search on Alias or Name
:  in the first column you can select one, multiple or all counterparties. Next the

applicable Actions appear in the Navigation pane.
Alias: short name or code for internal use in your company.
Name and address: full name and full address of the counterparty.
Account country: country of the account.
Beneficiary: if a beneficiary account has been added to the counterparty, it is indicated
with the icon. In that case, this counterparty can be used to create transactions.
Debtor: if a direct debit order number has been added to the counterparty, it is indicated
with the icon. In that case, this counterparty can be used to create direct debit orders.
Shared: if the counterparty is shared, other users may be able to view, use or edit that
counterparty. For more information, please consult the chapter Personal and Shared
Counterparties
Personal and Shared counterparties.
Close: the button to return to the transactions overview.

How can I...:

Create a counterparty?
Modify a counterparty?
Delete a counterparty?
Add an account number to a counterparty?
Modify an account number of a counterparty?
Delete an account number of a counterparty?
Print or export counterparties?
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Edit counterparty circular cheque data?

Upload counterparties from my accounting software?

See my own personal counterparties in Isabel 6?

More info:

Creating or editing counterparties
Add account number to a counterparty
Add direct debit number to a counterparty
Add circular cheque data to a counterparty

Transaction preferences
Personal and Shared Counterparties
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Creating or editing counterparties Document
ID: 1102
Modified:
03/05/2013
Created:
03/05/2013
Version: 58

Purpose:

To create new beneficiaries or debtors, you have to start by creating a new counterparty.
To add a new counterparty, you need to enter the personal data of this counterparty first. Once the counterparty
has been created, you can add beneficiary accounts and/or direct debit order numbers. 

  How to access

To create a new counterparty: Select Transactions tab > Managing menu >
Counterparties > New menu > Counterparty
To edit a counterparty:

Select Transactions tab > Managing menu > Counterparties > Select a
counterparty > Actions menu > Show counterparty details
Select Transactions tab > Managing menu > Counterparties > Click the name
of the counterparty

The New Counterparty window contains the following sections:

Counterparty:
 

Alias: short name or code for internal use in your company  
Account country: country of origin of the account number

Counterparty sharing: sharing counterparties is only possible when the eBanking user
has selected the module MultiSign. If this module is not ordered, all new counterparties
will automatically be saved as Personal.
 

Personal or Shared: for more information, please consult the chapter Personal and
Shared Counterparties.

Counterparty contact data: 
 

Name: full name of the counterparty
Address: street name, house number, postal code and city of the counterparty
Country: country of the counterparty
Telephone number: telephone number of the counterparty
E-mail: e-mail address of the counterparty
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Create: enables you to add beneficiary accounts or direct debit order numbers to the
new counterparty.

Cancel: discard the creation of a new counterparty

The Edit counterparty window contains two additional sections:

Beneficiary accounts: the details of the accounts added to the counterparty

Debtor direct debit order numbers: the details of the direct debit order numbers
added to a Belgian counterparty 

Use the buttons Add, Edit or Delete to add, modify or delete account numbers or
debtor direct debit order numbers of the counterparty 

Save: save the counterparty 

Cancel: discard the changes applied to the counterparty 

How can I...:

Create a new counterparty?
Upload counterparties from my accounting software?

More info:

Transaction preferences
All you need to know about Personal and Shared Counterparties

Follow the descriptions below for more details about:

Managing Counterparties (beneficiaries and debtors)
Add an account to a counterparty
Add a direct debit order number to a counterparty (debtor)
Edit circular cheque data
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Add account number to a counterparty Document
ID: 8932
Modified:
03/05/2013
Created:
03/05/2013
Version: 28

Purpose:

If you want to use a counterparty for creating transactions, at least one account needs to be added to that
counterparty in addition to the personal data.

In other words: to create a beneficiary, you first need to create a counterparty and add an account
number to that counterparty.

 How to access

Select Transactions tab > Managing menu > Counterparties > New menu
> Counterparty > Click the Create button > Open the counterparty
by clicking it > Click the Add or Edit button in the Beneficiary accounts section; or
Select Transactions tab > Managing menu > Counterparties > Select a
counterparty > Click the Add or Edit button in the Beneficiary accounts section

The Add Counterparty Account window contains the following sections and items:

Counterparty: these two fields can not be modified.

 Tip
If the country of the account number you wish to add is different then the country of
the counterparty, you need to create a new counterparty with that account country.
 

Alias: short name or code for internal use in your company
Account country: country of origin of the account number

Note
Only the user who created the counterparties can manage and/or share them. To make counterparties
personal or shared, you need the module MultiSign.

Account number: depending on the selected account country, different formats can be
used
 

IBAN: the International Bank Account Number. The IBAN-format is required if your
foreign payment should be eligible for a cheaper rate.
Local bank account number: an account number specific for a country. The format
of an account number is country dependent. A check on the validity of the account
number will be performed.
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Free format: an account number on which no validity check will be performed. This is
only visible when the account country is not Belgium.

  Bank:
 

BIC: the Bank Identifier Code of the counterparty's bank. It is recommended to
select a BIC in order to facilitate the transaction handling at the bank.
Search: the button to search the BIC

Defaults: when filled in, the values below will automatically appear in the appropriate
fields, while creating transactions with this particular account number.

Message to the beneficiary

 Tip
By adding a structured message you must only use numbers, not the characters
+++//+++. This message is also displayed with a tooltip.

Amount
Currency

Save: save the account number for the selected counterparty (= beneficiary)
Cancel: cancel the action

More info:

Managing Counterparties (beneficiaries and debtors)
Creating or editing counterparties
Add a direct debit order number to a counterparty (debtor)
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Add a direct debit order number to a counterparty Document
ID: 8933
Modified:
03/05/2013
Created:
03/05/2013
Version: 26

Purpose:

If you want to use a counterparty for creating direct debits, at least one direct debit order number needs to be
added to that counterparty in addition to the personal data.

In other words: to create a debtor, you first need to create a counterparty and add a direct debit order
number to that counterparty.

 How to access

Select Transactions tab > Managing menu > Counterparties > New menu
> Counterparty > Fill in the data of the counterparty > Click the Create button > Click
the Add or Edit button in the Debtor direct debit order numbers section
Select Transactions tab > Managing menu > Counterparties > Select a
counterparty > Click the Add or Edit button in the Debtor direct debit order
numbers section

The Add Debtor direct debit order numbers window contains the following sections and items:

Counterparty: shows the alias and account country of the counterparty. These two
fields can not be modified.
 

Alias: short name or code for internal use in your company
Account country: country of origin of the account number

Debtor direct debit order number:
 

Direct debit number:  a digital direct debit number (max 16 digits) specified by the
creditor
End date: the end date of the direct debit order agreement

Defaults: when filled in, the values below will automatically appear in the appropriate
fields, while creating a direct debit with this particular direct debit order number.
 

Amount: the amount, which the debtor is indebted to you   
Refund: check box to indicate if it is a refund (selected) or not (cleared)
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Structured reference: a structured message to the beneficiary 
Message to debtor: the communication to the beneficiary, as it will appear in your
account statements

Save: save the direct debit number for the selected counterparty (= debtor)
Cancel: discard the creation of a new direct debit number

More info:

Managing Counterparties (beneficiaries and debtors)
Creating or editing counterparties
Add an account to a counterparty
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Add circular cheque data to a counterparty Document
ID: 6110
Modified:
03/05/2013
Created:
03/05/2013
Version: 13

Purpose:

In this window you can add (or edit) the circular cheque data for the selected counterparty.
 How to access

Select Transactions tab > Managing menu > Counterparties > Select Counterparty > Actions menu
> Modify circular cheque data

The Edit circular cheque data window consists of the following sections:

Type of cheque: a dropdown list to select the type of cheque
Charges: select whether the costs for the transaction are chargeable to the principal or
the payee
Title: select the title to be used on the cheque
Language: select the language for the messages on the cheque
Save: save the circular cheque data
Delete: delete the circular cheque data

Cancel: discard the changes of a circular cheque data
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How to create a counterparty? Document
ID: 980
Modified:
03/05/2013
Created:
03/05/2013
Version: 22

Steps:

To create a counterparty:

1. Click the Transactions tab.

2. In the Navigation pane under Managing, click Counterparties. An overview of all
shared and personal counterparties appears.

3. In the Navigation pane under New, click Counterparty. The window New
counterparty appears. 

4. Fill in the counterparty personal data.

 Note
Only the user who created the counterparties can manage and/or share them. To make counterparties
personal or shared, you need the module MultiSign.

5. Click the Create button. The counterparty is created.

6. Under the section Beneficiary accounts, click the Add button. The Add
Counterparty Account window appears.

7. Fill in the account number data.

8. Click the Save button. The counterparty is saved with the added account numbers.
The window Manage counterparties appears.

How can I...:

Add an account number to a counterparty?
Search the BIC code?
Create a debtor direct debit order number?
Edit circular cheque data?
Upload counterparties from my accounting software?
Modify a counterparty?
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More information:

Account number details
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How to modify a counterparty? Document
ID: 984
Modified:
03/05/2013
Created:
03/05/2013
Version: 19

Steps:

To modify a counterparty:

1. Select the Transactions tab.

2. Click Counterparties in the Navigation pane under Managing. The window
Manage counterparties appears.

 Notes
If your total number of counterparties exceeds the number defined by system
configuration then:

The counterparties are not displayed.

A popup message “You have too many counterparties to display at once.
Please use the ‘search’ field to limit the list.” appears.

  

You have to type one or more corresponding characters in the search field (and
have to click the “Search” button to confirm). The purpose is to limit the
counterparties to be displayed in the counterparties area in order to optimize
screen performance.

3. Select the counterparty you wish to modify. In the Navigation pane under Actions,
click Show counterparty details. The window Edit counterparty appears.

 Tip
To open the window Edit counterparty, you may also click on the Alias, Address
or Account country of the counterparty.

4. Modify the personal data of the counterparty.
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5. Click the Save button. The counterparty is saved. The window Manage
counterparties appears.

How can I...:

Delete a counterparty?
Modify an account number?
Add an account number?
Delete an account number?
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How to delete a counterparty? Document
ID: 1001
Modified:
03/05/2013
Created:
03/05/2013
Version: 16

Steps:

To delete one or more counterparties:

1. Click the Transactions tab.

2. Click Counterparties in the Navigation pane under Managing. The window
Manage counterparties appears. 

3. Select the counterparty(-ies) you wish to delete.

4. In the Navigation pane under Actions, click Delete counterparties. A popup
window appears to confirm the action.  

5. Click the Yes button. The list with counterparties is updated.

 Tip
To delete all counterparties at once; select the top checkbox; and in the Navigation pane under Actions,
click Delete counterparties.

How can I...:

Create a counterparty?
Upload a list of counterparties?

More information:

Counterparties overview
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How to add an account number to a counterparty? Document
ID: 994
Modified:
03/05/2013
Created:
03/05/2013
Version: 25

Prerequisite:

 Note
Only the user who created the counterparties can manage and/or share them. To make counterparties
personal or shared, you need the module MultiSign.

Steps:

You can add account numbers to a new or an existing counterparty.

To add an account number to a new counterparty: 

1. When the new counterparty is saved, under the section Beneficiary accounts click the button Add.
The window Add Counterparty account appears.

 Note
Before adding the first account number to a new counterparty, you may select another Account
country from the drop-down list. The country of the other account numbers that you subsequently
add to the counterparty cannot be changed. If you wish to add another account number of another
country, you need to create a new counterparty.
 

2. Fill in the required account number data.

3. Click the Save button. The account number is added to the counterparty and the
window Edit counterparty appears.

4. Click the Save button. The changes to the counterparty are saved and the window
Manage counterparties appears.

To add an account number to an existing counterparty:

1. Select the Transactions tab. The list of transactions appears.

2. Click Counterparties in the Navigation pane under Managing. The window
Manage counterparties appears.

3. Select the checkbox in front of the counterparty you wish to modify.

 Note
If you already added account numbers to a counterparty, you cannot select
another Account country for the new account number. If you wish to add an
account number of another country, you need to create a new counterparty.

 
4. In the Navigation pane, under Actions, click Show counterparty detail.

 Tip
You may also click on the Alias, Address or Account country of the
counterparty to open its details.

5. In the section Beneficiary accounts, click the Add button. The window Add
Counterparty account appears.

6. Fill in the required account number data.
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7. Click the Save button. The account number is added to the counterparty and the
window Edit counterparty appears.   

8. Click the Save button. The changes to the counterparty are saved and the window
Manage counterparties appears.

How can I...:

Create a counterparty?
Modify an account number of a counterparty?

More information:

Details of account numbers
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How to modify an account number of a counterparty? Document
ID: 1000
Modified:
03/05/2013
Created:
03/05/2013
Version: 16

Steps:

To modify an account number of an existing counterparty:

1. Select the Transactions tab. 

2. Click Counterparties in the Navigation pane under Managing. The Manage
counterparties window appears. 

3. Select the counterparty you wish to modify. 

4. Click Show counterparty details in the Navigation pane under Actions. The Edit
counterparty window appears.

 Tip
To open the window Edit counterparty, you may also click on the Alias, Address
or Account country of the counterparty.

5. In the Beneficiary accounts section, select the account number you wish to modify. 

6. In the Beneficiary accounts section, click on the Edit button. The Edit
Counterparty Account window appears.

 Tip
You may also click the hyperlink in any column to view the details of the account
number.

7. Modify the necessary account number data. 

8. Click the Save button. The window Edit counterparty appears and the list of
accounts is updated. 

9. Click the Save button. The window Manage counterparties appears.

How can I...:

Search the BIC code?

More information:

Account number details
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How to delete an account number of a counterparty? Document
ID: 1002
Modified:
03/05/2013
Created:
03/05/2013
Version: 23

Steps:

To delete an account number of a counterparty:

1. Select the Transactions tab.

2. Click Counterparties in the Navigation pane under Managing. The Manage
counterparties window appears.  

3. Select the counterparty from which you want to delete an account number.

4. In the Navigation pane under Actions, click Show counterparty details. The Edit
counterparty window appears.

 Tip
To open the Edit counterparties window, you may also click on the Alias,
Address or Account country of the counterparty.

5. Select the account number(s) you wish to delete in the section Beneficiary
Accounts.

6. Click the  Delete button in the section Beneficiary Accounts. The window to confirm
that you want to delete the account number(s) appears.
 

7. Click the Yes button. The account is deleted and the Edit counterparty window
appears. 

8. Click the Save button. The counterparty information is saved and the Manage
counterparties window appears.

 Tip
To delete a group of accounts of the counterparty: select the accounts you want to delete; and in the
Navigation pane under Actions, click Delete account.

How can I...:

Add an account number to a counterparty? 
Delete a counterparty?
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How to print or export counterparties? Document
ID: 34658
Modified:
04/01/2013
Created:
03/05/2013
Version: 3

Prerequisite:

The eBanking application allows you to print or export overviews or details of the available counterparties.

When selecting the print functionality, you can choose between printing to a PDF document or exporting to a
text file. The PDF document can be printed or saved. The text file is often used to export the data to another
program.

Steps:

1. Select the Transactions tab.

2. Select Counterparties under Manage in the Navigation Pane.

3. Select one or more counterparties you want to show (and print).

4. Click Print under Actions in the Navigation Pane.

As a result the Print Options popup window appears.

Available Print options:
 

Overview of (selected) counterparties
Details of (selected) counterparties
Details of all counterparties

5. Print or export counterparties: 

Show (and print) PDF document:

A PDF writer is not required to create the PDF file, this function is included in
eBanking. However you need Adobe Reader to view the PDF file.
 

1. Click the Show PDF button. Next you can download and open the PDF
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document via Reports in the Navigation pane.

Example:

Example:

2. Click the Print button in the toolbar of Adobe Reader. The overview, the
details or the summary will be printed.

It is possible to save the PDF document to your hard disk by clicking the
Save a Copy button in the toolbar.

3. Close the window with the PDF document.

Export to a text file:
The default text separator is ';'.

To modify the text separator:

Select the Transactions tab > Managing menu > Preferences menu-item.
Select General from the Manage user preferences overview and enter the
text separator in the field When exporting as txt-file, separate with.

To simplify the import of your exported txt-file in Microsoft Excel, you can rename the extension of the
file to "csv" (e.g. report.csv).

1. Click the Export TXT button. Next you can download and open the TXT
document via Reports in the Navigation pane.

2. Click the Save As button. A Windows popup window appears to save the text
file to a destination folder.

3. From the Save in field, select the destination folder.

4. Enter the file name.

5. From the Save as type field, select Text File (*.txt).

6. Click the Save button and close the window.
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More information:

Reports
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How to edit circular cheque data Document
ID: 6120
Modified:
04/01/2013
Created:
03/05/2013
Version: 10

Steps:

To edit circular cheque data:

1. Select the Transactions tab.

2. Click Counterparties in the Navigation pane under Managing. The Manage
Counterparties window appears. 

3. Select the Counterparty you wish to modify and click in the Navigation pane under
Actions on Show counterparty details. 

4. Click Modify circular cheque data in the Navigation pane under Actions. The
Edit circular cheque data window appears. 

5. Edit the data of the Counterparty circular cheque. 

6. Click the Save button. The circular cheque data is modified and you return to the Edit
Counterparty window.

Using Isabel 6 - v6.26 - 6120 - How to edit circular cheque data 15/05/2013

230 / 283



Upload counterparties overview Document
ID: 7328
Modified:
03/05/2013
Created:
03/05/2013
Version: 21

Purpose:

Instead of manually creating counterparties, you can also upload counterparties from a file, e.g. exported files
from an accounting package using this step-by step wizard.

 How to access
Select Transactions tab > Managing menu > Counterparties > New menu > Upload of Counterparties

The wizard consists of the following steps:

Upload of counterparties: this step allows you to select the environment from which
you would like to import your counterparties.

Selection of the counterparties: this step allows you to make a personal
selection from the list of counterparties you have retrieved from a file.

Error detection: This step will verify if the selected counterparties are already present
in the existing list in Isabel 6 eBanking

 Note
Once you have uploaded your counterparties and you want to share the counterparties and manage
them, the module MultiSign is needed.

How can I...:

Upload counterparties from my accounting software?

More info:

Upload counterparties wizard:

Step 1: Upload of counterparties
Step 2: Selection of the counterparties
Step 3: Error detection
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Upload counterparties - upload (1/3) Document
ID: 1101
Modified:
06/05/2013
Created:
06/05/2013
Version: 50

Purpose:

During the first step of this wizard, you have to choose between different environments to upload the
counterparties (beneficiaries and debtors).

The Upload counterparties window consists of the following items which represent two possibilities (two
options) to upload (import) the counterparties:

Counterparties from Isabel Business Suite 5.0: choose this option when Isabel 6 is
installed on the same computer as Isabel Business Suite 5.0.

 
Counterparties from Isabel Business Suite 5.0 on another PC or from another
environment (e.g. accounting package): choose this option when Isabel 6 is NOT
installed on the same computer as Isabel Business Suite 5.0 or when you want to import
beneficiaries or debtors from another program. Use the  button to search and
select the counterparties file.

Next: proceed with the upload of the counterparties file. 

Cancel: cancel the upload of the counterparties file.

How can I...:

Upload counterparties from my accounting software?

More info:

Upload counterparties overview
Step 1: Upload of counterparties
Step 2: Selection of the counterparties
Step 3: Error detection
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Upload counterparties - select (2/3) Document
ID: 7327
Modified:
06/05/2013
Created:
06/05/2013
Version: /

Purpose:

In this window, you can select the counterparties you want to integrate in Isabel 6 and you can select whether
you want the counterparty to be shared or not.

If you need to modify the details of the counterparties afterwards, select the Transactions tab > Managing
menu > Counterparties.

The Selection of the counterparties window consists of the following sections:

Alias: the alias that was created for this counterparty (limited to 35 characters) 
Name and address: full name and full address of the counterparty
Account country: country of the account (mandatory)

Beneficiary: if the imported counterparty has an account number that can be used to
create a payment, it is indicated with the icon

Debtor: if the imported counterparty has a (Belgian) account number that can be used to
create direct debits, it is indicated with the icon

Shared: if the counterparty is shared, other users may be able to view, use or edit that
counterparty. For more information about Personal and Shared  counterparties,
please consult the related chapter. To toggle between making all the counterparties
shared or not shared (personal), select Actions menu > All shared/personal.

 Note
Sharing counterparties is only possible when the eBanking user has selected the
module MultiSign. If this module is not ordered, all imported counterparties will
automatically be saved as Personal.

Next: proceed with the upload of the counterparties file
Cancel: cancel the upload of the counterparties file

To select the counterparties in Isabel 6:

1. Select the counterparties you want to integrate. To toggle between selecting all the
counterparties or non, select the check box on top of the list.

2. Click the Next button to continue.
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How can I...:

Upload counterparties from my accounting software?

More info:

Upload counterparties overview
Step 1: Upload of counterparties
Step 2: Selection of the counterparties
Step 3: Error detection

Transaction Preferences
Personal and Shared Counterparties overview
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Upload counterparties - error detection (3/3) Document
ID: 7329
Modified:
06/05/2013
Created:
06/05/2013
Version: 17

Purpose:

The third step of this wizard will verify if name, alias, account number, direct debit number or info about circular
cheques is already present in the existing list of counterparties.

If no identical data is detected, click Finish to exit the wizard for uploading counterparties.

If identical data is detected, a list of counterparties will be shown in a table, containing 3 columns.
The counterparties can be sorted in ascending or descending order per column by clicking the column name.

The list consist of the following items:

Alias: the alias that was created for this counterparty.
Name and address: full name and full address of the counterparty.
Error report: a detailed description of the reason why this counterparty already exists.

Complete the upload wizard:

1. Select the counterparties from the list you still want to integrate. To toggle
between selecting all the counterparties or non, select the check box on top of the list.

2. Click on Finish to integrate the selected counterparties. In case you did not make any selection, you still
need to click Finish to exit the wizard.

How can I...:

Upload counterparties from my accounting software?

More info:

Upload counterparties overview
Step 1: Upload of counterparties
Step 2: Selection of the counterparties
Step 3: Error detection
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How to upload counterparties from my accounting software? Document
ID: 1176
Modified:
06/05/2013
Created:
06/05/2013
Version: 98

Prerequisite:

The Counterparty Converter Tool has to be installed on the same PC where your third party application is
installed.

This tool will allow you to easily collect all of the counterparties (beneficiaries and debtors) stored in your third
party application. Afterwards the counterparties are converted into SEPA compliant IBAN and BIC account
numbers. Only Belgian beneficiary account information will be converted.

Steps:

1. Extraction and conversion of the beneficiaries and/or debtors from your third party
application with the Counterparty Converter Tool.

Import BBAN accounts from the file I select:

The Counterparty Converter Tool can accept 3 different file formats from your third
party application (for example an accounting software), but only specific formats can
be used if you want to upload the result of the converted beneficiary data into Isabel 6.

For the correct layout of these files, we refer to the chapter Compatible files for
import of Counterparty data in the documentation of the Counterparty Converter
Tool.

2. Upload the XML file that contains the beneficiaries and/or debtorsinto Isabel 6.

1. Select the Transactions tab.

2. Click Counterparties in the Navigation pane under Managing. The
Managecounterparties window appears.

3. Click Upload of Counterparties in the Navigation pane under New. The
Upload of counterparties window appears (Step 1 of the Upload
counterparties wizard).

4. Select the option Counterparties from IBS 5.0 on another PC or from
another environment (e.g. accounting package).

5. Click the  button. As a result the Choose file window appears.

6. Go to the folder were you have stored the XML file that was previously generated
by the Counterparty Converter Tool and click the Open button. As a result you
return to the Upload of counterparties window.
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7. Click the Next button. The Selection of the counterparties window appears
(Step 2 of the Upload counterparties wizard).

8. Select the beneficiaries or debtors you wish to upload.

Tip
To toggle between selecting all the counterparties or none, select the check
box on top of the list.

9. To Share the counterparty with other users, select the corresponding check box.
Sharing counterparties is only possible when the eBanking user has selected the
module MultiSign. If this module is not ordered, all new counterparties will
automatically be saved as Personal.

Tip
To toggle between making all the counterparties shared or not shared
(personal), click Actions menu > All shared/personal.

10. Click the Next button. The upload of the beneficiaries and the debtors starts and
the Error detection window appears (Step 3 of the Upload counterparties
wizard). If no errors or identicals were found, the message All selected
counterparties have been successfully integrated will appear.

11. Click Finish to exit the wizard for uploading counterparties.

If identical data is detected, a list of counterparties will beshown in a table. Select
the counterparties from the list you still want to integrate by selecting the
corresponding check box(es) in front of them and click on Finish. In case you did
not make any selection, you still need to click Finish to exit the wizard.

More information:

Upload counterparties overview
Manual on the Counterparty Converter Tool
Download the Counterparty Converter Tool
Personal and Shared Counterparties
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Personal and Shared Counterparties overview Document
ID: 23323
Modified:
17/04/2013
Created:
17/04/2013
Version: 28

Answer:

Why make counterparty Personal or Shared?

If several users often use the same counterparties, a lot of time can be saved if one of the users creates the
counterparties and shares them with the others (Shared Counterparty). On the other hand, if a counterparty
will only be used by one particular user, this user can create a Personal Counterparty.

Who can make a Personal or Shared Counterparty?

In a subscription with only ONE USER: it is quite obvious that this user can only save a
counterparty as Personal (there is no one else to share the counterparty with).

In a subscription with SEVERAL USERS:

The eBanking user who has selected the module MultiSign has the possibility:

to make his counterparties Personal or Shared.
to change the counterparty sharing from Personal to Shared or vice versa. 

The eBanking user who has NOT selected the module MultiSign:

can only save a counterparty as Personal .
cannot change the counterparty sharing from Personal to Shared or vice versa.

The eBanking user who has selected the module Signing Modules cannot create,
view or edit a counterparty and thus cannot create a Personal or Shared
Counterparty.

What is the difference between a Personal Counterparty and a Shared Counterparty?

A Personal Counterparty can only be viewed, edited, deleted or used by one user. 

A Personal Counterparty is linked to the PKI contract (or Secure Signing Card) of that
user.

In case you work with different profiles, the Personal Counterparties are
accessible by all of your profiles.

 
A Shared counterparty can be viewed, edited or used by several users in the same
subscription.
When a user decides to share a counterparty, he has to select at least one
eBanking contract (see picture)

The Shared Counterparty will be visible to all the users that have at least one of the
selected eBanking contracts linked to their PKI contract (or Secure Signing Card).
These users will also be able to use this counterparty when creating a transaction or a
direct debit order. 
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A Shared Counterparty is linked to one or several eBanking contracts.

In case you work with different profiles: All users that work with profiles containing at
least one of the selected eBanking contracts, will be able to see and use
this counterparty.

When can you determine if a counterparty becomes Personal or Shared?

1. In case you manually create a new counterparty or when you edit an existing
counterparty:

In the section Counterparty sharing, you have the possibility to indicate if a
counterparty is Personal or Shared.

 Tip
You can choose to save the counterparty as Personal or Shared by default. To do
so, go to the Preferences menu-item > Select the Transactions tab in the Manage
User Preferences screen > Save new counterparty by default as (the default
value is Personal).

  

2. In case you create a transaction or a direct debit order. When creating a transaction or
a direct debit order, one has the possibility to save a new beneficiary or a new debtor.
The counterparty will be saved as Personal or as Shared depending on the situation:

In case the eBanking user has selected the module MultiSign, the application will
save the new counterparty based on the preferences. By default, all new
counterparties (beneficiaries or debtors) will be saved as personal. To change this
preference, go to the Preferences menu-item > Select the Transactions tab in
the Manage User Preferences screen > Save new counterparty by default as
and select Shared.

In case the eBanking user has NOT selected the module MultiSign or in case of a
subscription with only one user, the new counterparty (beneficiary or debtor) will be
saved as Personal .

3. In case you upload counterparties. When you upload a counterparty, the counterparty
will be saved as personal or as shared depending on the situation:

In case the eBanking user has selected the module MultiSign, he will have the choice
between saving each counterparty as Personal or as
Shared. By default*, all counterparties will be indicated as Personal. You can use an
option in the menu to switch between Shared or Personal (for all the counterparties at
once), or you can change this attribute for each individual counterparty.

(*) To change the default value, go to the Preferences menu-item > Select
the Transactions tab in the Manage User Preferences screen > Save new
counterparty by default as and select Shared.

In case the eBanking user has NOT selected the module MultiSign or in case of a
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subscription with only one user, the counterparty will be imported as Personal.
 Example

A subscription has 4 users and 3 eBanking contracts (bank A, B and C). 
User1 is the only one with the authority to share counterparties and he has the 3 eBanking contracts linked to
his PKI contract.
User2 has eBanking contracts A and B linked to his PKI contract.
User3 has eBanking contracts B and C linked to his PKI contract.
User4 can only sign.

User1 makes a counterparty shared for eBanking contract A and B:

Both User2 and User3 will be able to view and edit the counterparty.
User2 and User3 will also be able to use this counterparty for every transaction they insert.
User4 can not view or edit counterparties. 
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How to share all counterparties? Document
ID: 38243
Modified:
06/05/2013
Created:
06/05/2013
Version: 6

Prerequisite:

You can either import counterparties from your old eBanking application IBS5 (Isabel Business Suite 5) or
create your counterparties within the eBanking application.

The purpose of the Share all counterparties functionality is to allow you to share all your counterparties with all
active eBanking Contracts on which you have access within an active profile. This functionality can be
performed:

During upload or creation (in one of the input wizards) of the counterparties; or
Each time you want (for example when a new active eBanking contract is available within
an active profile).

 Notes

You have to subscribe to the Multisign module to use the Share all counterparties
functionality. 

During counterparty upload or creation; the new counterparty is  Shared or Personal
according to the default setting in the Preferences.

Steps:

To “Share all counterparties”:

1. Go to Transactions > Managing - Counterparties > Actions - Share all
counterparties

2. After clicking the Share all counterparties action, a confirmation popup appears.

Refuse or accept to share the existing personal counterparties in the confirmation
popup with one of the following buttons:
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Share all button (share personal and shared); or
Share only the already shared button (no additional sharing of personal
counterparties, button is only available when personal counterparties exist); or
Cancel button (to undo all)

More information:

Personal and shared counterparties
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Creditor management overview Document
ID: 5438
Modified:
06/05/2013
Created:
06/05/2013
Version: 13

Purpose:

In this window you have an overview of all creditor numbers and the assigned account
numbers.

 How to access
Select Transactions tab > Managing menu > Creditors

The Creditor management window contains the following items:

Creditor number: the column with the creditor numbers. This creditor number,
allocated by your bank, identifies you as a counterparty of the direct debit order
agreement that the debtor has entered with the bank.

Account number: the column with the account numbers, assigned to the creditor
number in the first column.

 Note
In case no accounts are available for the creditor, please contact the concerned bank.

How can I...:

Create a new creditor?
Delete one or more creditors?
Modify a creditor?

More info:

The navigation pane

New
Creditor 
Actions
Delete creditor(s)
Modify creditor 
Managing
Counterparties
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How to create a debtor direct debit order number? Document
ID: 6116
Modified:
04/01/2013
Created:
06/05/2013
Version: 8

Steps:

To create a direct debit order number:

1. Click the Transactions tab.

2. Click Counterparties in the Navigation pane under Managing. The window to
select a counterparty appears. 

3. Select a counterparty.

4. Click on the button Add in the section Debtor direct debit order numbers. 

5. Fill in the data of the debtor direct debit order number. 

6. Click the Save button to finish.
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How to create a new creditor? Document
ID: 5439
Modified:
06/05/2013
Created:
06/05/2013
Version: 9

Steps:

To create a new creditor:

1. Select Transactions tab.

2. Click Creditors in the Navigation pane, under Managing. The Creditor
management window appears.

3. Click Creditor in the Navigation pane, under New. The popup window Add new
creditor appears.

4. Fill in the creditor number and select one or more account numbers.

5. Click the Add button. The creditor appears in the list of creditors.

 Note
In case no accounts are available for the creditor, please contact the concerned bank.

How can I...:

Delete one or more creditors?
Modify a creditor?

More information:

Creditor management overview
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How to modify a creditor? Document
ID: 5440
Modified:
06/05/2013
Created:
06/05/2013
Version: 9

Steps:

To modify a creditor:

1. Select the Transactions tab. 

2. Click Creditors in the Navigation pane, under Managing. The Manage creditors
window appears. 

3. Select the creditor number, you wish to modify.

4. Click Modify creditor in the Navigation pane, under Actions. The popup window
Modify creditor appears. 

5. Select or clear the check boxes in front of the account numbers. 

6. Click the Change button. The creditor number is modified and you return to the
Manage creditors window.

How can I...:

Create a new creditor?
Delete one or more creditors?
Modify a creditor?

More information:

Creditor management overview
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How to delete a creditor? Document
ID: 5441
Modified:
06/05/2013
Created:
06/05/2013
Version: 9

Steps:

To delete one or more creditors:

1. Select the Transactions tab. 

2. Click Creditors in the Navigation pane, under Managing. The Manage creditors
window appears. 

3. Select the creditor number(s). 

4. Click Delete creditor(s) in the Navigation pane, under Actions. The  popup window
Confirmation appears. 

5. Click Yes to delete the selected creditor number(s). You return to the list of remaining
creditor numbers.

How can I...:

Create a new creditor?
Modify a creditor?

More information:

Creditor management overview
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Sent Transactions overview Document
ID: 1094
Modified:
06/05/2013
Created:
06/05/2013
Version: 69

Purpose:

The Sent Transactions window displays the list of the transactions that have been sent to
the bank. In this list you can easily follow the status of each transaction.

The overview of sent transactions is shown in a table, containing 9 columns:

 : check boxes to select one, more or all transactions. In the Navigation pane under
Actions, you can see the authorised actions and the selected transaction(s) that are
applicable for you.
:  icon that indicates that this transaction is an urgent transaction.

Action: the icon in this column indicates the status of the transaction.

Icon Status
Sent: The transaction has been sent but its receipt
has not yet been confirmed.
Not Delivered: The transaction has not reached the
bank.
The transaction has been sent and its receipt has
been confirmed. Your transaction is being verified
by the bank.
Your transaction is being carried out. You have
received a positive confirmation message from your
bank.

Your transaction will not be carried out. You have received
a negative confirmation message from your bank.

Description: the description of the transaction. The name depends on how the
transaction was created.
Nbr.: the number of transactions in a group transaction.
Total: the total amount of the transaction.
Bank: the bank where to the transaction was sent.
Memo date: the date on which the transaction should be executed.
Date sent: the date on which the transaction was sent (<> the last update date). 

 Tip

The transactions can be sorted ascending or descending by clicking  next to the title of each column.
 
When the content does not fit into the Display zone, it will be divided into several pages. The buttons on the
left and the right of the page indicator (Page 1 of 1 in the example) allow you to browse through the content.

 Tip
   The following values are available in the Filter dropdown list:
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All recent transactions: default filter, transactions from the last x days (x value is bank
dependent and configured by Isabel). This means the user sees for example the files of
the last 7 days (not the files of the last 24x7 hours). 

 Note
The "recent" transactions filters are more performant (faster display).

My recent transactions
All transactions
My transactions

 Note
All sent transactions that are older than 3 months are removed from the Sent
Transactions window on a daily basis.

How can I...:

Verify the status of a transaction?
Manually delete sent transactions?

More info:

Sent transactions auto cleanup
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How can I verify the status of a transaction? Document
ID: 4101
Modified:
06/05/2013
Created:
06/05/2013
Version: 37

Steps:

To know if a transaction is sent, delivered or carried out:

Go to the Sent Transactions tab.

In front of each transaction, you can see an icon that indicates the status. Consult the
table below to find out what that status means or place your mouse pointer on top of the
icon in the list of your sent transactions.

Sent: the transaction has been sent but its receipt has not yet been confirmed.

This is the very first status that is attributed to your sent transaction. Wait a few minutes
to see the next status.

Not Delivered: the transaction has not reached the bank.

At this point, this transaction is stored on the Isabel server and there will be no attempt to
resend it to the bank. You will have to recreate the transaction and send it again.

The transaction has been sent and its receipt has been confirmed. Your transaction is
being verified by the bank. For the time being your transaction has not yet been carried out.

Wait a few minutes and check the status of the sent transaction again.

The following status should be or .

Please conctact the concerned bank(s) for more information.

  Your transaction is being carried out. You have received a positive confirmation message
from your bank.

Click the concerned sent transaction if you want to see the positive confirmation message.
Look at the Notification field on top of the Display zone.

If you want to want to know when your payment will be booked, please contact the concerned
bank(s).

Your transaction will not be carried out. You have received a negative confirmation message
from your bank.

Click the concerned sent transaction to see the negative confirmation message. Look at the
field Notification field on top of the Display zone.

Please conctact the concerned bank(s) for more information.

More information:

Sent Transactions overview
Sent transaction remains in Sent status
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How to manually delete sent transactions? Document
ID: 26012
Modified:
06/05/2013
Created:
06/05/2013
Version: 18

Steps:

To delete one or more sent transactions:

1. Select the Sent Transactions tab.

2. Select the transaction(s) you wish to delete.

3. Click Delete in the Navigation pane under Actions.

The Confirmation popup window appears. 

4. Click the Yes button.

The updated overview of sent transactions appears.

 Note
To toggle between selecting all the sent transactions or none, select the checkbox at the top of the list. This
selection only concerns to the transactions at that time visible. Nothing happens to the sent transactions on
the other pages.

How can I...:

More information:

Sent transactions auto cleanup
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How to print or export sent transactions? Document
ID: 34659
Modified:
06/05/2013
Created:
06/05/2013
Version: 3

Prerequisite:

Isabel 6 eBanking allows you to print or export overviews, details or summaries of the available sent transaction
data.

When selecting the print functionality, you can choose between printing to a PDF document or exporting to a
text file. The PDF document can be printed or saved. The text file is often used to export the data to another
program.

Steps:

1. Select the Sent Transactions tab.

2. Select one or more sent transactions you want to show (and print).

3. Click Print under Actions in the Navigation Pane.

As a result the Print Options popup window appears.

Available Print options:
 

Overview of (selected) files
Details of (selected):
 

Status
Summary of the transactions
Processing options
Sign info
Audit trail

Summary of (selected) files

4. Print or export sent transactions: 

Show (and print) PDF document:

 Note
A PDF writer is not required to create the PDF file, this function is included in
Isabel 6 eBanking. However you need Adobe Reader to view the PDF file.

1. Click the Show PDF button. Next you can download and open the PDF
document via Reports in the Navigation pane.

2. Click the Print button in the toolbar of Adobe Reader. The overview, the
details or the summary will be printed.

 Tip
It is possible to save the PDF document to your hard disk by clicking the
Save a Copy button in the toolbar.

3. Close the window with the PDF document.
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Export to a text file:
 Tip

The default text separator is ';'.

To modify the text separator:

Select the Transactions tab > Managing menu > Preferences menu-item.

Select General from the Manage user preferences overview and enter the
text separator in the field When exporting as txt-file, separate with.

 Tip
To simplify the import of your exported txt-file in Microsoft Excel, you can rename the extension of
the file to "csv" (e.g. report.csv).

1. Click the Export TXT button. Next you can download and open the TXT
document via Reports in the Navigation pane.

2. Click the Save As button. A Windows popup window appears to save the text
file to a destination folder.

3. From the Save in field, select the destination folder.

4. Enter the file name.

5. From the Save as type field, select Text File (*.txt).

6. Click the Save button and close the window. 

More information:

Reports
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Sent Transactions Details Document
ID: 4197
Modified:
06/05/2013
Created:
06/05/2013
Version: 24

Purpose:

In the overview of sent transactions, not all information of a transaction is displayed. You
can view all information by opening the details of a transaction.

 How to access

Select Sent Transactions tab > Click the name of the transaction; or
Select Sent Transactions tab > Select a transaction > Actions menu > Transaction
details

The sent transaction details consist of the following items:

In the upper section you find feedback on the sent transaction. The information shows whether a transaction has
been successfully submitted or not.

Payments group: 

 

1. Group properties:

1. Payment group: the name of the group of transactions.

2. Transaction type: the type of transaction (domestic, foreign, ...).

3. Global/single debit:

Global debit: global debit is activated, the total amount is shown on your
account statements.
Single debit: global debit is deactivated, every order is entered as a
separate transaction on your account statements.

4. File reference: a reference which may be useful for your internal accounting.

5. Transaction reference: the reference of the transaction, assigned by Isabel.

6. Creation date/time: date and time on which the file is uploaded.

7. eBanking contract: the eBanking contract, used for the transaction.

8. Contract bank: the bank to whom the transaction will be sent.

2. Contents:

Ordering party account: principal account, used in the transaction.
Beneficiary account: the account number of the beneficiary.
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Beneficiary name: the name of the beneficiary as it will appear on your account
statement.
Memo date: the date on which the transaction should be carried out or on which
the amount should be transferred to the beneficiary account.

 Note
The meaning of the memo date can vary depending on the principal account's
bank. Contact the principal account's bank to get information on how the bank
handles transactions with a memo date.

Amount: the amount to be transferred.
Message to beneficiary: a message for the beneficiary.
Number of transactions:  the number of transactions included in the group of the
uploaded file.
Total: the total amount of all transactions. This amount stands on your bank
statements as overall debit is integrated.

Single payment:

1. Content:

1. Ordering party account: principal account, used in the transaction.

2. Beneficiary name: the name of the beneficiary as it will appear on your account
statement.

3. Beneficiary address: the address of the beneficiary.

4. Beneficiary account: the account number of the beneficiary.

5. Amount: the amount to be transferred.

6. Memo date: the date on which the transaction should be carried out or on which
the amount should be transferred to the beneficiary account.

7. Message to beneficiary: a message for the beneficiary. 

8. User reference: internal reference for this transaction that for instance can be
used for your accountancy software.

9. Transaction type: the type of transaction (salary, ordinary, ...), available only for
domestic transactions.

10. Payment type: normal or cheque.

11. Foreign payment method code: the code to indicate who carries the payment
costs (principal, beneficiary or shared), only available for international
transactions.

12. Transaction charges: the code to indicate who carries the payment costs
(principal, beneficiary or shared), available only for international transactions.

13. Beneficiary bank BIC: the Bank Identification Code of the beneficiary's bank,
available only for international transactions.
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14. Urgency code: the urgency code of the transaction (urgent transaction or normal
transaction, no urgency).

15. Transaction reference: the reference of the transaction, assigned by Isabel.

16. Creation date/time: date and time on which the file is uploaded.

17. eBanking contract: the eBanking contract, used for the transaction.

18. Contract bank: the bank to whom the transaction will be sent.

2. Sign info:

1. Nr of required signatures: indicates how many signatures are required for a
sufficiently signed transaction.

This detail is visible only for:

non account-based contracts (e.g. for social secretariat); or
cheques (uploaded or manually created); or
uploaded DIV-files

2. Signer name: the name of the signer

3. Signer date: the date of signature

3. Audit trail history: the button to view the history of the transaction.

4. Close: the button to close the details of the transaction

How can I...:

Hide the account info details of one of my payments?
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Reports Document
ID: 38211
Modified:
16/04/2013
Created:
16/04/2013
Version: 1

A queue is used for reports (with a high number of transactions) created in the Account Info and the (Sent)
Transactions area.

This solution however is not limitless but offers, for one report, up to 3000 transactions.

Although the feature reduces peak load & avoids system crashes due to heavy queries, many requests for
reports (especially in Account Info) are launched during the peak hours (between 8-10am) which increases
waiting time.

Tip
By scheduling certain reports, you do not have to wait for the report to be generated when you need it.

Queues & timing:

Overview of queues:

Fast queue for:

Small reports

 Examples
Print screen like reports of:

Exchange rates
Transaction detail reports in Account Info area

Intraday statements
Urgent payments

Medium queue for medium sized reports
Slow queue for large reports

Some reports are dynamically assigned to a queue depending on the data volume.
The timings depend on the load per queue.

Some reports are processed with priority (advanced in the queue):

The report contains either intraday or future information
Transactions bearing the “urgent” flag
Results of a search

Reports:
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Reports overview button (1): is available on top of to the Navigation pane, this
button enables you to access the Reports popup window. It contains a number which
represents the number of reports that are not yet viewed.

Reports popup window (2):

All generated reports are available on a single interface. This interface contains
both the launched & completed reports.

The generated report remains available for 5 days.

Tip
As a result, we advise you to download your reports on a regular basis.

Overview:

A table that contains all launched & completed reports with the following
columns:

Checkbox: you can multiselect reports to delete, to download and to plan
several completed reports at one time.

Description: single clicking the report description opens the report details.
These details are displayed with an extra line in case of reports that can be
scheduled. A  checkmark is used to identify the scheduled reports.

Format:

The  icon for a pdf file.
The  icon for a text file.

The Date and the hour when the report is generated.

Scheduled:

Yes: scheduled report
No: unscheduled report

Status:
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In Progress
Available, this status also contains a link to the report.
Already Downloaded, this status also contains a link to the report.

Navigation buttons (4): in analogy with the other windows in the application.

Buttons (5):

Schedule/Unschedule: enables you to schedule/unschedule selected
reports. The button is only available for booked statements based on
relative dates (yesterday, this week …) instead of on absolute dates
(dd/mm/yyyy).

Scheduled reports can only be stopped by clicking the Unschedule button.

?: mouseover button with the message “Scheduled reports are
generated each working day at 8 AM. Schedule this report to have it
generated every weekday morning.”

Delete: deletes the selected reports.

Download: the selected reports (with status Available or Downloaded)
are downloaded simultaneously. The downloaded reports are saved in a zip
file with a time indicator in the filename.

Close: closes the Reports popup window.

Notification toaster (at the bottom right):

When you start a print assignment:

1. A notification toaster appears "Report requested. The report ... has
been requested".

2. A notification toaster appears:

In case of one report:
"Report requested"
"One new report is available"

"Download it now" link
"Open the Reports area" link

In case of multiple reports:
"Reports requested"
"New reports are available"

"Open the Reports area" link

 Note
If you log off after requesting a report, but before the report
is ready then the application continous the report upon you
next login.

Report types:
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Account info reports:

Booked statement(s) (full)
Booked statement(s) (condensed)
Intraday (full)
Intraday (condensed)
Future statement(s) (full)
Balance overview (both for last overview & period overview)
Selected transaction(s)

(Sent) Transactions area reports:

Overview of (selected) files
Details of (selected) files
Summary of (selected) files
Overview of (selected) counterparties
Details of (selected) counterparties

Other:

Exchange rates

Quick print (9):

Enables you to make a print screen report:

Not in pdf format but in browser format
Of business relevant data (proof of payment)
Always in English.

The “Quick print” button is added to two screens:

Transaction area > Transaction detail
Account Info area > Statement/period view > Transaction detail

Only shown on the detail screen of manually entered single transactions.

The generated report is exactly the same as the “selected transactions” report.
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The quick print report contains:

Header:

Amount: shows the amount and the transaction currency
Communication: shows the structured or unstructured reference
Payment method: shows the transaction type 
Execution date: memo date or execution date, if any

Ordering party:

BIC/bank name, depending on which is available in the transaction.
Account number

Counterparty: same fields as with ordering party

Processing: contains all relevant data for the counterparty

Message to the intermediary bank (can be multiple lines)
Intermediary bank BIC
End to end identifier
Charges

Bottom: the following lines are added

“Not send to the bank” or the notification message
“This overview does not constitute a legal proof of payment”
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Preferences overview Document
ID: 694
Modified:
08/05/2013
Created:
08/05/2013
Version: 26

Purpose:

Isabel 6 eBanking is built in such a way that a user can define the preferences adapted to his/her needs.

 Note
The preferences are defined in the different tabs (General, Account info, Transactions and Sent
transactions) only apply to the user that is logged on.

There are four different tabs available:

General: preferences on the general use of Isabel 6 eBanking. 
Account info: preferences to customise the layout of the Accounts overview.
Transactions: preferences to customise the layout of the Transactions overview.
Sent transactions: preferences to customise the layout of the Sent Transactions
overview.

More info:

Video about Preferences
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General preferences Document
ID: 689
Modified:
06/05/2013
Created:
06/05/2013
Version: 38

Purpose:

In this window you can define preferences for the general use of Isabel Banking.
 How to access

Preferences menu-item > Select the General tab (in the Manage user preferences window)

The General tab consists of the following sections:

Language: the dropdown list to select the user interface language of the eBanking
application. The possible languages are English, Dutch, French and German.
Local formatting: the dropdown list to select a country and its local formats, such as
decimals and date.
The e-mail address : selection to indicate that you want to receive information by e-
mail, e.g. you are invited to sign a transaction. The second field is to fill in the e-mail
address on which you wish to be notified.
Default start-up folder: in this the dropdown list you can select which tab sheet you
wish to see when you start the Isabel 6 application. By default the Account Info tab is
shown. You can also choose Transactions or Sent Transactions.
When exporting as txt-file, separate with: select a text separator you wish to use
when you export data to a text file. The default text separator is ";".

Save: the button to save the general preferences. The changes will only come into
effect after a new logon.
Cancel: the button to discard the changes.

More info:

Preferences:

General
Account info
Transactions
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Sent transactions
Video about Preferences
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Account Info preferences Document
ID: 690
Modified:
06/05/2013
Created:
06/05/2013
Version: 43

Purpose:

In this window you can define preferences for your accounts.

 How to access
Preferences menu item > Select the Account Info tab (in the Manage user preferences window)

The Account Info tab contains the following items:

Default Filter: selected filter on the Account Info tab when starting up the application.

Number of accounts to be displayed per page: to define the number of accounts
displayed per page.

Default view of account information: two different views for your account information
exist.

View account info. per period: each transaction shown separately for the past
week.
View account info. per statement: group transactions by statement. A statement
may include more than one transaction.
Displaying information by period may be a good option if you only have a few
transactions, while displaying by statement may be better if you have lots of
transactions. By default, the View account info. per statement is shown.

View aliases instead of account holder names: when selected, accounts in the
Account Info tab are presented with their aliases instead of their names. 

Merge download reporting files:

When selected: selected report files of the same type will be downloaded as one
file.
When not selected: selected report files will be downloaded as separate files.
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Timezone for "Request for Reporting" task scheduling/tracking: enables you to
select the timezone that applies to your current location.

 Note
To avoid timing issues, you are requested to enter your timezone when you enter the
Request for Reporting window. If the timezone of your current location is not
yet entered in the Preferences a popup alert appears.

Save: the button to save the account preferences. You have to login another time before
the changes come into effect. 

Cancel: the button to discard the changes.

More info:

Preferences:

General
Account info
Transactions
Sent transactions

Video about Preferences

Related articles:

Account information per period
Account information per statement
Profile management
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Transaction preferences Document
ID: 692
Modified:
06/05/2013
Created:
06/05/2013
Version: 42

Purpose:

In this window you can define preferences for your transactions.
 How to access

Preferences menu-item > Select the Transactions tab (in the Manage User Preferences screen)

The Transactions tab contains the following sections:

Default Filter: selected filter on the Transactions tab when starting up the application.

Default country for new counterparties: a dropdown list to select the country that will
be automatically selected when you create a new counterparty. If you don't select a
country, Belgium is the default country.

Default currency for encoding transactions: a dropdown list to select the currency
that will be automatically selected when you enter a transaction.

Save new counterparty by default as: a dropdown list to select the sort of
counterparty that will be automatically selected when you create or import a counterparty
(Personal as default, Shared as second option).

When creating new transactions, the default standard for sharing with other
users who have no signing, controlling or releasing rights is: a dropdown list to
select what the default standard for sharing with other users is (Private as default,
Shared as second option).

Viewing hash in detail of transactions and in the signing screen: the hash code
can be generated by your accounting software and is used to prove that a file has not
been altered between the moment it is created in your accounting package and the
moment it is signed and send to the bank. For more information read "How to generate
and show the hash code for uploaded payment files?"

Using Isabel 6 - v6.26 - 692 - Transaction preferences 15/05/2013

267 / 283

https://www.isabel.eu/en/forbusiness/support6/websupport/direct.html?id=44040


 
1. Always show hash code.
2. Show hash if delivered via Isabel Go or Corporate Synchronizer.
3. Never show hash code.

Treatment of uploaded file after successful upload (even if file is not correct): 

No treatment: this is the default behaviour for the treatment of uploaded files after
successful upload (even if the file is not correct).
Delete the file: after successful upload the original file will be deleted.
Rename the file: after successful upload, the original file will be renamed. The file
extension will be changed to 'SAV' and the date and the time will be added in front of
the original file name (e.g. yyyymmdd_hhmm_original filename.SAV).

Default cost accounts: option to define default cost account(s) for non SEPA
payments that can be used in the Payment and "Group of payments" transaction
wizards.

 Note
Contact your bank to verify if a different account then the ordering account is
supported.

Processing options: 

1. Always sign immediately: option to choose whether or not transactions are
always signed immediately.

2. Always send automatically: option to choose whether or not transactions are
always sent immediately.

 Important
The options "Always sign immediately" and "Always send automatically" are not automatically
taken into account when creating domestic payments and SEPA payments.

Save: the button to save the transaction preferences.
Cancel: the button to discard the changes.

How can I...:

Generate and show the hash code for uploaded payment files?

More info:

Preferences:

General
Account info
Transactions
Sent transactions

Video about Preferences

Related articles:

Manage your contract profiles
The options "Always sign immediately" and "Always send automatically" are not
automatically taken into account when creating domestic payments and SEPA
payments.
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Supported banking file formats Document
ID: 32541
Modified:
08/05/2013
Created:
14/05/2013
Version: 25

Isabel 6 supports the following upload formats:

 Format Creation Remarks

XML CT (XML ISO20022) SEPA &
Non-SEPA Pain 001.001.02

x Credit transfer XML with validation
on Belgian Implementation
guidelines

XML CT (XML ISO20022) SEPA &
Non-SEPA Pain 001.001.03

x Credit transfer XML with validation
on Belgian Implementation
guidelines

XML DD (XML ISO20022) SEPA
Pain 008.001.01

x Both Core & B2B SEPA Direct
Debit are allowed

XML DD (XML ISO20022) SEPA
Pain 008.001.02

x Both Core & B2B SEPA Direct
Debit are allowed

SDD Reversals Pain 007.001.02  Standard Reversals

CIRI-FBF 128 x Belgian Domestic Payment

CIRI-FBF 360  Belgian Domestic Payment

CIRI-VME 128 x Belgian Foreign Payment,
supported: v3.0 and 3.1

CIRI-VME 1440  Validation rules are similar to those
of VME 128, supported: v3.0

CIRI-DOM80 128 x Belgian Direct Debit

CIRI-DOM80 180  Belgian Direct Debit

CIRI-RCA 128 x Belgian Cheque

CIRI-RCA 180  Validation rules are similar to those
of RCA 128, supported: v3.0

CIRI-DIV-files  Formats unknown to Isabel 6 but
identifiable by the banks

(*) The DIV file format is a bank specific format. It allows the bank to define formats that are already treated by
its processing applications, but not yet supported by the Isabel 6 environment.

 Note
Before uploading a file in DIV file format (e.g. DOM 70), we advise you to take contact with your bank to find
out if they support the format of that file. 

Isabel 6 supports the following download formats:

Format Remarks

CODA (old
versions)

Downloadable Reporting format

CODA 2.1 Downloadable Reporting format

CODA 2.2 Downloadable Reporting format

CODA 2.3 Downloadable Reporting format

MT 940 Account Statements & download

MT 941 Account Statements & download

MT 942 Account Statements & download

DIV-files Banks can decide to sent DIV-files (e.g. MANDATE files of the National
Bank of Belgium for SEPA Direct Debit)

More info:

The implementation guidelines can be found on the Febelfin website:
Febelfin: betalen in praktijk
Febelfin: Les paiements en pratique
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About Zoomit Document
ID: 30355
Modified:
25/03/2013
Created:
25/03/2013
Version: 8

Purpose:

Zoomit is an integrated eBusiness tool of Isabel 6 which allows you to more easily manage your eBusiness
documents.

Zoomit acts like a mailbox collecting digital documents issued by many companies. In other words, Zoomit
manages two streams of information, the collection of electronic documents and the payment of electronic
invoices.

How can I...:

Allow that documents are displayed?
Retrieve, consult and download allowed documents?
Pay received invoices?

More info:

What is possible with Zoomit?
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What is possible with Zoomit? Document
ID: 30357
Modified:
26/03/2013
Created:
26/03/2013
Version: 16

Purpose:

Receive the following types of electronic documents:

Invoice with pending payments
Domiciliation
Salary slip
Invoice reimbursement
Domiciliation reimbursement
Salary reimbursement

View and/or Download documents in different formats mode available by the sender:

Mostly (signed) PDF
Finvoice
CSV, BMF100, XML
Text file
...

"Manually" pay invoices (SEPA transfers) in Isabel 6 that are received Zoomit.
Currently there are in Isabel 6 no Zoomit documents available but there is a link to
Zoomit on the Isabel 6 “Welcome page”.

The documents can be classified according to the level of confidentiality:

Document with the confidentiality type “Standard”: business document sent only to a
company (Unique Enterprise Number) having an Isabel 6 subscription.

 Examples

Invoice from the electricity provider
Invoice from a leasing company
Invoice for the purchase of office equipment
...

Document with the confidentiality type “Sensitive”: sensitive document sent to a
company (Unique Enterprise Number) having an Isabel 6 subscription and a bank
account number (PC Banking). Therefore, the document is available in two
environments.

 Example

Invoice for the payment of wages
...

Document with the confidentiality type “Non Sensitive”: non-sensitive document sent to a
company (Unique Enterprise Number) having an Isabel 6 subscription and a bank
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account number (PC Banking). Therefore, the document is available in two
environments.

How can I...:

Allow that documents are displayed?
Retrieve, consult and download allowed documents?
Pay received invoices?

More info:

About Zoomit
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How to allow that documents are displayed? Document
ID: 30375
Modified:
05/04/2013
Created:
05/04/2013
Version: 23

Prerequisite:

The registration to Zoomit commonly called Opt-in is your acceptance to receive electronic documents of a
specific sender.

Steps:

Click on the  button on the “Welcome page” of the Isabel 6 eBanking application to open a Zoomit
session in a new window.

One of the following scenarios is presented to you when you arrive in the Zoomit application:

The default Opt-in: will be requested only "once" to you for each unique Sender and
each customer ID that you have at a company.

 Note
In reality it is often the case that someone has different client IDs at a company
(where he/she is a client) because he/she has more than one product/service from
that company.

Your first Opt-in is accompanied by a wizard who helps you to follow the scenario. In
step 1 of the wizard you will be required to enter your e-mail address to (this is used for
notifications).

For a document with standard confidentiality: an invoice or salary slip in a B2B
(Bussines to Bussines) context

If you are identified as the addressee of the document, i.e. your name, first name
and UEN (Unique Enterprise Number) correspond to those in the Isabel 6
eBanking application:

To add a new Sender to your list of senders:

1. Select the Sender in the left column. The "Documents information"
option and the underlying options appear automatically.

 Note
You can click optionally on the "Adressing details" option in order to
learn more about the Sender (telephone number, e-mail address ...).

2. Select the Agreement option and click the Accept button. As from then
you receive the documents from this Sender only electronically through
Zoomit (no more paper version).
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3. Optionally, consult the "Users registered  for this sender" to:

Change the "Access granted": as addressee you can decide to
share the access to the documents with other users (=mandatories).

 Notes
If the first opt-in is performed by a mandatory, he/she cannot
grant mandates. 
Afterwards when the addressee wants to view the documents;
the addressee must perform a second opt-in and has to define
the mandates.

Refuse the sender (the displayed documents of the sender will be
removed)
Manage documents

If you aren't identified as the addressee of the document, i.e. your name, first
name and UEN don't correspond to those in the Isabel 6 eBanking application:

To add a new Sender to your list of senders:

1. Select the Sender in the left column. The "Documents information"
option and the underlying options appear automatically.

 Note
You can click optionally on the "Adressing details" option in order to
learn more about the Sender (telephone number, e-mail address ...).
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2. Select the Agreement option and click the Accept button.

3. Enter the "Zoomit activation code" (an alpha-numeric code provided by
the sender on the last paper version of the document). As from then you
receive the documents from this Sender only electronically through
Zoomit (no more paper version).

 Note
If you receive documents with the "Zoomit activation code", you
cannot share the access of documents with mandatories.

For a non sensitive confidential document: an invoice in a B2B context

Follow the same steps as described above for a document with standard
confidentiality. There is no check of your UEN during your identification.

For a sensitive confidential document: an invoice in a B2B context

Follow the same steps as described above for a document with standard
confidentiality:

There is no check of your UEN during your identification.
However, If you are not identified as the addressee of the document, you
cannot add the new Sender to your list of senders and you will not have
access to the document.

Zoomit for all: you already agreed to use Zoomit at the time of the contract signing.

 Example
The consultation of your Isabel 6 invoices is a typical example of this. If you don't
receive your Isabel 6 invoices in Zoomit then please contact the Isabel Help Desk. 

If you are identified as the addressee of the document, i.e. your name, first name and
UEN correspond to those in the Isabel 6 eBanking application; then you will
automatically receive the documents of this Sender in Zoomit

As described above with a document with standard confidentiality, as addressee you
can decide to share the access to the documents with so called mandatories.

How can I...:

Retrieve, consult and download allowed documents?
Pay received invoices?

More information:

About Zoomit
What is possible with Zoomit?
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How to retrieve, consult and download documents? Document
ID: 30367
Modified:
28/03/2013
Created:
28/03/2013
Version: 30

Steps:

Click on the  button on the “Welcome page” of the Isabel 6 eBanking application to open a Zoomit
session in a new window.

To retrieve, consult and download documents:  

1. Click in the "Navigation bar" on “Documents: Invoices” or “Documents: Pay
slips”.

As a result, a list of documents of all the accepted senders appears in the display area
on the left side. More details and actions of the currently selected item in the list
appears on the right side . Documents not yet consulted are in bold.
 

 Notes

The “Navigation bar” (or the main Zoomit menu) contains the following items:

Senders: all document senders, already registered or not.
Documents: Invoices/Pay slips: all available documents, previously visited
or not.
Settings: your personal settings for e-mail notification.

The “Display Zone” contains a table with:

In the left column a list of documents with:
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The possibility to sort by Sender and Date.
The possibility to show more or less detail.

Next items per Sender:

The name of the sender who sent the electronic document.
The title of the document as provided by the sender (only in the more
detailed view). 
The "Document date".
The total "Amount" of the document (if applicable and only in the more
detailed view).

In the right column:

Actions for the selected document:

Download button
View button
Pay button (only with invoices): when clicked a popup window is
displayed that refers to Isabel 6 to perform the payment manually.
"Modify payment status" link (only with invoices): offers the ability to
manually adjust the payment status (see also "Pay Status"), to add a
comment (which is not shared by the sender) and to Save. 

More details of the selected document:

Repetition of the same items that appear in the detailed view of the left
column.
Bank account
Due date (only with invoices)
Downloaded status

Payment status (only with invoices):

Paid elsewhere:

Either the sender has initiated the payment (e.g. direct debit or
payment in your favour). 
Either you have made a payment to the bank.
Either you have changed the status manually. 

In most cases, this is the final status in Zoomit. Ideally the final
status of a payment made, should be Paid. This status can be
initialised by the bank or sender. At the moment however not all
banks and senders have implemented this status update in
Zoomit. 
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Paid: the bank or the sender has confirmed that the invoice is paid.
Refuse payment: you refuse manually to pay (mark manually).
Unpaid: invoice for which payment has not been registrated yet in
Zoomit (can be manually marked).
Cancelled: the sender indicates that the payment is not applicable
anymore.
  

2. Select a document in the document list and click the View button. A preview of the
document is then displayed in an adapted window. Previously mentioned actions are
also available here.

3. If you wish; click on the "Zoomit overview" button to return to the document list
screen.

4. Click the Download button in the document preview screen (or in the document list
screen) and choose one of the following options in the dropdown menu:

PDF: permits you to download the document in the PDF format.

 Note
To print the PDF document you have to use the print button of the PDF reader
(Adobe Acrobat Reader).

XML: permits you to download the document in the XML format (standard which
allows the integration of billing data into you accounting).

Other: permits you to download the document in another format such as BMF100,
CSV or a text file.

5. Click the Download button in the Download dropdown menu.

Note
The buttons described above do not always produce a result because all senders do not offer all document
formats.
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How can I...:

Allow that documents are displayed?
Pay received invoices?

More information:

About Zoomit
What is possible with Zoomit?
Video about consulting your Isabel 6 invoices
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How to pay received invoices? Document
ID: 30382
Modified:
11/04/2013
Created:
11/04/2013
Version: 12

Prerequisite:

Click on the  button on the “Welcome page” of the Isabel 6 eBanking application to open a Zoomit
session in a new window.

 Note
 The current version of Isabel 6 is not integrated with Zoomit.

Steps:

1. Click in the "Navigation bar" on “Documents: Invoices”

2. Select an invoice in the document list in the left column. The details of the invoice are
displayed in the right column.

3. Click the Download button and save the invoice on your PC in the desired format.

4. To return to the Isabel 6 Bankit screens:

Click "Close and go to bank".
Or click the Pay button > click the "Continue to internet banking" button.

Next, the Isabel 6 Bankit "Welcome page" appears.

5. Open the invoice that is saved on your PC.

6. Start Isabel 6 Bankit and use the payment data from the displayed invoice to enter the
payment "manually" into Isabel 6 Bankit.

You can find more details on how to introduce a payment in Isabel 6 Bankit by reading
the following articles:

How to create a SEPA payment?
How to create a domestic payment?

Note
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You can manually adapt and save the payment status in Zoomit.

How can I...:

Allow that documents are displayed?
Retrieve, consult and download allowed documents?

More information:

About Zoomit
What is possible with Zoomit?
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How to manage Isabel 6 subscriptions? Document
ID: 29450
Modified:
06/05/2013
Created:
06/05/2013
Version: 15

Description:

If you are already an Isabel 6 customer and you would like to update your subscription, you can fill in one of the
various forms below. Your request will be handled as soon as possible.

Resolution:

Change the direct debit number, Company Name, address or UEN of my Isabel 6-
subscription
(document ref: Isa6/RM-changespecssubscription)

Add/remove a user in/from my Isabel 6-subscription
(document ref: Isa6/RM-adduser or Isa6/RM-deleteuser)

Add/remove a bank in/from my Isabel 6-subscription
(document ref: Isa6/RM-addbank)

Change the user information in my Isabel 6-subscription
(document ref: Isa6/RM-changeuser)

Replace a Secure Signing Card
(document ref: Isa6/orderformENcard)

Order new card reader
Cancel my Isabel 6-subscription
(document ref: Isa6/RM-deletesubscription)

Submit your request by filling in and sign the appropriate document and send it to Isabel using one of the
following methods:

By registered letter:

Isabel S.A.
Customer Care
Keizerinlaan 13 -15
1000 Brussels

By fax to +32 (0)2 545 17 19
Block an Isabel 6 Secure Signing Card in case of loss or theft:

Act quickly! The Card Stop service enables you, with a single call, to block an Isabel Card. This service
(provided by Banksys) operates around the clock, seven days a week, in Belgium and abroad.

ACT QUICKLY!

CARD STOP

In the event of a lost or stolen card, call +32 (0) 70 344 344

24 hours a day, 7 days a week

For security reasons, your call will be recorded and Card Stop will ask you a maximum of information about the
card that should be blocked:

First name
Last name
Subscription number of the user
Company in which the card is used ...

Of course, all your data will be treated in accordance with the Belgian privacy law.

Write down the reference number you receive from Card Stop, and keep it safe. This will enable us to assist you
more easily should you call again.
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Next, the Isabel Customer Care Service will contact the concerned user or the responsible of the Isabel
certificates in your company in order to have a confirmation of this blocking request. The question will be asked
to send a written confirmation through a specific form. This for the revocation of a certificate after loss or theft of
the Isabel 6 Secure Signing Card.

More information:

KBC or CBC client
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